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About This Manual
The System 3 (Version 4.3) Manual is divided into seven sections.

Section I, Introduction, is a brief overview of the hardware components and
software programs that comprise System 3.

Section II, Setup and Operation, is a “How-To” section which describes, in a step-
by-step sequence, how use the System 3 software programs to setup a
configuration file and how to put the configured file into operation.

Section III, Diagnostics, describes diagnostic, monitoring, optimization, and
troubleshooting checks and utilities.

Section IV, Hardware, describes the specifications, installation, and deployment
of System 3 hardware and associated DigiCOURSE wet-end equipment.

Section V, Setup Program, describes the setup configuration software.

Section VI, Operator Interface Program, describes the operational software.

Section VII, Analysis Program, describes the analysis utility software.

If you find errors or omissions in this manual, please fax your comments to
the Input/Output Marine Systems Engineering Department at 504 734-8627.

About DigiCOURSE
DigiCOURSE is an industry leader in the manufacturing of marine seismic
exploration products. DigiCOURSE employs a comprehensive design,
manufacture, and calibration process to ensure that DigiCOURSE seismic
positioning and measuring instruments are not affected by vessel heading,
geodetic location, or changes in the operating magnetic latitude. DigiCOURSE is
committed to the accurate, reliable, and repeatable performance of these
instruments in all areas of the world.
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If you need information or assistance beyond the scope of this manual, please
contact one of the following Field Service Offices:

New Orleans Office

Input/Output, Inc.

5200 Toler St.

Harahan, Louisiana, USA    70123

Phone: 504-733-6061 (Monday through
Friday, 8 a.m. to 5 p.m. CST)

Toll-free: 800-533-0702 (within the
Continental United States)

Fax: 504-734-8627

Internet:: digi.fservice @ laitram.com

Houston Office

Input/Output, Inc.

11104 West Airport Blvd.

Stafford, Texas, USA    77477

Phone: 281-933-3339

Fax: 281-879-3500

United Kingdom Office

I/O Marine Systems, Ltd.

Little Mead Industrial Estate

Cranleigh, Surrey

United Kingdom GU6 8ND

Phone: 0483-277-644

Fax: 0483-277-655
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SYSTEM OVERVIEW
System 3 is a hardware and software package that controls and collects data from
a network of acoustic sensors and streamer positioning devices.  System 3 has on-
line command, diagnostic, and performance-monitoring capabilities. See Figure
1.1, for a diagram of the System 3 Architecture.
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Figure 1.1  System 3 Architecture (three-Modem)

Hardware Overview
System 3 hardware is composed of three main components: a Data Management
Unit, an Operator Interface computer, and one, two, or three Line Interface Units.

Data Management Unit

The Data Management Unit (DMU) is the interface between the shipboard
computers and the sensors on the cables.  It serves as a centralized data switch for
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data collected from the sensors, and distributes data to the shipboard computers.
All functions relating to communications with the sensors and external computers
are implemented within this unit.

Operator Interface Computer

The Operator Interface computer is the system command console. It  handles all
operator control and monitoring functions by implementing the three System 3
software programs: Setup, Operator Interface (OI), and Analysis. From the
Operator Interface computer you can enter commands and configuration data to
set up the system, execute sensor control, diagnostic, and test functions, and
display current information on streamer position and sensor performance in both
tabular and graphic formats.

The system can be set up to use multiple Operator Interface computers. In System
3 Versions 2.0 and later, up to six Operator Interface computers can be set up to
provide full command and control functions. An additional 248 Operator Interface
computers can be set up in monitor mode only.

The DMU and the Operator Interface computer(s) communicate over an Ethernet
connection.

Line Interface Unit

The Line Interface Unit (LIU) provides the physical interface between the DMU
and the transmission lines. Each LIU has six transmission line connectors. In
System 3 versions 3.0 and later, up to three LIUs are provided for 18-streamer
capabilities: each LIU supports 6 streamers, with ports 7 (Modem #1) and 14
(Modem #2) reserved for data radio ports.

Optional Dry-End Components

An expanded System 3 may include optional hardware, such as a Line Power Unit
(LPU), additional Operator Interface computers, additional Line Interface Units,
and other on-board electronics, such as a Rack-mount CMX.

The DMU, Operator Interface computer, LIU, and other on-board components
collectively comprise what is called “the dry end.”

Wet-End Components

Other components (which are not intrinsically System 3 components, but are used
in conjunction with the System 3 hardware) comprise what is called “the wet
end.”
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These “wet end” components include the acoustic units (CMX and CTX units),
birds, velocimeters, and any in-streamer compasses and in-streamer depth sensors.
In System 3 versions 3.0 and later, the system can include up to 500 sensors (a
maximum of 180 can be acoustic units; the remainder, non-acoustic units) with up
to 600 ranges.

Additional Information

For expanded information on the System 3 hardware components, including the
wet end components that are used with System 3, see Section IV, Hardware.

Software Overview
System 3 is operated through the Operator Interface computer using three software
programs: the Setup Program, the Operator Interface Program, and the Analysis
Program.

Setup Program

The Setup program allows you to set up the parameters needed for operation of
the system.

The Setup Program is the system configuration program. Setup allows you to set
the parameters needed for operation of the system. The Setup program supports
the definition, editing, and transferring of system level parameters, lines, sensor
equipment, and acoustic ranges. All configuration data is first entered and stored
on disk; then an option is presented for transferring the configuration data to the
DMU. Configuration of the system can be done either entirely in one session or in
several separate sessions. To put a new Setup parameter file into service, it must
be transferred to the DMU. Any number of setup files can be stored in the
Operator Interface computer with file name identification.

Unlike the Operator Interface computer, which can store many setup files, the
DMU can run only one. When a Setup file is transferred to the DMU, it remains in
effect until it is replaced by another setup file.

How to use the Setup Program is discussed in Section II, Setup and Operation.
The entire Setup Program is described Section V.

Operator Interface Program

The Operator Interface Program allows you to monitor and control the system; it
provides a real-time interface that allows you to interact with the system while
acquiring seismic data.
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How to use the Operator Interface Program is discussed in Section II, Setup and
Operation.  The entire Operator Interface Program is described in Section VI.

Analysis Program

The Analysis allows you to analyze acoustic data that has been acquired.

Installation of the Analysis program is optional; it can not be executed unless the
software has been installed on the Operator Interface computer. The Analysis files
should be installed in the same directory as the System 3 files.

The Analysis Program is described in Section VII.
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This is a “How-To” section that describes, in a step-by-step sequence,
how to use the System 3 software programs to setup a configuration
file and how to put the configured file into operation.  Follow the
instructions in each step carefully.

For a complete description of the individual System 3 software
programs, see Section V, Setup Program; Section VI, Operator
Interface Program; and Section VII, Analysis Program.

SETUP FUNCTIONS

Step 1 Prerequisites

Before starting the Setup Program, you must assemble the following prerequisite
information.  A rough sketch of the system layout will also make the configuration
process easier, faster, and more accurate.

1. Lateral offsets for all platforms

2. Cable offsets for all sensors (Acoustic and Bird units)

3. Unit numbers (for both Acoustic and Bird units)

4. Unit serial numbers (for both Acoustic and Bird units)

5. Target depth settings for all streamers

Step 2 Enter the Setup Program

To initialize the system, first apply power to the Data Management Unit, then to
the Operator Interface computer. The power switch for the Data Management Unit
(DMU) is at the lower right corner of the front panel.

The entire boot process takes approximately 40 seconds. When the DMU is
powered, the green LEDs labeled RUN and SCON will illuminate.

On the Operator Interface computer, start the Setup program by double-clicking
on the program icon.
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From the Setup program’s Main Window, you must either open an existing Setup
file, create a new Setup file, or import a Setup file from a Spectra navigation
system (see the Spectra File Exchange topic in Step 16):

How to Create a New File

You can create a new file by any of
the following methods:

Click on File / New.

Press Ctrl + N.

Click on the “New” button .

How to Open an Existing File

You can access an existing file by
any of the following methods:

Click on File / Open.

Click on File, then select from the
list of existing files at the bottom
of the menu.

Press Ctrl + O.

Click on the “Open” button .

Step 3 Set Global Parameters

The System / Global command accesses the Global Parameters Dialog Box,
which allows you to define system-wide parameters that are not associated with
any subsystem. The parameters that can be defined or edited are Vessel Number,
Number of Transmission Ports, Units for Depth Measurement, and Emergency
Dive Depth. The Emergency Dive Depth must be set before the creation of a
Setup configuration.

Do not click on the “Add Vessel” button     on the Setup Toolbar;
that button will add another vessel to the array, it will not access the
Global Parameters Dialog Box.
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Figure 2.1  Global Parameters Dialog Box

Vessel Number

The range of entries is 1 to 4. The default is 1. This data field is used primarily in
multi-boat configurations.

Number of Transmission Ports

This parameter is the number of transmission lines used in a given installation.
Each DMU modem supports up to seven transmission lines (including the radio
port). The range is 1 to 20.

Ports 7 and 14 are used for radio data telemetry only.

Units of Depth Measurement

The depth can be displayed in either feet or meters.  This selection also effects the
unit of depth measurement that is sent to the Host computer.

Emergency Depth

The range is between 0 to 125 meters. The default is 0. The emergency dive depth
specifies the target depth for all lines when an emergency dive command is
executed. The Emergency Dive Depth must be set before the creation of a Setup
configuration.
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When using Model 5010E or 5011E birds, do not enter depths greater
than 31 meters (103 feet).

Step 4 Set Host Parameters

The System / Host command accesses the Host Parameters Dialog Box, which
allows you to define the configuration of the communications ports. These ports
are used to transfer data to the Host computer and to select the data formats for
acoustic and non-acoustic data. The parameters that can be defined (or edited)
include the selection of the Logging Mode, Non-acoustic data format, Non-
acoustic data sort direction, Acoustic data port, Acoustic data protocol, and
Acoustic port characteristics.

Do not click on the “Add Vessel” button     on the Setup Toolbar;
that button will add another vessel to the array, it will not access the
Host Parameters Dialog Box.
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Figure 2.2  Host Parameters Dialog Box

Logging Mode

The Logging Mode determines when sensor data is sent to the Host. Select one of
the four modes:

Disable Logging:  When Data Logging is turned off; no data is sent to the Host
on trigger.

Data Request:  Non-acoustic data (depth, heading, fin) is sent to the Host when a
specific code (separate from the trigger character) is requested by the Host.
Request code 1 is for heading data; request code 2 is for depth data; and request
code 3 is for fin angle data. The request codes are binary numbers, and the non-
acoustic sensor data is returned in binary format. No request code exists for
acoustic data. Acoustic data is logged automatically on receipt of the scan trigger
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if Port 3 is selected as the acoustic data port. If Port 2 is selected as the acoustic
data port (and Data Request is selected as the Logging Mode), acoustic data will
not be sent to the Host.

Scan Trigger:  Data is sent to the Host on the receipt of every external scan
trigger. The external trigger may be a character received from the Host or from an
electronic closure supplied to the Contact Closure Unit. The format of the sensor
data returned is determined by the selections made for the Non-acoustic Data
Format and the Acoustic Data Protocol.

Scan or Internal Timer:  Data is sent to the Host on the receipt of every external
or internal trigger. Internal triggering occurs in the absence of external triggering.
The format of the sensor data returned is determined by the selections made for
Non-Acoustic Data Format and the Acoustic Data Protocol.

Port 2 Acoustic/Non-Acoustic

The primary Host port (Port 2) is a bi-directional serial link between your Host
computer and the System 3 Data Management Unit. The Data Management Unit
responds to commands from the Host computer to perform various functions
related to data acquisition and output, including timing control for data acquisition
triggering.

If the Port 2 is selected for the output of acoustic range data, an acoustic range
message is transmitted every time a Host log event is scheduled. The range
message follows the non-acoustic data message. Port 2 shows Acoustic, Port 3
shows Not In Use.

Port 2 Baud

This parameter is determined by your Host computer. The selection options are
1200, 2400, 4800, 9600, and 19200.

Port 2 Stop Bit

This parameter is determined by your Host computer. The selection options are 1
and 2.

Port 2 Parity

This parameter is determined by your Host computer. The selection options are
None, Even, and Odd.

Port 2 Data Bits

This parameter is determined by your Host computer. The selection options are 5,
6, 7, and 8.
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Port 3 Acoustic/Not In Use

If the acoustic data port (Port 3) is selected, an acoustic data message is output at
the beginning of each scan cycle. The type of message to be output is specified as
a configuration parameter. Port 3 shows Acoustic, Port 2 shows Non-Acoustic.

Port 3 Baud

This parameter is determined by your Host computer. The selection options are
1200, 2400, 4800, 9600, and 19200.

Port 3 Stop Bit

This parameter is determined by your Host computer. The selection options are 1
and 2.

Port 3 Parity

This parameter is determined by your Host computer. The selection options are
None, Even, and Odd.

Port 3 Data Bits

This parameter is determined by your Host computer. The selection options are 5,
6, 7, and 8.

Non-Acoustic Data Format

This parameter is determined by your Host computer. Five types of data formats
are supported for the transfer of non-acoustic sensor data via the primary Host
data port:

• Binary

• ASCII

• Western

• Extended Binary

• Gbird

 Both solicited and unsolicited output of sensor data are supported. For solicited
output, a data request must be received from the Host. Unsolicited output occurs
automatically once each shot interval, with its timing controlled by the internal
scan trigger.

 Set Offset Sort Order

 This parameter determines whether non-acoustic unit data is output in ascending
or descending order by streamer cable offset. The selection options are
Descending and Ascending.
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 Acoustic Data Protocol

 This selection defines which data protocol is used to output acoustic range data to
the Host. This parameter is determined by your Host computer. The available
protocols are:

• DigiCOURSE (P/N 1000-132)

• CLS

• GLS

• HGS  (P/N 1000-388)

• Extended DigiCOURSE  (P/N 1000-361)

• GECO Binary

• Standard Ethernet

• PGS Ethernet

Assign Acoustic Port

This option determines which serial port (Port 2 or Port 3) is used to send acoustic
data to the Host. Port 3 is the default. If Port 2 is selected as the acoustic port, Port
3 is inactive and its parameters cannot be set. Port 2, which is the primary Host
port, can be used for either acoustic or non-acoustic data.

Step 5 Set Data Acquisition Parameters

The System / Data Acquisition command accesses the Data Acquisition
Parameters Dialog Box, which allows you to define how often data is requested
by and from the Data Management Unit. The parameters that can be defined (or
edited) are Self Trigger Interval, Number of Poll Retries, and Scan Start Delay.

Do not click on the “Add Vessel” button     on the Setup Toolbar;
that button will add another vessel to the array, it will not access the
Data Acquisition Parameters Dialog Box.
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Figure 2.3  Data Acquisition Parameters Dialog Box

Self Trigger Interval

This parameter specifies the  interval (from 1 to 255 seconds) between
consecutive system-generated internal scan triggers in the absence of an external
trigger from the Host. If the Host stops triggering, the system initiates internal
triggering after expiration of a two-minute timer unless another external trigger is
received. Internal triggering terminates when external triggering resumes.

Number of Poll Retries

This parameter specifies the number of times (from 0 to 3) the modem will issue a
communication retry to a sensor failing to respond to the initial data acquisition
poll. The default value is 1.

Scan Start Delay

This parameter specifies the length of time (in tenths of seconds, from .3 second
to 25.5 seconds) between the external trigger and the primary acoustic sync sent
out by the Data Management Unit. This parameter can be used to change the delay
time between trigger and primary acoustic ranging to move the acoustic ranging
time away from the gun blast.

Increasing the value of the scan start delay extends the acquisition
cycle time.
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Step 6 Set Acoustic Parameters

The System / Acoustics command accesses the Acoustic Parameters Dialog
Box, which allows you to define system level acoustic parameters. The parameters
that can be defined (or edited) are Secondary Acoustic Sync, Speed of Sound,
Same Channel Aperture Separation, Aperture Size for Same Line, Aperture Size
Transmission, Distance to Bottom Minimum/Maximum, Different Line Aperture
Sizes, Pulse Size Number, and Default Threshold.

Do not click on the “Add Vessel” button     on the Setup Toolbar;
that button will add another vessel to the array, it will not access the
Acoustic Parameters Dialog Box.

Figure 2.4  Acoustics Parameters Dialog Box
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Range Creation

This option specifies the mode of operation for range data acquisition: one-way
ranging or two-way ranging (default). When one-way ranging is selected, a range
consists of a single path time measurement, with one unit receiving the acoustic
signal transmitted by the other unit. Range acquisition time is generally shorter
when one-way ranging is in use. When two-way ranging is selected, a range
consists of two path time measurements combined to make a range value, with
each of the two units both transmitting to and receiving from the other unit.

Secondary Acoustic Sync

This parameter specifies the length of time (in tenths of seconds, from 0 to 10
seconds) desired between the trigger and the secondary sync sent out. The purpose
of the secondary sync is to initiate a retry for ranges that failed in the primary
acquisition. The value entered must be greater than Primary offset and less than
100 (10 seconds). The default value is 40 (4 seconds). A setting of 0 disables
secondary acquisition.

Speed of Sound

This parameter is a fixed nominal sound speed used internally to convert distances
to transit times and vice versa. The accuracy of this value determines the accuracy
of the ranges displayed during run time. The entered value must be from 1400 to
1600 meters/second. The default is 1500 meters/second. (NOTE: This value does
not affect the accuracy of range data transferred to the Host computer.)

Same Channel Aperture Separation

This parameter specifies the minimum delay time (in milliseconds) between two
receiver apertures on the same channel. The entry must be from 0 to 999
milliseconds. The default value is 25 milliseconds.

Aperture Size for Same Line

This parameter specifies the size of the apertures (in milliseconds) for ranges
between two CMXs attached to the same line. The entered value must be from 1
to 999 milliseconds. The default value is 10 milliseconds.

Aperture Size Transmission

This parameter specifies the amount of time (in milliseconds) to be taken for a
CMX to transmit an acoustic pulse. The valid value must be from 0 to 10,000
milliseconds. The default value is 25 milliseconds and should not be changed.

Shallow Water Reflections: Minimum/Maximum Depth

These parameters are used by the acoustic compiler to eliminate reflections
between different range pairs. An acoustic pod’s self generated reflection is also
eliminated. Survey water depth minimum and maximum values (in meters) should
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be entered at the start of the survey. The default value for both parameters is
9999m. Typically, the default values can be used for water depths of greater than
85m.

Different Line Aperture Sizes

These parameters specify the sizes of the apertures (in milliseconds) for ranges
between two CMXs attached to different lines.

0 to 999 meters: Enter the different line aperture size for ranges in which the
offsets of both CMXs are less than 1000 meters. The default value is 20
milliseconds.

1000 to 2999 meters: Enter the different line aperture size for ranges in which the
offsets of one or both CMXs are from 1000 to 2999 meters. The default value is
40 milliseconds.

3000 meters and above: Enter the different line aperture size for ranges in which
the offsets of one or both CMXs are from 3000 meters and above. The default
value is 60 milliseconds.

Pulse Size Number

This parameter affects the acoustic transmit waveform parameters. The pulse size
number is set to its default value of F010 Hex and cannot be changed by you.

Default Threshold

This parameter specifies a threshold value that will be used as the default value
when ranges are created. To change the default threshold value for ranges that
have already been created, the ranges must be deleted and re-created after the new
default threshold value has been entered in the default threshold field.

0 to 999 meters: Enter the default threshold desired for paths in which the offsets
of both CMXs in the range are less than 1000 meters. The default is -6.

1000 to 2999 meters: Enter the default threshold desired of both CMXs in the
range are from 1000 to 2999 meters. The default is -6.

3000 meters and above: Enter the default threshold desired for paths in which the
offsets of both CMXs in the range are above 3000 meters. The default is -6.

Step 7 Set Radio Configuration Parameters (if Radios are used)

If radios are not used, skip this step.

The System / Radio Configuration command accesses the Radio Parameters
Dialog Box, which allows you to define radio timing parameters. The parameters
that can be defined (or edited) are Baud Rate, Radio Transmission Delay,
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Response Time-out, RTS to Transmission Delay, and Transmission to Reception
Turnaround Delay.

Do not click on the “Add Vessel” button     on the Setup Toolbar;
that button will add another vessel to the array, it will not access the
Radio Configuration Parameters Dialog Box.

Figure 2.5  Radio Parameters Dialog Box

Baud Rate

This parameter is determined by the radio you are using. Ensure that the baud rate
selected matches the baud rate of the radio. The selection options are 1200, 2400,
4800, 9600, and 19200.

The parameters shown in the example are the default values for the
TSI 9600 Radio Modem operating at 9600 baud rate.  Contact
DigiCOURSE before altering the default settings.

Radio TX Delay (tb)

This parameter is determined by the radio you are using, since the delay is
introduced by the radio’s buffer. The radio transmission delay is the delay from
the time that the sending device starts transmitting until data is actually received.
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The selection options are from 0 to 1000 (in 1/10 ms). For TTI radios, tb = 0 ms;
for TSI radios, tb = 23 ms.

To measure tb, first use the radio manual to determine a close estimate, then
compare the sync bit from the radio CTX to the FSK CMX to fine tune this
number. Attempt to get a zero mean spread on the sync bits deviation. An
alternate method of measuring tb is to compare the line 1 start of sync transmit to
the radio line 7 (or radio line 14). For a six-streamer system, compare (TXD) MP
1, connector 1, pin 5 to (TXD MP 1, connector 7, pin 5. For a twelve-streamer
system, compare (TXD) MP 1, connector1, pin 5 to (TXD) MP 2, connector 7, pin
5.

Response Time-out (te)

This parameter specifies the time-out period in the radio multiplex port from the
end of the TX to RX Turnaround period to the first bit in the response message.
The default is 60 ms. The selection options are from 0 to 255 (in ms); however,
never use 0.

RTS to TX Delay (ta)

This parameter specifies the delay required from the activation of RTS to the start
of transmission from the sending device to the radio modem. The selection
options are from 0 to 255 (in ms); however, never use 0. For TTI radios, ta = 25
ms; for TSI radios, ta = 3 ms.

TX to RX Turnaround (tc)

This parameter specifies the delay required as dead time between the end of
transmission and the start of reception. This delay is necessary in some radios due
to the transmitter decay time. The selection options are from 0 to 255 (in ms);
however, never use 0. For TTI radios, tc = 30 ms; for TSI radios, tc = 1 ms.

Parameters td and tf are embedded in the CTX and, therefore, are not
adjustable in the Radio Configuration Parameters Dialog Box.

Baud Rate Compensation Delay in the CTX (td)

This parameter is the delay that is embedded in the CTX to compensate for the
differences in baud rates between the radio and FSK ports. This is only relevant
when timing accuracy is required. Only the sync message needs this delay. The
value embedded in the CTX takes into account the actural baud rates of the MP
and the CTX units.

Message Time-out in the CTX (tf)

This parameter is the time-out period in the CTX from the start of the Data Carrier
Detect to the start of the first bit in the incoming message. The tf = 32 ms.
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Step 8 Create Platforms/Lines (Steamers only)

The Edit / Platform Line / Create command (or button   ) allows you to add
a new line to the array of a vessel (that is, to create or define a new line to which
sensors can be attached, such as streamer cables, gun arrays, tail buoys, etc.) by
accessing a new Platform/Line Information Dialog Box and completing the
information fields in the box. Platform/Line parameters that can be defined are
Line ID, Vessel, Name, Type, Cable, Port, Line Length, Lateral Offset, Cable
Depth and Disable Cable Screen Display.

Line ID

The line identifier is a letter or a digit-letter combination that serves as a reference
for a line. The identifiers are A to Z for lines 1-26, 1A to 1Z for lines 27-52, and
2A to 2K for lines 53-63 (63 total lines).  No two lines can have the same
identifier.

Vessel

The vessel number allows System 3 to associate a line to a vessel. This feature
also allows a multi-vessel system to be treated as a single system. The limits for
vessel number are 1 to 4, and the default is 1.

Name

The line name is used only for display purposes. The name can be any character
string up to 20 characters long, and can include blanks. There is no default for line
name.

Type

The type identifies the type of platform line, and is used both for display purposes
and for identification of streamer cables in the bird data sent to the Host. The
selections available are Streamer Cable, Vessel, Gun Array, Tail Buoy, Paravane,
Tow Fish, Nav Sled, and Test Cable.  Select “Streamer Cable.”

Cable

The cable number is used for identification of streamer cables in the bird data sent
to the Host. This field is locked out unless the “Line Type” is “Streamer”. Cable
numbers must be sequential with no numbers skipped.

Port

The port corresponds to the line number on the Line Interface Unit to which the
communications link for the defined line is connected. Line Interface Unit
numbers are 1 to 6, 8 to 13, and 15 to 20. Port numbers 7 and 14 are for radio
telemetry only and are not to be used as streamer cables.
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Line Length (m)

The line length is the total length of the platform line (in meters), and is used for
display purposes. The line length must be greater than the largest unit offset.

Lateral Offset (m)

The lateral offset is the lateral offset distance (in meters) from a system-wide
reference line to the line being entered. Normally, all lines are referenced from the
vessel center line. Lines to port of the reference have a negative lateral offset and
lines to starboard have a positive offset. The limits are -9999 to +9999; and the
default is 0. For multi-vessel systems, all lines must be referenced from the same
reference line (which is normally the centerline of Vessel 1).

Cable Depth (m)

The depth is the desired target depth for the line. The limits for depth are from 0
to 115 meters (0 to 378 feet), and the default is 0.

An emergency dive depth, which specifies the target depth for all
cables when an emergency dive command is executed, is input during
the Setup program by selecting System menu, Global submenu,
Emergency Depth command.

When using Model 5010E or 5011E birds, DO NOT ENTER VALUES
GREATER THAN 31 METERS (103 feet).

Step 9  Add Acoustic Units and Bird Units to Streamer(s)

Adding (or creating, or attaching) acoustic sensors and birds to a line
is most easily accomplished using a combination of mouse clicks and
key strokes, then tabbing from field to field in the dialog boxes. The
instructions in this section is just one way to accomplish the task.
Make sure that you build one complete streamer (both acoustics and
birds) before beginning another one.

The Edit / Platform Line / Copy command allows you to copy a
selected line that has previously been defined. If the line sensors have
been defined, this command will also copy all sensor information
(except the serial numbers) to the new line.

The Edit / Platform Line / Populate command accesses the Populate
Line Dialog Box, which allows you to add birds or acoustic units to a
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selected streamer at regularly-spaced offsets.

For details on how to use either of these convenient and time-saving
commands, see Section V, Setup Program, Edit menu.

Unit Names

Unit names are unique alphanumeric identifiers for external devices.  The names
are initially defined in the Setup program when a new device is added to the
configuration, and are subsequently used in both the Setup program and the
Operator Interface for identifying the devices.

Two forms of unit names are supported: standard Input/Ouput unit names, and
free-form unit names.  The type of unit names to be used is selected during
software installation, and remains in effect until the software is re-installed.
When standard Input/Ouput unit names are in use, the Setup program
automatically generates the names based on a device’s location on a platform, the
device type, and a user-defined unit number.  For example, in the name FB03, ‘F’
represents the platform line, ‘B’ designates a bird, and ‘03’ is the device’s unit
number.

When free-form unit names are in use, you enter a unit name consisting of up to
six characters when you define a new device in the Setup program.  The program
ensures that the name you enter is not a duplicate of an existing name.  These
names can also be imported from a Spectra Navigation system, eliminating the
need to re-enter them in System 3 Setup.

Acoustic Units

Acoustic sensors must be uniquely identified to all system components. For
system-wide identification, a unique global identifier is assigned to each sensor by
using the Setup program.

When standard Input/Ouput unit names are in use, a 4- or 5-character
alphanumeric identifier is assigned to each sensor during Setup. This identifier is
guaranteed to be unique by the Setup program, and is stored in the sensor
equipment table of the configuration file. The first character (or two characters for
lines 27-63) of the identifier is a letter or digit-letter pair designating the line
(platform) to which the sensor is attached. The next character is the letter A
(designating an acoustic sensor), and the last two characters are digits designating
the unit number.

The Edit / Unit Sensor / Create / Acoustic command accesses a new Acoustic
Sensor Information Dialog Box. Complete the information in the box.
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Unit Number

The unit number determines the last two characters of the unique sensor identifier
(BA01), and is used to construct a unique address for communications with the
sensor. The limits for CMX unit number are 1 to 31. The CMXs are stored in
alphanumeric order, and, for existing setup files, the first CMX initially displayed
is the one with the lowest unit number on the first line.

Serial Number

The serial number is the unique number assigned to each DigiCOURSE product
when it is manufactured. The serial number is printed on the label of each CMX,
and must be entered here. Duplication of serial numbers is not allowed.

Offset from Towpoint

The offset from towpoint is the linear offset distance (in meters) from a system-
wide reference point to the CMX. Normally, all units are referenced from the
center stern of the vessel (or navigation reference point). CMXs in front of this
point have a negative offset and CMXs behind this point have a positive offset.
The limits are -9999 to the defined line length, and the default is 0.

Group Number

The group number associates the CMX with an acoustic group, such as front,
middle or tail. It is used primarily for display purposes. The limits for group
number are 1 to 9.

If the TAGS protocol is in use, this field is locked out. The TAGS ID determines
the group number (F=1, T=2, M=3, N=4, O=5, P=6, Q=7, R=8, S=9).

Geco/CLS/GLS ID

The protocol identifier selects the Host protocol in use. If the CLS or GLS Host
protocol is in use, this entry identifies the CMX unit in the nomenclature defined
in that protocol. If the HGS (TAGS) Host protocol is in use, this entry identifies
the CMX unit in the nomenclature defined in that protocol.

Transmit Channels 1, 2, 3, 4, and 5

These entries allow you to limit the freedom of the compiler by disallowing
certain transmit channels. This causes the transmit channel of the CMX to be
limited to the allowed channels. If a particular channel is causing interference to
another system, that channel can be disallowed here. Check (or un-check) the
appropriate check box to allow (or disallow) the use of a channel. There must be
at least one transmit channel allowed. The default is all channels allowed. If any
of these entries are changed, the acoustic data must be compiled.
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Receive Channels 1, 2, 3, 4, and 5

These entries allow you to limit the freedom of the compiler by disallowing
certain receive channels. This causes all ranges associated with the CMX to be
limited to the allowed channels. If background noise levels are too high for a
particular channel, that channel can be disallowed here. Check (or un-check) the
appropriate check box to allow (or disallow) the use of a channel. There must be
at least one receive channel allowed. The default is all channels allowed. If any of
these entries are changed, the acoustic data must be compiled.

Bird Units

Bird sensors must be uniquely identified to all system components. For system-
wide identification, a unique global identifier is assigned to each sensor by using
the Setup program.

When standard Input/Ouput unit names are in use, a 4- or 5-character
alphanumeric identifier is assigned to each sensor during Setup. This identifier is
guaranteed to be unique by the Setup program, and is stored in the sensor
equipment table of the configuration file. The first character (or two characters for
lines 27-63) of the identifier is a letter or digit-letter pair designating the line
(platform) to which the sensor is attached. The next character is the letter B
(designating a bird), and the last two characters are digits designating the unit
number.

The Edit / Unit Sensor Create / Bird command accesses a new Bird Sensor
Information Dialog Box. Complete the information in the box.

Unit Number

The unit number determines the last two characters of the unique sensor identifier
(BB01), and is used to construct a unique address for communications with the
sensor. The limits for bird unit number are 1 to 63. The birds are stored in
alphanumeric order, and, for existing setup files, the first bird initially displayed is
the one with the lowest unit number on the first line.

Serial Number

The serial number is the unique number assigned to each DigiCOURSE product
when it is manufactured. The serial number is printed on the label of each
DigiBIRD, and must be entered here. Duplication of serial numbers is not
allowed.

Offset from Towpoint

The offset from towpoint is the linear offset distance (in meters) from a system-
wide reference point to the bird. Normally, all units are referenced from the center
stern of the vessel (or navigation reference point). Birds in front of this point have
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a negative offset and birds behind this point have a positive offset. The limits are
-9999 to the defined line length, and the default is 0.

Subtype

It is vital to streamer depth control that the model defined by the subtype entry
agrees with the type of bird installed on the streamer. Model types may be mixed
on the streamer providing they are correctly identified.

Depth

The depth defines the assigned target depth (in meters) of the bird. The default
value is the depth of the line to which the bird is attached. The limits are 0 to 115
meters (0 to 378 feet).

When using Model 5010E or 5011E birds, DO NOT ENTER VALUES
GREATER THAN 31 METERS (103 feet).

Include data to Host  Yes/No

If the Host protocol you are using limits the number of sensors that can send data
to the Host, you may select which sensors are allowed to send data.

Step 10  Create Platforms/Lines (Gun-mounts)

Repeat Step 8. In the Type selection, select “Gun Array.”

Step 11  Create Platforms/Lines (Radio CTX, if needed)

Repeat Step 8 if radio CTX units are used; otherwise, skip this step.

Step 12  Create Ranges

For a detailed description of the range creation procedure, see the
Create Ranges section in the Setup program description in Section V.

The Edit / Create Ranges command is the first step in creating and editing
ranges. After selecting the Edit / Create Ranges command, click on an acoustic
unit in the Graphic side to display all existing ranges for that unit; the icon for the
selected unit will turn white.  To define a new range for that sensor, hold the
Control key (Ctrl) down and right-click (right mouse button) on the second
acoustic unit of the range pair.  A line connecting the two units representing the
range will appear, and the icon for the second unit will turn green.  Use this
method to create up to eight ranges for the selected unit.  When all ranges are
defined for the current unit, left-click on that unit to de-select it, then right-click
on the next unit whose ranges you wish to define or edit.
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To edit an existing range, left-click on one unit of the range pair, then double-
click on the second acoustic unit (which is ranged to the first unit) to access the
Edit Range Dialog Box. Range Name is used to identify a range in the Operator
Interface program when viewing Signal Strength or Path Time displays. The range
name can be any character string up to 20 characters long and can include blank
spaces and upper or lower case letters.

Path thresholds are entered as a scale factor index. Path 1 is the signal received by
the first CMX in the range pair, and Path 2 is the signal received by the second
CMX. The value entered is an index that corresponds to the threshold setting in
dB above RMS noise level. The index also determines CMX operational mode:
reflection or normal. All DigiRANGE acoustic units with serial number 7000 and
higher have new firmware with Enhanced CFAR.  This feature is an improvement
over the previous CFAR settings in that it is self-adjusting to changing noise
conditions.  Also the system is more immune to false noise trips.  The new default
setting for deep water mode is -3, and for dual tracking mode is   -14. The default
value of -3 should be used for units 1000 meters or more behind the vessel.  For
units less than 1000 meters, the default values of -5 seem to work best.

The minimum and maximum range distances are entered in meters. The “Retry”
option (Yes/No) determines whether this range should be retried if secondary
acquisition is enabled and the primary range data was absent or unqualified. The
“Range Data Mode” field selects the type of range data qualification: two-way,
one-way (Unit 1 receive), or one-way (Unit 2 receive). Two-way range
qualification generally results in a more accurate measurement, but one-way
qualification may be appropriate if one CMX of the pair is in a high noise
environment.

Step 13 Compile

The File / Compile command compiles an acoustic system configuration file. The
Compile function uses system, line, acoustic sensor (CMX), and range
information, combined with rules and algorithms, to calculate and optimize all
aspects of the acoustic transmit and receive signals. This acoustic system
configuration file must be compiled prior to downloading individual unit
configuration information to the CMX’s in the Operator Interface (OI) program.
Whenever acoustic parameters are changed, a new compilation may be required;
the Setup program will indicate when this is necessary.

Step 14 Check Cycle Estimates

The File / Cycle Estimate command accesses (after the acoustic system
configuration file has been compiled) the Cycle Estimates window. The Bird
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Communications Rate and Acoustic Range Completion Rate can be changed to
generate an acquisition cycle time estimate based on current observations.

When using a system with multiple DMU modem processors or in multi-boat
acoustic operations, the secondary acoustic sync must be after the primary cycle
time. The total cycle time must be less than the fastest switch closure or trigger to
the system.

The total cycle time can be used to determine if all data acquisition is complete
prior to the next trigger (shot). The primary cycle time can be used to determine
the time to set the second acoustic sync time. Calculate the secondary acoustic
sync time by using the primary cycle time, adding 750 ms, and rounding the
number to the next highest 1/10 second.

Example:

Primary Cycle time = 4495

4495 + 750 = 5245

5245 rounded to next highest 1/10 second = 5300

Set the secondary acoustic sync to 53 and run Cycle Estimate again to check
that the total cycle time is less than switch closure or trigger time.

Compile the acoustic system configuration file prior to using the Cycle
Estimates function.

Step 15 Save File

The File / Save As command saves changes made to the open System 3 file.
Changes can be saved under a new file name and/or a new folder.

Step 16 Transfer File to DMU

The File / Transfer to DMU command downloads a System 3 Setup
configuration file from the Operator Interface computer and transfers that file to
the DMU. Before System 3 can use a Setup file created with the Setup program,
the file must be transferred to the DMU. Following the entry of all setup data, an
acoustic compile is performed (if required) and the Setup file is stored on disk
using one of the Save commands under a file name of your choice. This file can
be opened later for updates, and the modified setup can be stored on disk under
the same name or under a new name. In any case, the Setup file does not become
active until it is transferred to the DMU.
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The Operator Interface computer first sends an Initialize Link message to the
DMU and waits for an acknowledgment. If no acknowledgment is received, an
error is reported. If the DMU is prepared to accept the Setup program file, it sends
the acknowledgment to the Operator Interface, and the Setup data is formatted
into the required messages and is transmitted to the DMU.

Following the transfer of the Setup file information to the DMU, the
acoustic configuration must still be downloaded to each CMX from the
Operator Interface runtime program.

Spectra File Exchange

This feature is available only if it is enabled during installation.  If
Spectra has not been enabled during installation, you must re-run
installation.

Purpose

The purpose of the configuration file exchange is to increase productivity by
minimizing the number of times you must input system configuration data.
Previously you had to enter the system configuration, i.e., vessels, platforms,
birds, acoustic nodes, and range observations, once in Spectra and then again in
System 3. This new feature of exchanging configuration files requires you to enter
the system configuration only once.

In addition, once the exchange cycle is completed, both systems will have the
same configuration. Previously, when errors were made the two systems did not
have the same configuration.

Initial System Configuration

See Figure 2.6, File Exchange: Initial System Configuration

1. Completely define the system setup on the Spectra system. Input vessel
information, platforms, birds, and acoustic nodes. Ranges can be defined
in either system.

The Spectra system platform screen will include a field for the System
3 transmission port number. The Spectra system will accept System 3
unit numbers on the bird and acoustic node screens, and will enforce
the System 3 rules that require unique unit numbers for sensor types
on any given transmission port. It is suggested that you input the serial
numbers for sensors when they are defined in the Spectra system.



System 3 (Version 4.0) User’s Manual

28

2. Once finished entering data on the Spectra system, select the Export
selection from the File menu on the Spectra SNN Program. This creates an
exchange file based on the current configuration.

3. Go to the System 3 operator interface terminal and from the Setup
program select File /Spectra Interface (Read). If there is no file open in
Setup, the file read from Spectra into System 3 will result in a new
configuration being created, including all platforms and sensors.

If ranges exist in the exchange file they will be created with default
aperture and threshold settings. If ranges do not exist, then create the
range observations for the current system in the System 3 Setup
program.

4.  Compile the acoustic system, and transfer the configuration to the System
3 DMU.  The Setup program will put the configuration on the Spectra
system automatically.  Then select the Import selection from the File menu
on the Spectra SNN Program. This updates the Spectra system based on
the current exchange file. The exchange is now complete with both
systems having the same configuration.
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Figure 2.6  File Exchange: Initial System Configuration
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Changes After Initial Configuration

See Figure 2.7, File Exchange: Changes to System Configuration.

If changes need to be made in either system the following procedure
should be followed.

1. If Spectra system changes are needed, such as, offset changes, adding a
node, or deleting a node, do these changes first.

2. Once finished changing data on the Spectra system, select the Export
selection from the File menu on the Spectra SNN Program. This creates an
exchange file based on the current configuration.

3. From the Setup program, select File / Receive from DMU.

4. From the Setup program select File / Spectra Interface (Sync).  The
Setup program will ask which system’s serial numbers to preserve:
DigiCOURSE or Spectra.  It will then ask if the system should keep the
acoustic aperture settings or reset the apertures to the default settings. The
Spectra configuration will be merged with the System 3 configuration.
This will preserve the System 3 specific parameters.

5. Add or delete ranges if needed.

6. Compile acoustics.  This must be done any time a configuration is
received from Spectra.

7.  Transfer the configuration to the System 3 DMU. The Setup program will
put the configuration on the Spectra system automatically.  Then select the
Import selection from the File menu on the Spectra SNN Program. This
updates the Spectra system based on the current exchange file.  The
exchange is now complete with both systems having the same
configuration.
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Limits

At this time, no mechanism exists to automatically keep the two systems
synchronized.  You must follow the above procedures to manually keep the
System 3 and Spectra systems in sync.
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OPERATOR INTERFACE FUNCTIONS

The following steps describe the basic functions necessary to operate
System 3.  For a complete description of the Operator Interface
Program, see Section VI.

Step 1  Open the Operator Interface (OI) Program

Step 2  Connect to the DMU

The File / Connect command connects the Operator Interface computer to the
DMU. The Depth graphic screen is the default. Select the display that you want to
view.

Step 3  Set Target Depth Color Values

The File / Preferences command allows you to make color adjustments to the
display.  The File / Preferences command initially accesses the System
Preferences Dialog Box (which is tabbed into two sections: the System
Preferences for Depth Displays Dialog Box and the System Preferences for
Ranges/Paths/Acoustics Dialog Box. The dialog box allows you to select the
default colors used in the Graphic Display for bird and acoustic settings. The only
settings required at this time is for the Target Depth values; the other color
preferences can be set now or at another time. Double-click on a color to call up
the color palette, and select you colors you want to use, or use the default colors.
These colors, once set, are displayed in the Color Bar. Note that if your monitor is
not using True or High Color, the colors you select may appear differently in the
displays.

Step 4  Deploy Bird Units

The Sensor / Deploy a Bird Unit command accesses the Bird Deployment
Dialog Box. The dialog box allows you to enter a Unit ID and select from the
following options: Assign Unit Number, Read Serial Number, Read Battery
Voltage, Read AGC, Assign Target Depth, Wing Reset, Set Fin +15, Set Fin -15,
and Set Fin 0.

Assign the bird a Unit ID.

Set Wing Reset to ensure the wing operates through its full range of motion.

Select the options you want to check.
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Press the “Execute” button to read the depth and response from the selected
options.

Press the “Info Page” button to access the Bird Information Dialog Box. (The
dialog box is also accessible by using the Diagnostic / Bird / Info Page
command.)

Read the Bird Information Dialog Box. The dialog box allows you to enter a
Unit ID (if necessary) and view a quick summary of the key parameters that define
the status of that bird. The dialog box combines diagnostic and control
information from several of the individual commands into a single display. The
display updates continually until it is exited.

Deploy all bird units before continuing.

Step 6 Turn On Acoustics Mode

The DMU / Set Acoustics Mode command is a switch that allows you to turn the
acoustics on or off. Turning the acoustics off when they are not in use saves
battery life; however, under most circumstances, the acoustics should be turned
ON.  The Acoustic Mode must be ON to check the battery voltage of acoustic
units.

Step 7  Deploy Acoustic Units

The Sensor / Deploy an Acoustic Unit command accesses the Acoustic
Deployment Dialog Box. The dialog box allows you to enter a Unit ID and select
from the following options: Assign Unit Number, Read Serial Number, Read
Battery Voltage, Read AGC, and Download CMX Configuration.

Assign the acoustic a Unit ID.

Select the options you want to check.

Press the “Execute” button to read the response from the selected options.

Press the “Info Page” button to access the CMX Information Dialog Box. (The
dialog box is also accessible by using the Acoustic / Diagnostic Page command.

Read the CMX Information Dialog Box. The dialog box contains more detailed
information on a specific CMX unit. When this option is executed off-line, an
option is available for downloading a special test configuration to the selected
CMX unit. This is most useful during initial deployment, when the CMX may not
have a valid configuration. After the Diagnostic Page option is selected in off-
line mode and the desired Unit ID is entered, you can download the special
configuration by pressing the Download Diagnostic button. If the special
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configuration is downloaded, the previous configuration must be re-downloaded
after completing the diagnostics procedure.

Download the acoustic’s runtime configuration. The Sensor / Download CMXs
Configuration command loads any required configuration data to a sensor.
(Currently this applies only to acoustic CMXs, and is used to download acoustic
aperture and threshold settings). Valid runtime acoustic configurations (originally
generated by the Setup program) must be downloaded to all CMXs prior to
initiating operation of the acoustic system to ensure that valid range data is
produced. It is also important to avoid making any individual range
aperture/threshold adjustments unless the affected CMXs contain valid runtime
configuration data. To download configurations to all CMXs at once, enter the
“@” wildcard at the unit ID prompt.

Deploy all acoustic units before continuing.

If, at any time, you need to substitute one CMX for another, use Read/ Swap
Serial Number function to change the serial number in the database to match what
is actually being put on the line.

Step 8  Checkout Birds and Acoustics

The Performance / Sensor Comm. Graphic command displays a graphical
representation of inbound signal strength and noise data by transmission line. The
display plots inbound received signal strength (in dB volts) as a function of linear
offset (in meters) for the selected transmission line. All sensors that communicate
over the selected line are displayed. The vertical axis represents signal strength,
and the horizontal axis represents offset distance from the towpoint. The
background noise level in dBV is shown as a horizontal line across the graph. The
display updates automatically at every shot cycle after the initial read.

Normally the received signal strength should decrease linearly with distance down
the line. If any significant sharp drops appear at specific points along the line, this
may a indicate leakage problem or some other condition causing attenuation.
Also, communications may be unreliable with any sensor whose signal strength is
near the background noise level.

Use the Performance / Sensor Comm.Graphics command for EACH bird and
acoustic unit.

Step 9 Enable Path Reflections

The DMU / Path Reflections command is a switch that allows you to enable or
disable the reflection QC function. When the reflection QC function is enabled,
the DMU will analyze the acoustic data trend and attempt to detect when
reflections are present. When reflections are detected, the data quality flag bit will
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be set in the message to the host computer signifying bad (reflected) data. This
function serves as an additional layer of acoustic data QC before data is handed to
the host computer. When the function is disabled acoustic data is not checked for
the presence of reflections.

Step 10 Enable Path Prediction

The DMU /Path Prediction command is a switch that allows you to enable or
disable the path prediction feature. The acoustic pod will send the predicted value
of the path time if it does not detect a path time. When a path prediction is sent
from a pod, a +6 is placed in the signal strength field to notify the dry end that the
path is a predicted value. If path prediction is off, the DMU will ignore the
prediction from the acoustic pod. If path prediction is enabled, and the range is
configured as a two-way range, the DMU will combine a predicted value with an
actual received path from the other pod in the range pair to form a range. A
predicted value will not be used for a configured one-way range even if path
prediction is enabled since no received path time is available to qualify the
prediction. Refer to the table for a description of the operation of the acoustic path
prediction feature and its effect on the data quality flag (0 / Good Range; 1 / Bad
Range) in the host message and its effect on acoustic secondaries.

ACOUSTIC DATA DATA QUAL. FLAG

(0 / GOOD; 1 / BAD)

PERFORM
SECONDARY?

PATH 1 PATH 2 PRED. ON PRED. OFF EST. ON EST. OFF

PASSED DATA DATA 0 0 N N

RANGE DATA PREDICTION 0 1 N Y

PROC. PREDICTION DATA 0 1 N Y

CHECKS PREDICTION PREDICTION 1 1 Y Y

FAILED DATA DATA 1 1 Y Y

RANGE DATA PREDICTION 1 1 Y Y

PROC. PREDICTION DATA 1 1 Y Y

CHECKS PREDICTION PREDICTION 1 1 Y Y

Step 11 Check the DMU Status on Status Bar

The “RPQA” DMU status codes should be present on the status bar.
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The DMU status codes are as follows:

R = Run Mode (R alone is for bird data, but no acoustic scan. A and R together
are needed for acoustic data)

B = Background Noise Mode

P = Range Prediction On

Q = Path QC On

A = Acoustics On

- = Position of option turned off

Step 12 Choose a Type of Display from the View Menu

Open the View menu and choose the type of display in which you want to view
the data.
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THIS SHEET IS BLANK.
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DMU COMMUNICATIONS PROCESSOR
The DMU Communications Processor (CP) (P/N 8000-766) resides in slot 1 of

the DMU chassis.  During normal operation the LEDs on the front panel of the CP
should be in the following states:

Fail LED OFF

Status LED ON (Yellow)

Run LED ON (Green)

Scon LED ON (Green)

The ON state of the FAIL LED (Red) indicates a CP board failure.  The "bad"
CP board can be replaced with a new CP (part of spares kit - P/N 6500-057A) by
following the procedure in Section IV, Hardware, DMU Communications
Processor Replacement.
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DMU MODEM PROCESSOR COMMUNICATIONS
The DMU Modem Processor (MP) (P/N 8000-772) resides in slot 3 of the DMU

chassis.  The front panel connectors on the MP allow for convenient monitoring of
signals for troubleshooting problems.  The pinout for the front panel connectors is
shown in Figure 3.1.

PIN 10
PIN   8
PIN   6
PIN   4
PIN   2

PIN   9 - GND
PIN   7 - RTS
PIN   5 - TXD
PIN   3 - RXD
PIN   1

Figure 3.1   Modem Processor Front Panel Connector Pinout

The RTS (pin 7) signal is used to enable the FSK transmitter. The voltage level
of the RTS signal is +12V when data is transmitted to "in-water" sensors and -
12V when no data is transmitted.

The TXD (pin 5) signal is the asynchronous data that will be FSK and put on the
streamer twisted pair.  When not transmitting, the level is -12V.

The RXD (pin 3) signal is the demodulated data returned from the "in-water"
sensors.  RXD signals are valid only after a request for data (poll cycle,
diagnostics, etc.).  When not receiving data from "in-water" sensors, noise will
cause random changes of level on the RXD line, this is a normal situation.

If an MP failure is suspected, observing the above signals should help in
diagnosing the problem.

Good modem communication is required in order for a system perform properly.
Even if the system is deployed properly and no acoustic problems exist, bad
modem communications causes the system to have low range completion rates.
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Causes for Poor Modem Communications

• Interference from another system

• Saltwater intrusion in the streamer

• Improper wiring between the LIU and the streamer communication lines

• Misaligned coils

• Damaged equipment

 How to Monitor Modem Communications

 Sensor Communications Text

 The Performance / Sensor Comm. Text command accesses the Sensors
Communications Charts Dialog Box. The dialog box allows you to select the
transmission ports that you want information from. Data available in the dialog
box includes the inbound and outbound signal strength and outbound noise level
for all sensors on the selected line. Under Communications, data includes the total
number of polls issued, the number of response time-outs, and the number of
checksum errors. Under Performance, data includes the inbound noise, the
transmit voltage, the transmit current, the dc voltage (if Line Power Unit is
installed), and the dc current (if Line Power Unit is installed). The dialog box
updates automatically at every shot cycle after the initial read.

 Sensor Communications Graphic

 The Performance / Sensor Comm. Graphic command displays a graphical
representation of inbound signal strength and noise data by transmission line. The
display plots inbound received signal strength (in dB volts) as a function of linear
offset (in meters) for the selected transmission line. All sensors which
communicate over the selected line are displayed. The vertical axis represents
signal strength, and the horizontal axis represents offset distance from the
towpoint. The background noise level in dBV is shown as a horizontal line across
the graph. The display updates automatically at every shot cycle after the initial
read.

 Normally the received signal strength should decrease linearly with distance down
the line. If any significant sharp drops appear at specific points along the line, this
may a indicate leakage problem or some other condition causing attenuation.
Also, communications may be unreliable with any sensor whose signal strength is
near the background noise level.
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 Reset Counter Statistics

 The Performance / Reset Counter Statistics command accesses the Reset
Line(s) Counter Statistics Dialog Box. Select the line or lines that you want to
reset, and press the “Reset” button; this causes the Operator Interface processor to
send a command to the DMU to clear all sensor communications counters.

 Reset Communication Statistics

 The Performance / Reset Comm. Statistics accesses the Reset Line (s)
Communication Statistics Dialog Box. Select the line or lines that you want to
reset, and press the “Reset” button; this causes the Operator Interface processor to
send a command to the DMU to clear and reset the filtered signal strength,
background noise, and line power statistics.

 DigiRange Diagnostics
 Several tools are available for monitoring performance and diagnosing problems
with the DigiRange system.  These include the Operator Interface options
Acoustic Disk Logging, Reset Range Statistics, and Check Background Noise.
The main tool for diagnosing problems with specific ranges is the Analysis
program (see Section VII).

 Range Completion Rate

 A useful and obvious indicator of acoustic system performance is the range
completion rate.  A range that has problems for any reason will indicate a low
completion rate.  Range completion rates can be viewed on the Operator Interface
Range/Path Data display.

 If the system is set up correctly, the recommended deployment methods are used,
and the system is operating correctly, the expected Range Completion Rates are as
follows:

 Front network: > 80%

 Mid network:  > 95%

 Tail network:  > 95%

 Causes of Low Completion Rates

• Improper deployment

• Damaged equipment

• Poor modem communications
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• Poor or inconsistent acoustic path

• High ambient noise

• Improper aperture or threshold settings

 Acoustics Disk Logging

 The Performance / Acoustic Disk Logging command accesses the Disk Logging
Dialog Box. The dialog box allows you to cause the next N shot points worth of
acoustic data to be logged to a file on the hard disk of the Operator Interface
system, where N is a user-entered value (default=250). Logging terminates
automatically after the specified number of shot points, or you can choose to
terminate logging early. The logged acoustic data can be analyzed by the Analysis
program. The log file name is constructed from the current date and time, and has
the extension “.DEP”.

 The Acoustic Logging Counter (ALog) on the Status Bar counts the number of
shots logged.

 

 The Skipping Nth Shots option is not active here; it is active only in the
Disk Logging: Depth & Fin Dialog Box.

  Reset Range Statistics

 The Performance / Reset Range Statistics accesses a question box asking
whether or not you wish to proceed.  A “Yes” response causes the Operator
Interface processor to send a command to the DMU to reset the range percent
completion values to zero.

 Check Background Noise

 The Sensor / Check Background Noise command measures the background
acoustic noise while off-line (not in the Run Mode). A special configuration is
downloaded to the CMXs, which turns off the transmitters in the CMX units. The
receive apertures are still active and viewing the ambient background noise. The
save acoustic .DEP file option can be used to record the background noise and
then view this information using the Analysis program.

 Before returning to normal operation, the runtime configurations must be
downloaded to all CMXs using Download CMXs Configuration.
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 Range Status

 Range status can be monitored to help diagnose many acoustic related problems.
When a range seems to have a high occurrence of a status other than "normal", the
cause of the problem should be diagnosed and solved.  Range statuses can be
viewed on the Operator Interface Range/Path Data display as color-coded text.

 Range statuses are as follows:

• Secondary Ranges

• Aperture Edge

• Discrepancy

• One-Way Ranges

• No Range

 Secondary Ranges

 "Secondary" ranges, if enabled, indicate that the primary range was determined
to be bad and the secondary range was sent to the host.  A high percentage of
secondary ranges indicates an interference problem with acquiring the primary
range.  The interference could be affecting primary modem communications or
acoustic paths.  If modem communications interference is suspected, refer to the
Modem Communications section for possible causes.  If acoustic path interference
is suspected, identify and disable, one at a time, all possible causes.  Some
possible causes are other acoustic systems, gun wake or other communication
systems in the streamer.

 Aperture Edge

 "Aperture edge" is caused by having the aperture improperly set for the existing
dynamics of the system.  Refer to the Aperture Size section for an explanation of
how to set apertures.  It is normal to have this condition just after starting a turn or
just before the streamers are become straight after a turn.

 Discrepancy

 "Discrepancy" is an indication that two paths failed the range processing
verification test (which suggests that the sensor is in a noisy environment).  This
test requires ranges of 600 meters or less to have path times that are within 2 ms
of each other.  Ranges greater than 600 meters use a test criteria of 4 ms.  Failure
of this test indicates that the paths are not the same.  The Analysis Program should
be used to help determine which path is correct.
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 One-Way Ranges

 "One-way" ranges are usually caused by localized acoustic path blockage or
noise sources.  For ranges that consistently provide only one way data, there may
be a problem with one path. This is sometimes seen in ranges from Remote Hull-
mount Transducers to Remote Transducers attached to energy sources. If this is
the case, access the Setup Program to label that range as a "one-way" path only.
This causes one-way ranges to be flagged as good data.

 No Range

 "No range" indicates that no path, primary or secondary, has been detected.  If
this happens a very high percentage of the time, a setup or deployment problem
probably exists.

 Signal Strength

 Signal strength is an indication of the physical acoustic path quality.  Problems
in the acoustic path will show up as a lower than expected signal strength.

 If the system is setup correctly, the recommended deployment methods are used,
and the system is operating correctly, the expected Average Signal Strengths are
as follows.

 

 The signal strength for a given shot point will vary from the average
by as much as 6 dB.

 Average Signal Strengths

  10m to 19m  -6 dB

  20m to 39m  -12 dB

  40m  to 79m  -18 dB

  80m to 159m  -24 dB

  160m to
319m

 -36 dB

  320m  to
640m

 -42 dB

  641m to
1200m

 -48 dB
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 Aperture Size

 Aperture size should be set according to the dynamics of the range measurement
being made.  If the apertures are too small for a given range, when currents or
skew are present, the range will not be received.  When the apertures are larger
than needed for a given range, acoustic noise will have a greater chance of causing
a false signal detection.

Recommended Aperture Sizes

 Range between two Cable-mount CMX’s on the same line: ±10ms

 Range between two Remote Transducers (energy source): ±10ms

 Range between Remote Hull-mount Transducer and any other sensor: ±20ms

 Range between Cable-mount CMXs on different lines (gun system): ±20ms

 Range between Cable-mount CMXs on different lines (mid cable): ±40ms

 Range between Cable-mount CMXs on different lines (tail system): ±60ms

 Deployments in weak ocean currents or with short streamers can operate with
smaller apertures.  Deployments in strong ocean currents or with very long cables
may need larger apertures.  Circle shoot deployments will require much larger
apertures for all cross brace ranges in the mid and tail network due to the changing
dimensions of the system on progressively smaller radius circles.  In any situation,
the aperture must be big enough so that the maximum deviation from the nominal
setup will not cause the range to quit coming in.  Larger apertures will cause the
total cycle time to increase.

 When to Alter an Aperture

 Using the Operator Interface Program, the range screen will indicate when a
range is approaching the edge of the aperture by changing the color of the range
measurement. Using the Analysis Program, view the plot of the range in question.
An aperture set too small will show up as a clipped wave form. Apertures can be
adjusted online through the Operator Interface Program or by using the Setup
Program.
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 Reflections in Range Data
 Problems involving reflected signals are sometimes difficult to detect.  The
turbulence caused by the guns causes the direct acoustic signal between the
sensors to be severely attenuated.  When the sensors do not detect the attenuated
direct signal, they may detect a stronger indirect signal and assume that it is a
valid range.

 

 For a reflected signal to be reported as a good two-way range, both
sensors must receive the indirect signal.  If one sensor receives the
direct signal and the other receives the indirect signal, the range may
be reported as bad because of the discrepancy.

 Identifying Reflections

 Using the Analysis Program, view the plot of the range in question along with its
associated paths.  Reflections will appear as a well-defined band of data with an
upper edge that tracks the lower edge.

 Reflection Mode Dual Tracking Option

 DigiRANGE CMXs are equipped with a "Reflection Mode" option.  This option
may be used when you have identified a reflection problem with a particular
range.  Reflection problems are usually revealed by a "double band" of data in the
graphical range display of the Analysis Program.

 In most cases, reflections can be eliminated by adjusting thresholds or by closing
the stop aperture.  The Reflection Mode should only be used if threshold and
aperture adjustments fail to eliminate the reflection.

 

 
 CAUTION:  Never use the Reflection Mode Dual Tracking Option
in mid or tail nets.

 

 Shallow water prospects increase the probability of reflection problems in
ranges.  The reflection problem is normally more prevalent in the front section
network, (guns, hull mounts, cross streamer ranges).

 In dual signal tracking, two signals are tracked instead of one.  The first
trackable signal is reported as the path time by the CMX.

 To activate the dual signal tracking feature, use a threshold index from -11 to -
20.  (For example, if an original setting is -6, its dual tracking setting is -16.)
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 Rack-Mount CMX Diagnostics

 Error Indicators While in Run Mode

 Rack-mount CMX errors will usually be indicated by the following display
conditions while in Run Mode:

 COMM ERR (RED COLOR CODE) Communication Error

 This condition is updated and displayed every shot point. COMM ERR can
indicate that any of the following problems exist:

• Failed modem if all CMXs on one modem line (streamer) are exhibiting this
condition

• Failed DMU if no communication on all modem boards

• Failed  CMX electronics

• Failed  LIU Interconnecting cable (P/N 8000-044)

   INTDIAG ERR (YELLOW COLOR CODE) Internal Diagnostic Error

 This is a summary fault indication that is updated and displayed every shot point.
If any Error condition exists in a CMX other than “Depth Module,” it will be
colored yellow.

 Diagnostics While Not in Run Mode

 Test the Rack-mount CMX using the procedures described in Section IV,
Hardware, Dual Rack-Mount CMX.  Use a known good Remote Transducer and
the special Short Test Cable. Use the Polarity Checker as well.

 If all appears well with the Rack-mount CMX itself, the problem may be due to
a damaged Remote Transducer (energy source or hull mount) or by a damaged
interconnecting cable.

 Check the interconnecting cables for the Remote (energy source) Transducers.
Use the Pre-Deployment Checkout procedure; again use a known good Remote
Transducer. Use the Polarity Checker as well. The firing line cable may have
water intrusion.

 Check the interconnecting cables for the Remote Hull Mount Transducers. Use
the Pre-Deployment Checkout procedure; again use a known good Remote
Transducer. Use the Polarity Checker as well. The waterproof interconnecting
cable may have been damaged and have water intrusion.
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 If both the Rack-mount CMX and the Remote Transducer (energy source or hull
mount) interconnecting cables check out. Then replace the Remote Transducer.

 Remote Transducer Diagnostics

 Perform Pre-deployment Checkout

 Perform pre-deployment checkouts by following the procedures in Section IV,
Hardware, Remote Transducer.

 Pulse Monitor Test

 The intent of this reading is to determine gross status of the transmitter circuitry
and the transducer and cabling. The Pulse Monitor count is a number from 0 to
255 that represents the relative current flowing into the transducer.

 Normal readings are in the range of 155 to 210.  A low value, near 0, means that
no pulse was transmitted. Check to see if a valid Transmit Channel is selected.

 If the transducer is suspected of being bad, replace with a new one from the spares
kit.



System 3 (Version 4.0) User’s Manual

50

Cable-Mount CMX Diagnostics

 Error Indicators While in Run Mode

 Cable-mount CMX errors will usually be indicated by the following display
conditions while in run mode:

 COMM ERR (RED COLOR CODE) Communication Error

 This condition is updated and displayed every shot point. COMM ERR can
indicate any of the following problems:

• CMX not on streamer

• Water intrusion into streamer (leakage)

• Dead batteries or no batteries installed

• Communication Coil (collar) misalignment

• Failed System 3 modem if all CMXs on one modem line (one streamer) are
exhibiting this condition

• Failed DMU if no communication on all modem boards

• Water in CMX

• Failed CMX electronics

• Damaged communication coil in CMX nose assembly.

• Loose, unplugged, or damaged coil interconnecting cable in CMX

• High communication background noise; usually due to the streamer AC power
supply. The OFF (V) in CMX Diagnostics Page will usually read 1.0 or less if
this is the problem.

 INTDIAG ERR (YELLOW COLOR CODE) Internal Diagnostic Error

 This is a summary fault indication that is updated and displayed every shot point.
For a more complete description of error conditions, causes, and possible
solutions, refer to the section Off-line Diagnostics.

 CONFIG ERR (CYAN COLOR CODE) Configuration Error

 This condition is updated every time the CMX Configuration is changed, either at
run-time or at Setup time. This error indicates that the CMX Configuration does
not match the configuration in the DMU's memory. Configuration error is caused
by:
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• Communication failure during " Download to CMX" at setup time

• Failure during run-time Configuration changes (aperture adjustments,
threshold modifications) for a selected range The failure could occur due to:
Communication problems on the Tx line or with a CMX or CMX having the
correct unit number (CMX ID) but having the incorrect serial number entered.
To clear this condition, you must download the CMX.  If the problem still
exists, then the communications may be bad or the CMX may have a have an
internal problem.

 Diagnosing Problems While in Run Mode

 The CMX run-time status information code is displayed for each CMX in the run-
time CMX display screen.  The code is a 16-bit integer displayed in
hexadecimal format. Leading zeros are not displayed.

 CMX Run-time Status Information Code:  Most Significant Byte

 The Most Significant Byte (MSB) of the integer code indicates communication
errors with the CMX.

  Bit Position  Condition if Bit Is On

  0  CMX timeout error

  1  Virtual address error

  2  Checksum error

  3  CMX missing sync error

  4 - 7  not defined

 



System 3 (Version 4.0) User’s Manual

52

 CMX Run-time Status Information Code:  Least Significant Byte

 The Least Significant Byte (LSB) indicates internal diagnostic errors for
the CMX.

  Bit Position  Condition if Bit Is On

  0  DSP host interface failed

  1  DSP reset failed

  2  High voltage status failed

  3  Acquisition buffer
overflow

  4  DSP unstop failed

  5  DSPRVOK line failed

  6  Conf Data Setup failed

  7  DSPTVOK line failed

 

 Examples

 The following examples of codes and the corresponding conditions show typical
run-time observations:

 

  Code  Condition(s)

  0  No problems

  800  Missing sync error
(communication)

  200  Checksum error
(communication)

  20  DSPRVOK line failed
(internal diagnostic error)

  80  DSPTVOK line failed
(internal diagnostic error)

  84  DSPTVOK failed;
High Voltage Status failed
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 Diagnostics After Retrieving Problem Equipment

  If it is determined that the error flag is due to a fatal equipment condition or a
dead battery pack, the CMX must be retrieved and replaced, or serviced with a
new battery pack. Once retrieved, the CMX can be further diagnosed by following
the pre-deployment procedures in Section IV, Hardware.

 Communication problems due to a damaged communication coil in the CMX
nose assembly or a loose, unplugged, or damaged coil interconnect cable can be
repaired with new parts from the spares kit or from another nose assembly.

 The intent of this reading is to determine gross status of the transmitter circuitry
and the transducer and cabling. The Pulse Monitor count is a number from 0 to
255 that represents the relative current flowing into the transducer.

 Normal readings are in the range of 155 to 210.  A low value, near 0, means that
no pulse was transmitted. Check to see if a valid Transmit Channel is selected.

 If the transducer is suspected of being bad, replace with an assembly from the
spares kit.
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 OFF-LINE DIAGNOSTICS
 Further diagnostics can be performed with the Operator Interface Program while
the DMU is out of the run mode.  To do this, click on the Diagnostic / Acoustic /
Diagnostic Page command, which accesses the CMX Information Dialog Box.
The dialog box contains more detailed information on a specific CMX unit. When
this option is executed off-line, an option is available for downloading a special
test configuration to the selected CMX unit. This is most useful during initial
deployment, when the CMX may not have a valid configuration. After the
Diagnostic Page option is selected in off-line mode and the desired Unit ID is
entered, you can download the special configuration by pressing the Download
Diagnostic button. If the special configuration is downloaded, the previous
configuration must be re-downloaded after completing the diagnostics procedure.

 Unit Number
 This is the identifier (that you assign) which System 3 uses to communicate with
an individual CMX. Never use the same unit number on two CMXs connected to
the same System 3 Line Interface Unit port. This causes operator and system
confusion because both CMXs will try to communicate at the same time, resulting
in at best one of them getting through sporadically, and at worst no
communication to either unit.

 Serial Number
 This is the factory assigned serial number stored in the CMX Control Module
EPROM, and is used to assign Unit Numbers as well as unambiguously identify a
particular CMX. You can not change this number.  DigiRANGE CMXs are
assigned serial numbers of 3000 and above.

 Transmit Channel
 This is the number of the active transmit channel being used in this diagnostic.
In this mode, if the diagnostic configuration has been downloaded to the CMX,
transmit channels 1 to 5 can be selected one at a time by changing the value in the
Transmit Channel field. Channel 0 disables the transmitter and is used to observe
background noise levels reported from each of the available 8 apertures in the
SIGSTR display; the receivers are still active in this case.

 

 This transmit channel indicator only appears if the Diagnostic
Configuration has been downloaded.
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 SIGSTR
 SIGSTR (dB) refers to the DSP (Digital Signal Processor) processed received
signal strength for apertures 1 through 8. This is NOT a raw amplitude signal
strength. Readings of between -72 dB and -84 dB are typical during instrument
room checkout. A reading of -10dB indicates a stronger signal than does -40dB.
The SIGSTR range is +6 to -84 dB.  A signal strength of  +6 indicates a path
estimate.

 Signal
 Volt (V) = 0.0 0.0

 This is an indication of the relative levels of the FSK signals received by the
selected CMX from the LIU. A reading of 0.0 indicates that the CMX FSK
receiver is saturated and therefore receiving adequate signal levels from the LIU.
Numbers greater than 0.0 indicate that the signal from the 272 LIU modem is
weaker and is not saturating the CMX FSK receiver. Levels greater than about 1.0
are likely to result in intermittent or no communication. This data is useful in
finding proper coil alignment, or in detecting improper alignment when deploying
CMXs.

 Off (V) = X.X

 This is an indication of the level of the consistent, long term background noise
present on the communication twisted pair in the streamer cable. The number
presented here is inversely proportional to this noise level. A value of 2.5 or 2.4
indicates a noise free condition. Intermittent communication will more than likely
exhibit a reading of about 1.0 or less. This noise on the streamer cable is due to
interference from AC streamer power supplies. In the instrument room there are
many sources of interference; high resolution CRT monitors are among the worst
offenders. Because of this, it is sometimes necessary to take a CMX out of the
instrument room (long test coil cable) to perform pre-deployment checks. A better
alternative is to use a µ metal or steel enclosure as a shield for the test coil and
CMX coil.

 Depth / Temperature
 If the Data Acquisition Module is installed on the Control Module of the CMX,
the readings for depth and temperature are displayed here.
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 Alkaline Battery Pack
 New alkaline battery packs start at approximately 63 volts. Battery packs should
be replaced when the voltage drops below 42 volts.

 Lithium Battery Pack
 

 Acoustic Transmit Pulse Monitor
 The intent of this reading is to determine gross status of the transmitter circuitry
and the transducer and cabling. The Pulse Monitor count is a number from 0 to
255 that represents the relative current flowing into the transducer.

 Normal readings are in the range of 155 to 210.  A low value, near 0, means that
no pulse was transmitted. Check to see if a valid Transmit Channel is selected.

 Status Fields
 A white status indicator indicates normal operations. A red status indicator
indicates a failure. The following is a list of the status indicators and possible
causes of red (failure) condition status.

 Host Interface

 This is a run time status check of the communication between the Control Module
and the Host Interface of the DSP Module.

Failure Causes

• The DSP program did not download properly from the Control Module.

• The DSP did not reset properly.

• The DSP RAM contains an erroneous configuration or a corrupted program.

 CMX Action Taken If Failure Condition Exists

 Aborts further acoustic activity, fatal error.

 Corrective Action

 Failure is likely to be the DSP Module if communication is proper. Try resetting
the DSP to clear this condition by pressing the Reset DSP button.
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 DSP Reset Status

 This is a check performed only at power up or reset time to verify proper
operation of the DSP power up sequence.

 Failure Causes

• The DSP failed to get out of the low power mode (STOP).

• The DSP Module 20 MHz oscillator failed to power up in the required time.

• The DSP still failed its communication check after the previous two events
successfully  occurred.

 CMX Action Taken If Failure Condition Exists

 System retries 5 times then aborts subsequent acoustic actions, fatal error.

 Corrective Action

 Failure is likely to be the DSP Module if communication is working. Try resetting
the DSP to clear this condition by pressing the Reset DSP button.

 High Volt Status

 This is a run time check performed before and during every pulse transmit event
to determine the condition of the high voltage power supplies (HVPS) and the
power amp.

 Failure Causes

• The + or - HVPS is not at the correct voltage level before transmitting the
pulse.

• The + or - HVPS has dropped too far in voltage level while transmitting the
pulse.

 CMX Action Taken If Failure Condition Exists

 Further transmit action is not attempted. Probable fatal equipment error. Symptom
is no ranges will be received by other CMXs from this CMX.

 Corrective Action

 Low or faulty battery packs can cause this error status to be set. Check wiring
and/or change transducer. Failure is likely to be on the Power Module in the
HVPS section.
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 Invalid Setup

 An invalid configuration has been downloaded to the CMX.

 CMX Action Taken If Failure Condition Exists

 CMX aborts all acoustic activity.

 Corrective Action

 Check the unit’s acoustic configuration in the Setup Program, to see if it has any
invalid parameters.

 DSP Unstop

 RESERVED.

 DSP Receive Voltage OK (VOK) line

 This is a run time check performed before receiver apertures are opened to
determine that the levels of the receive circuit's power supply voltages have
stabilized to their proper values.

 Failure Cause

• + or -RVSW is not at the correct voltage level before opening receive
apertures.

• + or -5RVSW is not at the correct voltage level before opening receive
apertures.

 CMX Action Taken If Failure Condition Exists

 Aborts all acoustic activity.  DSP reset attempted.  Probable fatal equipment error.
Symptom is no ranges will be received by this CMX.

 Corrective Action

 The most likely cause of this problem is a spent battery pack.  A failure is
likely to be on the DSP Module in the ±RVSW or ±5RVSW section.  Replace the
batteries.

 Configuration Data Setup

 This is a check performed every time a configuration parameter is downloaded to
the CMX. A minimal amount of error checking is done here since most of the
configuration checks are done by System 3.
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 Failure Cause

 Configuration value is not within bounds.

 CMX Action Taken If Failure Condition Exists

 CMX will not respond to the System 3 "SYNC", no acoustic ranging will take
place.

 Corrective Action

 The most likely cause of this problem is an error in the Setup configuration file

 DSP Transmit Voltage OK (TVOK) line

 This is a run time check performed before every pulse transmit event to determine
that the levels of the transmit circuitry's low voltage power supplies have
stabilized to their proper values.

 Failure Cause

 + or -TVSW is not at the correct voltage level before transmitting the pulse.

 CMX Action Taken If Failure Condition Exists

 Transmit action is not attempted.  Probable fatal equipment error. Symptom is no
ranges will be received by other CMXs.  Receiver action will continue anyway.

 Corrective Action

 The most likely cause of this problem is a spent battery pack. A failure is
likely to be on the DSP Module in the ±TVSW section.  Replace the batteries.

 

 The equipment for this status does not exist on the 9000-4010 and
9000-4010/3 CMXs. The status is permanently set to "check" by the
CMX firmware.

 Electrically Erasable PROM (EEPROM) Test

 This is a test performed only at power up time in which the contents of the non-
volatile EEPROM are summed and compared against the checksum also stored in
EEPROM. This test is to ensure the integrity of important configuration data, i.e.
Unit Number.

 CMX Action Taken If Failure Condition Exists

 EEPROM checksum fails during RESET check.
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 Failure Cause

 Failure is likely to be on the Control Module; in particular the MC68HC11 micro-
controller itself.

 Data Acquisition Module

 This Failure condition status is used and set for two purposes:  Checked at power
up to determine if a Data Acquisition Module is installed on the Control Module
and, if it is installed, to determine proper operation for depth and temperature data
acquisition.

 CMX Action Taken If Failure Condition Exists

 If "F" is set upon power up (no DAQ module present); no further attempts are
made to access this function. If it is determined that DAQ Module is installed then
several retries are made during run mode before setting this error status.

 Failure Cause

 Failure is likely to be on the Data Acquisition Module installed on the Control
Module.

 

 The Data Acquisition Module is not normally installed in the CMX
and therefore its normal status is in the failure condition.

 External RAM Test

 This check is performed only at power up time only and consists of a multi pattern
test on each cell of the 8K byte RAM on the Control Module.

 Failure Cause

 Any cell fails to read back any of the patterns written to it.

 CMX Action Taken If Failure Condition Exists

 All cells are zeroed out and further action is attempted. Possible software error.
Also possible that the failed cell is not used by the program. If symptom persists,
it is a probable fatal equipment failure.

 Erasable PROM (EPROM) Checksum

 This is a checksum test on the program section of the EPROM on the Control
Module that is performed at every power up.
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 Failure Cause

 EPROM checksum fails.

 CMX Action Taken If Failure Condition Exists

 Further action is attempted. This is a probable fatal equipment failure.

 X-memory in DSP

 This is the status of a RAM pattern test performed on the external RAM X-data-
memory on the DSP Module.

 Corrective Action

 Failure is on the DSP module.

 Y-memory in DSP

 This is the status of a RAM pattern test performed on the external RAM Y-data-
memory on the DSP Module.

 Corrective Action

 Failure is on the DSP module.

 P-memory in DSP

 This is the status of a RAM pattern test performed on the external RAM P-
program-memory on the DSP Module.

 Corrective Action

 Failure is on the DSP module.

 Analog to Digital (A/D) Converter Condition

 This status check is performed every time the A/D converter internal to the
MC68HC11 micro-controller on the Control Module is used, i.e. communication
background noise checks (2.5V), ± Battery Voltage Reads.

 Failure Cause

 Any time that the A/D converter times out during a conversion process.
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 CMX Action Taken If Failure Condition Exists

 A/D conversion is aborted and tried again next time. This is a probable fatal
equipment failure. May not necessarily stop CMX operation but will result in no
communication background noise checks (2.5V), or ± Battery Voltage Reads.
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 TROUBLESHOOTING UTILITIES

 Geometry Verification

 Set Geometry Parameter

 The Sensor / Set Geometry Parameters command accesses the Geometry Test
Settings Dialog Box, which allows you to select an acoustic group and enter the
two reference CMXs (origin and baseline). The origin CMX defines the center of
a local coordinate system for the group, and the baseline CMX determines the
orientation of the local coordinate system.  Following your selection of the two
reference CMXs, select the Sensor / Request a Geometry Test command.

 Request a Geometry Test

 The Sensor / Request a Geometry Test command initiates the geometry
verification process. When the process is started, the CMX Serial numbers are
read and compared with the configured Serial numbers.

 

 At this point, it is assumed that all CMXs are deployed and their
acoustic configurations downloaded, and the reference CMXs (origin
and baseline) are specified.

 For units with mismatches, both the configured Serial number and the true Serial
number (read from the sensor) are displayed next to the Unit ID. Mismatches must
be resolved in order to proceed further (communications failures are ignored).

 If all Serial numbers match, the verification will proceed. During the next phase,
the DMU collects range samples over 10 shot intervals and then computes the
estimated positions of the CMXs. The DMU must be in Run Mode for the
sampling process to proceed. Other operations can be performed at the Operator
Interface while this sampling is in progress. A message appears when the
verification is complete (allow at least 10 shot intervals), indicating that the
results are available for display.

 Any of the following error conditions can prevent the verification process from
determining the CMX locations:

• invalid reference CMXs specified

• insufficient range data for reference CMXs

• insufficient range data for the group

• no convergence
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• RMS exceeds threshold.

If the ‘invalid reference CMXs specified’ message appears, re-enter two reference
CMXs, ensuring that they are on the same line. If any of the other error messages
appear, verify that all CMX configurations have been downloaded and that the
CMXs are communicating. Then go to the Range display and check the status of
the ranges in that group. If a fault is discovered, restart the verification after it is
corrected.

During the acquisition of the geometry verification data, the lines should
be straight and no turns made.

Retrieve Geometry Results

The Sensor / Retrieve Geometry Results command accesses the Select Group
Dialog Box. The dialog box allows you to select the number of the acoustic group
that you want to view in order to obtain the results of the last geometry
verification. A dialog box appears briefly and informs you that the verification
results are being compiled. Following the compilation of the geometry verification
results, they are displayed in a tabbed window. The window is divided into two
groups: Lines and Units and Acoustic Ranges.

The Lines and Units Geometry Test Results Display allows you to view the
configured lateral offset and the calculated lateral offset for each line and sensor
unit found in the selected group. All offsets are in meters. The calculated offset
for the line is the average of the calculated lateral offsets of all CMXs on that line.
Any calculated lateral offset that differs from the corresponding configured offset
by more than 10 meters is displayed in a pre-selected color. Any unit with
insufficient valid range data to participate in the verification is displayed in
another pre-selected color.

To select the colors used in the displays, use the tabbed System
Preferences Dialog Box, which is accessed by clicking on File /
Preferences. Note that if your monitor is not using True or High Color,
the colors you select may appear differently in the displays.

The Acoustic Ranges Geometry Test Results Display allows you to view the
configured, calculated and measured range distances (in meters) for each range in
the selected group. The measured range is based on an average of the observed
range values collected over the 10 shot intervals, with all unqualified range
measurements excluded. If an insufficient number of valid measurements were
obtained over this 10-shot sample interval for a range, that range is displayed in a
pre-selected color. Any calculated range that falls outside the center half of its
configured aperture is displayed in another pre-selected color.



Section III  Diagnostics

65

CMX Verification Test
The Sensor / CMX Verification Test command verifies the acoustic ranging
operation of a pair of CMXs by measuring a single range between two CMXs
whose transducers are in close contact. The range value reported between the
CMX pair is an indication of the accuracy of the two CMXs. This is essentially a
zero-range verification test. To pass the test, the reported range time should be 0.0
+/- 0.1 millisecond.

A special Setup file named ZERO.CFG is used for the verification test. This file
contains only two CMXs, both on transmission port 1 (AA01 and AA02), with a
single range between them.

The following steps are required to perform this test:

1. Position two cable-mounted CMXs so that their transducers are barely in
contact. Minimal contact is recommended. Place a suitable impeding
medium (the recommended medium is the bubble pack wrapping used to
ship the battery packs) between the transducers.

2. The CMXs must communicate over a line connected to modem
transmission port 1. If the default test configuration (ZERO.CFG) is
modified, be sure that the two CMXs are connected to the appropriate
modem port and have different unit numbers.

3. Enter the Setup program, open the ZERO.CFG Setup file and enter the
serial numbers of the two CMXs being used. Then, transfer this file to the
DMU (File / Transfer to DMU command). After a successful transfer,
exit Setup.

4. Enter the Operator Interface (OI) program and select the DMU / Exit Run
Mode command.

5. Select the  Sensor / Deploy an Acoustic Unit command. Enter the first
CMX ID (AA01) in the Unit ID field, and select ‘Assign Unit Number’
from the list of Command options. If an error message appears, repeat the
operation until it succeeds. Return to the Unit ID and repeat the same
procedure for the second CMX (AA02).

6. Select the Sensor / CMX Verification command. The CMX
configurations will be downloaded to each of the two pods. A message
will appear confirming each download.

7. Select the DMU / Enter Run Mode command. This activates data
acquisition and acoustic ranging.

8. Observe the acoustic signal strengths for path 1 and path 2 for the range
“AA01-AA02”. They should fall within the range of -35 dB to -1 dB. If
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they do not, make small adjustments to the position of the CMX
transducers or the impeding medium to change the contact pressure.

9. Select the DMU / Path Reflections command to ensure that both CMXs
are communicating properly (CMX Unit IDs are both the correct pre-
selected color).

10. Observe the range time for range “AA01-AA02” over several shot
intervals. The reported range should be 0.0 +/- 0.1 millisecond.

11. When the test is complete, return to the Setup program and transfer the
desired Setup file to the DMU (File / Transfer to DMU command). Then
go through normal deployment procedures.

Before returning to normal operation, the runtime configurations must
be downloaded to all CMXs using the Download CMXs Configuration
command.

Test Coil Diagnostics
If you have a free (unused) Transmission port on the Line Interface Unit (LIU),
you can designate that port as a Transmission line, create a platform/line, type is
Test Cable, label the Test Port “T”, and click on the Diagnostics / Acoustic
Diagnostics command.

Read AGC
1. Click on the Diagnostic / Read AGC command.

2. Use @ as a wildcard to read all AGC’s.

Sensor Communication Test
The Performance / Sensor Comm. Test option performs a communications test
on a sensor.  This test allows you to send a number of polls to a selected sensor,
and to display the results in a table of statistics. When this option is selected, the
Sensor Comm. Performance Test Dialog is displayed.  From here you select the
platform line and the device type, and enter the sensor’s unit number (or serial
number) and the number of times to poll the unit.  To poll continuously without
stopping until the window is closed, enter zero for the number of times to poll.
Click “Start” to begin the test.
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The results displayed include the total number of polls issued, the number of
responses, errors, and timeouts, and the percentage of failures.  This data can be
saved to a file by clicking the “Save” button.
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DATA MANAGEMENT UNIT

Overview
The Data Management Unit (DMU) is the interface between the shipboard
computers and the sensors on the cables.  It serves as a centralized data switch for
data collected from the sensors, and distributes data to the shipboard computers.
All functions relating to communications with the sensors and external computers
are implemented within this unit.

Figure 4.1  Data Management Unit (front view)

Communications Processor
The Communications Processor (CP) handles all high-level communications and
data management functions, which includes the acquisition cycle timing and the
interfaces to the shipboard computers.

Modem Unit
The Modem Unit (which consists of a Modem Processor and a Modem I/O) is an
intelligent communications controller that implements the data link interface and
physical layer interface to the transmission lines.
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Modem Processor

The Modem Processor (MP) is an eight-port RS-232 board. It provides the
interface between the CP and the Contact Closure Board, the radio link, and the
Modem I/O. Ports 1 to 6 interface with the Modem I/O via the backplane. Port 7
interfaces with the radio link via a ribbon cable. And Port 8 interfaces with the
Contact Closure Board via a ribbon cable.  Therefore, one Modem Unit is capable
of handling up to seven transmission lines (one is a data radio link; two Modem
Units are capable of handling up to 14 transmission lines (two are data radio links;
and three Modem Units can handle up to 20 transmission lines (two are data radio
links). The actual number of lines used in a given installation is specified during
system setup.

Modem I/O

The Modem I/O converts RS-232 to FSK (and vice versa) for communication to
and from the birds and the acoustic units. It also provides transmission signal
quality monitoring. Each of the 6 BNC connectors on the front panel are
connected to one of the six FSK transmission lines for external signal verification.

Communications between the Modem Units and the sensors on the streamer cable
uses the communications protocol described in the document System 3
Transmission Line Communications Protocol, (P/N 1000-191). The Modem Unit
handles the low-level functions related to the acquisition of data from individual
sensors on each transmission line, including polling of individual sensors, framing
of received responses, error detection, and re-polling of non-responding sensors.
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Figure 4.2  Data Management Unit (rear view)

Serial Ports 1 through 4
The four interface ports (which are located on the rear panel on the DMU chassis)
are used for data links for communications between the DMU and the other
system components.

Serial Port 1

Serial Port 1 is the Console port, which is used to troubleshoot system problems
or to perform software upgrades.

Serial Port 2

Serial Port 2 is the main communications port between the shipboard (Host)
computer and the DMU. The Host computer and the DMU Serial Port 2
communicate through a bi-directional serial link (RS-232 link).

The DMU responds to commands from the Host computer to perform various
functions related to data acquisition and output, including timing control for data
acquisition triggering.
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Host Data Transfer

Two basic types of data formats, binary and ASCII, are supported for the transfer
of non-acoustic sensor data from Serial Port 2 to the Host computer.  Several
protocols are supported for the transfer of data in binary format, and one protocol
is supported for ASCII format. These protocols are specified in the DigiSCAN
Operator's Manual, 293-A Edition, (P/N 6301-293A).

Both solicited and unsolicited output of sensor data are supported. For solicited
output, a data request must be received from the Host. Unsolicited output occurs
automatically once each shot interval, with its timing controlled by the internal
scan trigger.
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Host Data Logging Modes

In the Setup program, the System / Host command will open the Host
Parameters Dialog Box. Select one of the logging modes from the table below:

Host Logging Mode Result Explanation

Disable Logging Logging is disabled.

Data Request Receipt of a trigger
event (character “d”

followed by either a 1,
2, or 3) from the Host.

The cycle begins as soon
as the Host trigger is

received.

Scan Trigger Auto log on external
scan trigger.

Data sent every external
scan trigger.

Scan on Internal Timer Auto log (auto-
triggering) on external

or internal trigger.

Data sent every external
or internal trigger.

See the note below
concerning the

DigiCOURSE Contact
Closure Board.

When the DigiCOURSE Contact Closure Board (P/N 9000-504/02) is
used for triggering, the Host Logging Mode (Scan Trigger OR Scan on
Internal Timer) and data format are specified in the Setup program.

Triggering occurs regardless of which selection is made. If logging is not disabled,
the type of data output during logging depends on which Host command is
chosen.
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Host Data Triggering

The Host computer issues commands to the DMU to initiate a single data
acquisition cycle. In a data acquisition cycle, data is collected from the sensors
and is logged (stored); the DMU also transmits to the Host computer the data
logged from the previous data acquisition cycle.

The type of data logged and transmitted depends on which Host
character(s)/command(s) is issued. The Host commands which are supported are
as follows:

Character Command

P trigger data acquisition and transmit data (ASCII)

Q (same as P)

T transmit data (log data to Host computer; ASCII)

d trigger data acquisition and transmit data (binary)

p trigger data acquisition and transmit data (extended binary)

w trigger data acquisition and transmit compass data

c contact closure trigger (mode set internally)

d followed by g trigger data acquisition and transmit data when "g" is issued
(Geco Tribird data format). The Logging mode must be set
to Data Request for this function.

d followed by 1 trigger data acquisition and transmit compass data when
1 is issued. The Logging mode must be set to Data Request
for this function.

d followed by 2 trigger data acquisition and transmit depth data when 2
is issued. The Logging mode must be set to Data Request
for this function.

d followed by 3 trigger data acquisition and transmit fin angle data when
3 is issued. The Logging mode must be set to Data Request
for this function.

Acoustic Data Option

Optionally, Serial Port 2 can be selected for the output of acoustic range data. If
Serial Port 2 is selected for acoustic data, an acoustic range message is transmitted
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every time a Host log event is scheduled. The range message follows the non-
acoustic data message.

Acoustic Data Protocol

The protocols used in the transfer of acoustic data are specified in the following
documents:

DigiCOURSE ECHO Standard Host Protocol (P/N 1000-132)

DigiCOURSE ECHO Extended Host Protocol P/N 1000-133)

DigiCOURSE Extended Acoustic Protocol (P/N 1000-361)

Acoustic data output by the System 3 DMU to the Host computer
employs the selected protocol regardless of whether Serial Port 2 or
Serial Port 3 is used. (Refer to the Host Parameters Dialog Box,
Acoustic Data Protocol selection.)

Serial Port 3

Serial Port 3 is the primary acoustic port between the shipboard (Host) computer
and the DMU. The Host computer and the DMU Serial Port 3 communicate
through a bi-directional serial link (RS-232 link).

If this port is used, an acoustic data message is output at the beginning of each
scan cycle. The type of message to be output is specified as a configuration
parameter.

Serial Port 4

Serial Port 4 is not used.

Specifications

Physical Characteristics

Width: 48.26 cm (19.00 in)

Depth: 47.75 cm (18.80 in)

Height: 35.28 cm (13.89 in)
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Electrical Characteristics

Input Voltage: 90 - 132 / 180 - 264 Vac

Input Frequency: 47 to 63 Hz

Input Power: 575 VA (max)

Output Voltages: +5 Vdc @ 70A

+12 Vdc @ 10A

-12 Vdc @ 6A

Maintenance
The System 3 DMU chassis has a forced air ventilation system that draws air from
the bottom of the chassis, through an air filter, and routes the air over the circuit
boards and out the top of the chassis. Leave adequate space above and below the
DMU chassis for proper ventilation. Inspect and clean the air filter as often as
environmental conditions dictate. The air filter is accessible by removing the three
captive screws on the bottom front panel.

Installation

Before Installation

The Data Management Unit (DMU) and inter-connecting cables have been
fabricated in accordance with standard DigiCOURSE manufacturing procedures.
Visually inspect each piece for any possible damage due to shipping.  Ensure that
all items have been shipped as per the packing list.

Installation Equipment Required

The following equipment is required  to install the DMU:

1. DMU (P/N 9000-501A)

2. Line Interface unit (P/N 9000-505)

3. Power cable, supplied by DigiCOURSE (P/N 6000-026).

4. DMU to LIU inter-connection cable (P/N 8000-775); supplied by
DigiCOURSE

5. Rack slide rail and extension kit for the DMU; supplied by DigiCOURSE.
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6. Rack mounting screws; user supplied..

7. Screwdriver.

Installation Procedure

1. Mount the rack side rails in the rack with the hardware provided. The DMU is
shipped with the rack slides attached.

2. Install unit in rack and secure with the four front panel rack screws (user
supplied).

3.  Leave sufficient space above and below the DMU for unrestricted airflow.

Failure to allow for sufficient airflow may cause overheating and
failure of the DMU.

4. Install the power cable but leave the unit power switch off.

5.  The DMU power supply automatically configures itself for use with either
115Vac or 230Vac line voltage.

DMU Hard Drive Replacement

The hard drive used in the DMU is a 240 Mbyte SCSI drive.  A SCSI hard drive
is included in the spares kit (Note: any SCSI hard drive may be used as a
temporary replacement drive if a hard drive failure occurs).  In the event of a hard
drive failure, the DMU will not boot up properly during a power up.  To replace
the hard drive, follow the procedure outlined below:

1. Remove the power cord from the DMU.

2. Remove the four screws on the front panel of the drive bay on the DMU and
slide the drive bay out the front of the DMU.  If the drive bay does not slide
out, there may be two additional screws holding the drive bay in place.  The
two screws are accessible through the top cover of the DMU (note: before
sliding DMU out on rails, remove modem cable connector on rear of DMU).

3. Remove the power cable connector and SCSI cable connector from the rear of
the hard drive.  Remove the hard drive from the drive bay by removing the
four screws that secure the hard drive to the bay frame.

4. Install the replacement hard drive in the drive bay and secure it with the four
screws.

5. Connect the power plug and SCSI connector to the hard drive.

6. Insert the drive bay into the DMU chassis and secure it with the four front
panel screws.
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7. Plug in the DMU power cord and reconnect the modem cable.

8.  Power up the DMU.

DMU Communications Processor Replacement

The DMU Communications Processor (CP) (P/N 8000-766) resides in slot 1 of
the DMU chassis.  During normal operation the LEDs on the front panel of the CP
should be in the following states:

Fail LED OFF

Status LED ON (Yellow)

Run LED ON (Green)

Scon LED ON (Green)

The ON state of the FAIL LED (Red) indicates a CP board failure.  The "bad"
CP board can be replaced with a new CP (part of spares kit - P/N 6500-057A) by
following this procedure:

1. Power off DMU.

2. Remove the ribbon cable connector from port 8 on the front panel of the
Modem Processor (P/N 8000-760) located in slot 3 of the DMU chassis.

3. Remove the 2 retaining screws on the front panel of the CP (P/N 8000-766).
Remove the failed CP (P/N 8000-766) from the DMU chassis.

4. Insert the new CP into the DMU chassis, making sure the board is properly
seated in the backplane.

5. Tighten the 2 retaining screws on the CP front panel.

6. Insert the ribbon cable connector into port 8 on the front of the MP.

7. Power on DMU.

Contact Closure Board
The Contact Closure Board is used when the host does not generate an ASCII
character for the System 3 shot point trigger, but a switch closure (either relay
closure or logic signal level change) is available as the trigger for the System 3
DMU.

This board is designed to convert a switch closure into an ASCII character ("c" or
63h). The character is then forwarded to the System 3 DMU Serial Port 2 where it
serves as the System 3 shot point trigger character.  See Figure 4.2 for the location
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of the Contact Closure Unit on the DMU. Remove the two panel screws to gain
access to the DIP switch on the Contact Closure Board for configuration.

The option switches on the closure board are defined as follows:

Switch Definition

5. 6. 7 Baud Rate Selection

4 Active High/Low Selection

2, 3 Parity Selection

1 Not Used

Baud Rate Codes

The baud rate codes are listed below where a "1" equals an open switch, and a "0"
equals a closed switch.

Switch

5 6 7 Baud Rate

0 0 0 300 bits per second

0 0 1 600 bits per second

0 1 0 1200 bits per second

0 1 1 2400 bits per second

1 0 0 4800 bits per second

1 0 1 9600 bits per second

1 1 0 1200 bits per second

1 1 1 1200 bits per second
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Parity Codes

Parity codes are:

Switch

2 3 Parity Selection

0 0 Odd

0 1 Even

1 0 Off

1 1 Off

Signal Active High/Low

Signal Active High/Low selection is as follows:

Switch

4 Signal Polarity

1 Low Open

0 High Closed

In two-boat operations, set the switch to “High” to ensure closure synchronization.

The communication configuration of the contact closure board must match the
Host Port configuration as configured by the Setup program.

Refer to Figure 4.3 for contact closure unit cable installation connections.

Refer to Figure 4.4 for the contact closure cable pin out.

The contact Closure Board also connects to Modem Processor Port 8 on the front
panel of the DMU chassis via a ten pin ribbon cable connector.
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Figure 4.3  Contact Closure Unit Cable Connections
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Figure 4.4  Contact Closure Pin Out
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Host Interface Installation
The host interface is the physical data link between the DMU and the host

computer.  It allows the transfer of sensor data to the host computer.  Physically,
the host interface consists of a serial RS-232 cable, host computer serial ports and
DMU Serial Port 2 and Serial Port 3.

On the DMU, two serial ports, Serial Port 2 and Serial Port 3, are available for
the host interface link.

Normally, Serial Port 2 is used as the dedicated compass/depth data
link to the host.  Acoustic data transfer is normally done through
Serial Port 3.

Serial Port 2 port on the DMU is a 25 pin female port used for logging
compass/depth data and receiving the System 3 shot point trigger. The pin
functions are :

1. pin 2: TX from the DMU to the host

2. pin 3: RX (trigger character from the host or CCU)

3. pin 7: GND

Serial Port 3 port on the DMU is a 25-pin female port used for logging acoustic
range data. The pin functions are :

1. pin 2: TX from the DMU to the host

2. pin 3: No function

3. pin 7: GND

Figure 4.5, Data Management Unit Connector Location, shows the location of
Serial Port 2 and Serial Port 3.
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Figure 4.5  Data Management Unit Connector Location
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THIS SHEET IS BLANK.
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Operator Interface Computer

Overview
The Operator Interface computer is the system command console. It handles all
operator control and monitoring functions by implementing the three System 3
software programs: Setup, Operator Interface (OI), and Analysis. From the
Operator Interface computer you can enter commands and configuration data to
set up the system, execute sensor control, diagnostic, and test functions, and
display current information on streamer position and sensor performance in both
tabular and graphic formats.

The system can be set up to use multiple Operator Interface computers. Up to six
Operator Interface computers can be set up to provide full command and control
functions. An additional 248 Operator Interface computers can be set up in
monitor mode only.

The Operator Interface computer(s) communicates with the DMU over an
Ethernet connection.

For information on the software run by the Operator Interface computer, see
Section V, Setup Program; Section VI, Operator Interface Program; and Section
VII, Analysis Program.
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Figure 4.6  Operator Interface Computer (typical)

Specifications

The specifications below are the minimum recommended for use as
a  System 3 Operator Interface computer.

90 MHz processor (minimum)

3.5-inch floppy disk

CD ROM drive

540 MB hard disk (minimum)

Windows NT or Windows 98 Operating Systems

Color, 17-inch, multi-sync resolution monitor
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LINE INTERFACE UNIT

Overview
The Line Interface Unit (LIU) provides the physical interface between the DMU
and the transmission lines. Each LIU has six transmission line connectors. Three
LIU’s are provided for 18 streamer capabilities: one LIU for streamers 1 through
6, a second LIU for streamers 8 through 13, and a third LIU for streamers 15
through 20.

LIU units do not have connectors for Line 7 and Line 14.  Lines 7 and
14 (on the DMU) are used as Data Radio Telemetry links and cannot
be used for streamers.

6 - TX Port in use LEDS

6 - DC Input Connectors

6 - TX Port Connectors
     use Pins A an B

6 - Relay Contact Connectors

Figure 4.7  Line Interface Unit

The LIU has output relays and a “Line-in-Use” indicator LED for each line, which
are active when the DMU Modem Unit is accessing the transmission lines. The
LIU has terminal connections for supplying dc power to the transmission lines.
The dc power supply monitoring is available as an option (P/N 9000-505/02).
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Specifications

Physical Characteristics

Width: 48.26 cm (19.00 in)

Depth: 6.4 cm (2.520 in)

Height: 13.26 cm (5.219 in)

Electrical Characteristics

Input Voltage: 90 - 132 / 180 - 264 Vac

Input Frequency: 47 to 63 Hz

Input Power: 575 VA (max)

Output Voltages: +5 Vdc @ 70A

+12 Vdc @ 10A

-12 Vdc @ 6A

Part Numbers

P/N 9000-505/01: No dc power supply monitoring.

P/N 9000-505/02: Includes dc power supply monitoring. Use with in-
streamer sensors and Line Power Unit.

Installation
1. Mount the LIU on the back side of the rack with the transmission connectors

facing outward. Secure the unit with four rack screws (user supplied).

2. Using the 8000-775 ribbon cable, connect the DMU rear panel Modem
connector (see Figure 4.8) to the Modem connector on the LIU.
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Figure 4.8  DMU and LIU Interconnections.
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LINE POWER UNIT

Overview
When in-streamer sensors requiring dc power are used, the optional Line Power
Unit (P/N 9000-503) is required to power the devices. The /02 version of the Line
Interface Unit is used with in-streamer sensors and provides dc voltage and
current monitoring through the operator interface terminal for up to six
transmission lines. The "+" and "-" terminal blocks on the Line Power Unit are
wired to the "+" and "-" terminals in the Line Interface Unit (P/N 9000-505) to
route dc power to each transmission line.

Figure 4.9  Line Power Unit

Installation

The Line Power Unit is needed only if dc voltage for powering in-
streamer sensors is required.

1. Mount the Line Power Unit on the back side of the rack underneath the Line
Interface Unit.

2. Configure the ac voltage input module for the proper line voltage
(115/230Vac).

3. Wire the "+" terminal of the Line Power Unit terminal block to the
corresponding "+" terminal on the Line Interface Unit terminal block.

4. Wire the "-" terminal of the Line Power Unit terminal block to the
corresponding "-" terminal on the Line Interface Unit terminal block.

5. Install the Line Power Unit power cable but do not power on the unit at this
time.
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MODEL 5010 DIGIBIRD

Overview
The DigiCOURSE series 5000 components are advanced, microprocessor-based
cable control devices that are mounted externally on a marine seismic streamer
cable. The Model 5010 DigiBird provides adjustable depth control, depth
measurement, and ballast information. The DigiBird has a modular construction
that allows you to change mechanical and electronic subassemblies for different
cable control applications.

Externally, the Model 5010 DigiBIRD and the Model 5011 Compass
Bird are identical except for the color of the end-cap. The Model 5010
has a white end-cap, and the Model 5011 has a black end-cap.

Figure 4.10  Model 5010 DigiBird

Specifications

Physical Characteristics

Length: 1.2 m (48.2 in)

Weight: 8.32 kg (18.3 lb) in air

2.78 kg (6.1 lb) in sea water with batteries

Mounting: Industry standard collars on 0.57 m (22.5 in) centers

Communications

Type: Serial FSK

Frequency: 26 kHz or 28 kHz

Data Rate: 2400 bits/s
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Depth Measurement

Operating Range: 122 m (0 to 400 ft)

Resolution: .05 ft (0.15 m)

Diving Plane

Lift: 15.9 kg (35 lb) at 5 knots and 125° wing angle

Airfoil: NACA 651-012 Airfoil section

Wing Span: 48.3 cm (19 in)

Battery

Cells: 4 D-cell Lithium

Life: 90 days typical operation
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MODEL 5011 COMPASS BIRD

Overview
The DigiCOURSE series 5000 components are advanced, microprocessor-based
cable control devices that are mounted externally on a marine seismic streamer
cable. The Model 5011 Compass Bird provides adjustable depth control, depth
measurement, ballast information, and compass heading data. The Compass Bird
has a modular construction that allows you to change mechanical and electronic
subassemblies for different cable control applications.

Externally, the Model 5010 DigiBIRD and the Model 5011 Compass
Bird are identical except for the color of the end-cap. The Model 5010
has a white end-cap, and the Model 5011 has a black end-cap.

Figure 4.11  Model 5011 Compass Bird

Specifications

Physical Characteristics

Length: 1.2 m (48.2 in)

Weight: 8.32 kg (18.3 lb) in air

2.78 kg (6.1 lb) in sea water with batteries

Mounting: Industry standard collars on 0.57 m (22.5 in) centers
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Communications

Type: Serial FSK

Frequency: 26 kHz or 28 kHz

Data Rate: 2400 bits/s

Depth Measurement

Operating Range: 122 m (0 to 400 ft)

Resolution: .05 ft (0.15 m)

Heading Measurement

Accuracy: Better than +/-0.5°

Resolution: 12 bits

Diving Plane

Lift: 15.9 kg (35 lb) at 5 knots and 125° wing angle

Airfoil: NACA 651-012 Airfoil section

Wing Span: 48.3 cm (19 in)

Battery

Cells: 4 D-cell Lithium

Life: 60 days typical operation
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MODEL 315 HEADING SENSOR

Overview
The Model 315 Heading Sensor is a compass designed for in-streamer installation.
A 9-bit digital number (indicative of orientation relative to magnetic North) is
latched and converted to a serial pulse train output. This sensor has a maximum
operating pressure of up to 5,000 psi. The two-wire interface provides both power
and data.

Figure 4.12  Model 315 Heading Sensor
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Specifications

Physical Characteristics

Length: 92.837 mm (3.66 in)

Diameter: 44.45 mm (1.75 in)

Weight: 341 g (12 oz)

Housing: Anodized Aluminum (tied electrically to “common”
return connection)

Electrical Characteristics

Output Data Frequency: 5.44 kHz (nominal)

Power Consumption: 20 milliamperes constant current. Compass will clamp
at 6.5 volts.

Output Format: n + 1 serial pulse train

Environmental Characteristics

Pressure Rating: 5000 psi maximum

Operating Temperature: -5°C to +55°C

Storage Temperature: -55°C to +85°C

Performance Characteristics

Accuracy: 1°

Roll: 360° continuous

Pitch: 47.5° +/- 2.5°
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MODEL 321 HEADING SENSOR

Overview
The Model 321 Heading Sensor is a compass designed for in-streamer installation.
A 10-bit digital number (indicative of orientation relative to magnetic North) is
latched and shifted out serially in a 10-bit binary Gray word format. This sensor
has a maximum operating pressure of up to 10,000 psi, and can be used in military
towed arrays. The two-wire interface provides both power and data.

Figure 4.13  Model 321 Heading Sensor

Specifications

Physical Characteristics

Length: 92.837 mm (3.66 in)

Diameter: 44.45 mm (1.75 in)

Weight: 341 g (12 oz)

Housing: Anodized Aluminum (tied electrically to “common”
return connection)
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Electrical Characteristics

Output Data Frequency: 1 kHz (nominal)

Power Consumption: 96 mW at 20 Hz / 9.6 mW at 2 Hz (sample rate
dependent)

Output Format: PWM 10-bit binary Gray word

Environmental Characteristics

Pressure Rating: 10,000 psi maximum

Operating Temperature: -20°C to +55°C

Storage Temperature: -55°C to +85°C

Performance Characteristics

Accuracy: 0.5°

Roll: 360° continuous

Pitch: 47.5° +/- 2.5°
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MODEL 452 COMPASS INTERFACE

Overview
The Model 452 Compass Interface is designed for in-streamer installation and is
the interface for the Model 321 Heading Sensor.  The Model 452 Compass
Interface consists of a modem and data acquisition circuitry which receives
heading data from a single Model 321 Heading Sensor, monitors node voltage,
monitors the signal-to-noise ratio, performs operator controllable data storage and
manipulation (Parameters that the operator can control are the averaging time, the
sampling interval, and the offset correction factor.), and transmits the conditioned
data over the twisted pair communications line to the Operator Interface
Computer.

Figure 4.14  Model 452 Compass Interface
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Specifications

Physical Characteristics

Length: 6.48 inches +/- 0.02 in

Diameter: 1.50 inches +/- 0.01 in

Weight: 17.5 oz +/- 1 oz

Housing: Stainless Steel

Transmission Line
Connection:

2-wire feed through labeled “T”

Compass Connection: 2-wire feed through labeled “C”

Electrical Characteristics

Diagnostics: Node Strength and Signal-to-Noise ratio

Circuit Protection: Reverse polarity and overvoltage conditions

Power Consumption: 120 mW typical

Data Interface: DigiSCAN protocol 2400 baud FSK

Maximum Number of
452’s per Streamer:

(see Note below)

35 for 22 awg twisted pair

25 for 24 awg twisted pair

20 for 26 awg twisted pair

This maximum number assumes 200 meters of lead in cable and one
452 unit per 100 meters, powered by DigiCOURSE Sensor Interface
Unit. DigiCOURSE recommends using a dedicated twisted pair for the
452 units in the streamer.

Environmental Characteristics

Pressure Rating: 1000 psi

Operating Temperature: -5°C to +35°C

Storage Temperature: -30°C to +65°C
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Installation

Each 452 Compass Interface unit should be installed in the streamer
at least three feet from the nearest compass to prevent any possible
magnetic distortion of heading readings..
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MODEL 483 DEPTH SENSOR

Overview
The Model 483 Depth Sensor is designed for in-streamer installation. The 1.5-
inch diameter allows the sensor to be used in nearly all types of seismic streamers.
Five models of the sensor are available, each with a different depth operating
range (100, 200, 500, 1000, and 2000 feet). The two-wire interface provides both
power and data transfer.

Figure 4.15  Model 483 Depth Sensor
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Specifications

Physical Characteristics

Length: 164.6 mm (6.48 in)

Diameter: 38.1 mm (1.50 in)

Weight: 510.3 g (18 oz)

Housing: Stainless Steel

Electrical Connection: 2-wire pass-through

Pressure Interface:

(see Note below)

1/8-inch NPT female

To order 1/8 -inch NPT male hose for use with 3/16-inch I.D. hose,
order P/N 2800-518.

Electrical Characteristics

Circuit Protection: Reverse polarity and overvoltage conditions

Power Consumption: 75 mW typical

Data Interface: DigiSCAN protocol 2400 baud FSK

Maximum Number of
483’s per Streamer:

(see Note below)

50 for 22 awg twisted pair

40 for 24 awg twisted pair

30 for 26 awg twisted pair

This maximum number assumes 200 meters of lead in cable and one
483 sensor per 100 meters, powered by DigiCOURSE serial interface
unit. DigiCOURSE recommends using a dedicated twisted pair for the
483 sensors in the streamer.

Environmental Characteristics

Operating Pressure
Rating:

2x operating depth

Crush Pressure Rating: 1000 psi

Operating Temperature: -5°C to +35°C

Storage Temperature: -30°C to +65°C
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Performance Characteristics

Depth Resolution: 11-bit

Depth Accuracy: +/- 1 percent of full scale

Temperature Accuracy: +/- 1°C

Depth Operating Ranges / Models

100 feet: Model 483/02

200 feet: Model 483/01

500 feet: Model 483/03

1,000 feet: Model 483/04

2,000 feet: Model 483/05
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MODEL 487 COMMUNICATION COIL

Overview
The Model 487 Communication Coil is designed for in-streamer installation. The
Model 487 Communication Coil performs two functions: First, it is one-half of a
transformer that inductively couples bi-directional signals with in-water sensors
and controllers. Second, it optimally loads a 22 AWG twisted pair transmission
line. This optimum loading maximizes the data signal with respect to the streamer
power system interference while holding the data signal waveform distortion to a
negligible level.

Using Model 487 Communication Coils in accordance with the instructions in
DigiCOURSE Procedure 1000-243, Recommended Practice for Twisted Pair
Communication with Seismic Streamers, will provide reliable data
communication to 6000 meters.

Figure 4.16  Model 487 Communication Coil
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Specifications

Physical Characteristics

Length: 5.25 +/- 0.01 inches

Diameter: 0.875 +/- 0.01 inch

Wire Length: 20 inches

Electrical Characteristics

Maximum DC Voltage: 100 V

Maximum AC Voltage: 70.7 V rms
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DIGIRANGE ACOUSTIC SYSTEM INTRODUCTION
This section provides the user with a general overview of the DigiRANGE and

its individual product components. Subsequent sections provide instructions for
installation, troubleshooting and maintenance of the DigiRANGE product
components.

System Description
The DigiRANGE acoustic system is a collection of measurement devices

arranged in a network to provide information that is used, along with other
navigation data, to determine the geodetic position of hydrophone groups and
energy sources.  The system provides observations of acoustic transit time
measurements between nodes (locations) of the network, with a range time
resolution of 50µs for two-way ranges.  The measurements are made by the
instruments located at each node, and the measurement data are transmitted via
System 3 to the on-board host computer.  Multiple streamer configurations and
multiple boat configurations are supported.

The system does not use conventional transponder, responder or pinger acoustic
techniques to determine transit times.  The technique used is similar in some ways
to radio positioning.

Acoustic Ranging Network
The acoustic ranging network comprises a collection of nodes that represent the

specific parts of the streamers/energy sources configuration requiring point-to-
point linear measurements to complete the geodetic traverse.  At each node a
Concurrent Multichannel Transceiver (CMX) is placed to perform the actual
measurement process to and from other nodes in the network.  The ranges
correspond to branches.  Each node can acquire range measurements for up to
eight branches connected to that node.  Each node may initiate an acoustic signal
that is used to perform the measurement at other nodes.  The nodes are assigned
transmit time schedules established by the System 3 configuration program (Setup
Program).  These time schedules are used to define which nodes are to detect the
transmitted signals required to complete the network of branches.  The arrival
times are stored in the CMXs and transmitted to the shipboard system at each
recording point using System 3.



Section IV   Hardware

107

Modes of Operation
The acoustic system supports two modes of operation for range data acquisition:
one-way ranging or two-way ranging (default). When one-way ranging is selected,
a range consists of a single path time measurement, with one unit receiving the
acoustic signal transmitted by the other unit. Range acquisition time is generally
shorter when one-way ranging is in use. When two-way ranging is selected, a
range consists of two path time measurements combined to make a range value,
with each of the two units both transmitting to and receiving from the other unit.
These modes are described in more detail below.

Two-Way Ranging

Two-way ranging offers a greater degree of measurement reliability at the expense
of a longer range acquisition time, and is the default mode of operation.  When
operating in two-way ranging mode, the DigiCOURSE acoustic system provides
derived ranges from two-way paths.  The ranges are determined by combining the
local values of the arrival time of acoustic pulses traveling along opposite path
pairs between two nodes in the network.  These arrival times along paths are
observed within milliseconds of each other.  The dry end system converts the
arrival times into transit times (time of flight), and the combination of the two
transit times removes errors due to CMX local time offsets (SYNC skew), most
system errors, and the difficult-to-determine velocity error due to the non-static
nature of the network being measured.  In addition, the two path observations
provide a degree of redundant measurement to help provide more reliable
observations. Two criteria must be met for a valid two-way range:

1. Both components of the two-way ranges must be present to form a valid
     measurement

2. Both one-way measurements must be within 2ms (3 meters) of each
other for ranges less than 600 meters, and within 4 ms (6 meters) of each
other for ranges greater than 600 meters.

This technique further exploits the advantages of the two-way range strategy.
The inherent redundancy provides an immediate means to eliminate certain errors.
Criterion number 2 significantly reduces the corruption of valid data by reflection
paths.

One-Way Ranging

One-way ranging offers a shorter range acquisition time at the expense of the error
reduction techniques available in two-way ranging mode.  This mode would
normally be used when cycle time is at a premium. When operating in one-way
ranging mode, the DigiCOURSE acoustic system provides a single path time-of-
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flight measurement for each range.  Since SYNC skew is not eliminated by
combining two path times, it is minimized by tight control of the transmission of
the SYNC signal from the dry end Modem.  Velocity error is not removed from
ranges acquired in one-way mode.

CMX Units
Located at  nodes in the network are pods containing the telemetry system
interface, control logic, and the CMX.  An identical CMX is used at each node.
Each CMX can transmit on one of five assigned channels (frequencies) and can
receive eight different transmitted signals from other nodes on any single channel
or combination of channels. The transmit and receive processes are determined by
the system network geometry.  The transmission of signals from each node does
not depend upon receipt of an acoustic signal or an external electronic trigger.
Transmission time is determined by the precision local clock in the CMX, the
network schedule defined by the Setup Program, and the system synchronization
signal (SYNCH). The arrival times are measured in local time with a resolution of
100 µs.  When the arrival times between two nodes constituting a branch are
combined, an accurate measurement of the acoustic transit time for that branch is
obtained.

The CMX units are available in two configurations to facilitate their installation
at the physical location of the nodes. One is self-contained and externally mounted
on the cable. These cable-mounted CMX units (pods) mount on standard collars
and communicate via the conventional coil communication system of System 3.

The other is located shipboard and operates with remotely located transducers. To
provide economical and reliable measurements to locate energy sources relative to
the head of the streamers, Rack-mounted CMX units are used with a remotely
located, ruggedized transducer unit.  The rack-mounted dual CMX is located in
the instrument room on board the vessel. The transducers are typically located at
the end of the gun string(s) and electrically connected to the rack-mounted CMX
by a shielded wire pair. The remote transducer contains the T/R switching and
preamplifier functions.  The rack-mounted CMXs communicate via the
conventional coil communication system of System 3.  Logically the devices
appear to be another type of bird.  Remote transducers connected to rack-mounted
CMXs are also used for hull-located nodes.

The precision of the acoustic system is possible because of the power and
versatility of the VLSI Digital Signal Processor (DSP).  The DSP generates the
acoustic signal in the 50kHz to 100kHz band, amplitude modulates the signal and
presents in digital form a time series of digital words to the D/A converter to
effect the amplitude modulated signal.  The acoustic pulse is amplified and
coupled into the water by the acoustic transducer.
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During the receive mode, the A/D converter samples the output of the acoustic
transducer after amplification.  The digitized samples are operated on by the DSP
to detect incoming acoustic signals.  This provides a reliable, repeatable signal
detection scheme with inherent noise immunity.  It is through the use of this
technology that high performance acoustic measurements are achieved.

Once a pulse is detected, the reception time is latched in the appropriate timer
counter.  After the acoustic measurement cycle ends, System 3 polls the CMX and
retrieves the contents of the timer counters and other data on board the vessel.

Acoustic System Operation
The acoustic measurement cycle begins with the issuance of the SYNCH

synchronization signal through System 3.  Each CMX contains a transmit / receive
schedule assigned by the System 3 Setup Program.  After SYNCH, each CMX, at
its scheduled time, transmits a signal on its designated channel.  The acoustic
energy travels through the water and is detected at locations where other CMXs
are expecting to receive the signals.  Internally, the CMX stores the arrival times
of detected signals for retrieval later in the cycle.  The time required to make all
these measurements is optimized by the Setup Program, and depends on the size
and geometry of the acoustic network.

The CMXs may detect up to eight path measurements at each location.  This
allows for a robust network with significant redundancy.  For example, a front-
end system with four cable- mounted CMXs and four gun array transducers can
easily measure all 28 two-way range combinations.  With a hull-mounted
transducer, 36 possible ranges (72 one-way ranges) can be obtained.  The cycle
time to make the acoustic observations is still under a second.

The data collected in each CMX is time relative to scheduled transmission at
that CMX.  The time numbers are combined and scaled to represent an integer
multiple of 50 µ sec.  When operating in two-way mode, this patented technique
eliminates time skew errors caused by the data communication system and
eliminates the offset caused by the velocity of the entire network while
measurements are being made.
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DUAL RACK-MOUNT CMX UNITS AND REMOTE
TRANSDUCERS

Overview
The Dual Rack-mount Concurrent Multichannel Transceiver (CMX) (P/N 9000-
4032) is a device containing two sets of telemetry system interfaces, control logic,
and transceiver circuitry for use with remote transducers (either towed or hull-
mounted).

Each CMX transducer can transmit on one of five channels in the 50 kHz to 100
kHz acoustic band.  Up to eight different range measurements may be acquired by
each CMX on each measurement cycle. The system is designed to support
acoustic transit time measurements accurate to 0.1 ms.

Included with each unit are two shielded cables for connecting the Dual Rack-
mount CMX to the user’s patch panel.

Figure 4.17  Rack-Mount CMX (ship-board electronics)

Dual Rack-Mount Pre-Installation Checkout

- WARNING - High voltages present. Voltages up to ±230 volts
DC (and AC) exist on the transducer connectors on the rear panel
of the Dual Rack-mount CMX.  HANDLE WITH CARE.

The Dual Rack-mount CMX (P/N 9000-4032/03), with all cables, has been
fabricated in accordance with standard DigiCOURSE manufacturing procedures.
Visually inspect each piece for any possible damage due to shipping.  Ensure that
all items have been shipped as per the packing list.
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Installation Equipment Required

The following equipment is required to install the Dual Rack-mount CMX, the
Remote Transducer (energy source), and the Remote Hull-mount Transducer.

1. Sufficient number of Dual Rack-mount CMX units (1 unit handles two
Remote Transducers [energy source or hull-mount]).

2. Power cable, supplied by DigiCOURSE.

3. Dual Rack-mount CMX to modem processor interconnection cable (P/N
8000-044); one required and supplied by DigiCOURSE for each Dual Rack-
mount CMX.

4. Dual Rack-mount CMX to instrument room patch panel 100 ft.
interconnecting cable (P/N 8000-312-100); one required for each Remote
Transducer (energy source); two supplied with each Dual Rack-mount CMX.

5. Rack slide rail and extension kit for the Dual Rack-mount CMX; one required
and supplied for each Dual Rack-mount CMX.

6. Dual Rack-mount CMX to Remote Hull Mount Transducer 200 ft.
interconnecting cable (P/N 8000-312-200); one required for each Remote
Hull-mount Transducer; one supplied with each Hull-mount Remote
Transducer.

7. Remote Hull-mount Transducer 10 m  waterproof interconnecting cable (P/N
3300-008); one required for each Remote Hull-mount Transducer; one
supplied with each Hull-mount Remote Transducer.

8. Remote Transducer Cable Tester (P/N 3300-011 from test kit 6500-059);
optional.

9. Energy source firing line cables with Reed 6400-201 connectors; supplied by
user.

Dual Rack-Mount CMX Installation

Installation Procedure

1. Mount the rack side rails in the rack with the equipment provided. The Dual
Rack-mount CMX is shipped with the rack slides attached.

2. Install unit in rack and secure with the four front panel rack screws (user
supplied).

3. Install the power cable but leave the unit power off.
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4. Using the 8000-044 cable, connect the Dual Rack-mount CMX rear panel
COMM IN connector to the appropriate LINE X connector on the Line
Interface Unit (LIU).  Refer to Figure 4.18.

5. Typically, one line in the LIU is used for communication with all of the Dual
Rack-mount CMXs. If more than one Dual Rack-mount CMX is being used, it
should be "daisy chained" by connecting the rear panel COMM OUT
connector of one unit to the COMM IN connector of another unit with another
8000-044 cable.  Refer to Figure 4.18.

6.  The COMM IN and COMM OUT connectors are wired in parallel so in reality
there is no "IN" or "OUT"; they are both the same.

Power Up

The Dual Rack-mount CMX actually contains two independently controlled sets
of CMX electronics; each has its own front panel power switch. The unused
halves of these units do not need to be powered up and are to be used as spares.

1. Make sure that the 1 Amp, slow blow fuse is installed in the rear panel fuse
holder.

2. Apply power to the units as needed and proceed with the complete installation
and checkout of the remaining system components. Do not have the power on
when connecting the Remote Transducers.
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Figure 4.18  Rack-mount CMX and LIU Interconnections (rear view)
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Remote Transducers (Energy Source/Nav Sled)
Installation

This section describes the installation procedures for the DigiRANGE Remote
Transducer.

A Remote Transducer is designed to be mounted to an energy source or to a
positioning sled towed directly behind the energy source.  In both cases, a three
meter (minimum required length) wire rope should be used to tow the remote
transducer.  This tow cable (supplied by user) should be attached to the bridle
(supplied with Remote Transducer) of the transducer and to a convenient and
stable point on the sled or energy source (usually the last gun in a string. The
connecting equipment (shackles, nuts and bolts) to be used in assembly is
supplied by the user.

A waterproof, 4-conductor cable with a 4-pin gun connector must be run out
from the boat to the energy source or sled, and then down to the Remote
Transducer to provide an electrical connection.  The cable should be bound to the
nearest stable structure along its path to the transducer, with enough slack to
compensate for physical movement of the tow system when deployed.  Inadequate
slack can cause broken electrical cables.
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Dual Rack-Mount CMX to Remote Transducer (Energy
Source) Wiring Interconnections

- WARNING - High voltages present. Voltages up to ±230 volts
DC (and AC) exist on this assembly when it is connected to the Dual
Rack-mount CMX. HANDLE WITH CARE. Disconnect from the Dual
Rack-mount CMX before handling.

1. Connect the 8000-312-100 cable assembly from the Remote Transducer
connector located on the rear of the Dual Rack-mount CMX to an available
pair of the instrument room patch panel used for energy source firing line
cables (as per Figure 4.19) for each Remote Transducer (energy source) to be
deployed. This cable should be kept as short as possible; cut as necessary.
Unshielded twisted pair firing line cable is recommended for connection
between the Remote Transducer and the patch panel. The firing line cable
must also be checked for leakage and replaced if any problems are found.

2. Verify the wiring of the energy source firing line cable with the Remote
Transducer Cable Tester (P/N 3300-011 from kit no. 6500-059) attached to the
connector at the end of the firing line. Turn on the power to the Dual Rack-
mount CMX. If the green LED is lit, the wiring is correct. If the red LED is lit,
the wiring is reversed.  If neither is lit, check the wiring..

3.  If a remote transducer cable tester is not available, use a DVM and measure
DC voltage between pins 1 and 2 of the connector on the end of the firing line
(+  on pin 1, and  -  on pin 2 of the gun connector).
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Figure 4.19  Dual Rack-Mount CMX to Remote Transducer Wiring
Interconnections
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Remote Hull-Mount Transducer Installation
This section describes the installation procedures for the DigiRANGE Remote

Hull-mount Transducer.

A remote hull-mount transducer, enclosed in a specialized housing, is designed to
be mounted to a retractable stem that can be lowered below the hull of the vessel.

The following are the basic steps required to install a Remote Hull-mount
Transducer.

1. Feed the 4-pin gun connector end of the 10m waterproof cable (supplied with
the Remote Hull-mount Transducer) into the top of the stem.  Pull the
connector end out of the bottom of the stem.

2. Connect the 4-pin connector of waterproof cable to the 4-pin connector of the
transducer.

3. Attach the Remote Hull-mount Transducer to the end of the stem using the
provided equipment (user supplies waterproofing method and materials).

4. Splice the end of the waterproof cable to a shielded cable running from the
instrument room down to the stem location (waterproof splice should be
made).



System 3 (Version 4.0) User’s Manual

118

Dual Rack-Mount CMX to Remote Hull-Mount Transducer
Wiring Interconnections

- WARNING - High voltages present. Voltages up to ±230 volts
DC (and AC) exist on this assembly when it is connected to the Dual
Rack-mount CMX. HANDLE WITH CARE. Disconnect from the Dual
Rack-mount CMX before handling.

1. Route the 8000-312-200 cable assembly from the Remote Transducer
connector located on the rear of the Dual Rack-mount CMX through the
standard cable trays to the area where the Remote Hull-mount Transducer is
installed.

2. Splice the 8000-312-200 cable to the 3300-008 cable connected to the Remote
Hull-mount Transducer as per Figure 4.20. This cable should be kept as short
as possible; cut as necessary.

3. Before the 3300-008 cable is connected to the Hull-mount Transducer, verify
wiring with the Remote Transducer Cable Tester connected to the 3300-008
cable. Turn on the power to the Dual Rack-mount CMX. If the green LED is
lit, the wiring is correct. If the red LED is lit, the wiring is reversed.  If neither
is lit, check the wiring.

4.  If a Remote Transducer Cable Tester is not available, use a DVM and measure
DC voltage between pins 1 and 2 of the connector on the end of the 3300-008
cable (+ on pin 1 and - on pin 2 of the gun connector). With the Dual Rack-
mount CMX powered up, the voltage should be approximately +24vdc if  the
wiring has been done correctly.
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Figure 4.20  Remote Hull-mount Transducer to Rack-mount CMX
Interconnections
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Remote Transducer and Hull-Mount DC Current Check
To verify that the remote transducer (hull or energy source) is drawing the

correct DC current, perform the following check while NOT transmitting.

1. Plug the remote transducer DC current monitor cable phone plug (Figure 4.21)
into the rear panel jack labeled "Remote DC mA".  Connect the other end of
the special cable to a DVM set to measure DC current on a 100 mA or 200
mA scale.

The following table can be used to determine the DC conditions of the Remote
transducer and its wiring.

CONDITION PROPER
CURRENT

METER
READING

INDICATION

1 Nothing connected to rear
panel connector.

EXT.XDCR A or B

≈ 20 mA If greater than ≈ 20 mA, internal
failure.

2 Cable connected without
remote transducer.

≈ 20 mA If condition 1 OK, greater than ≈ 20
mA indicates wiring problem.

3 Cable and remote
transducer connected.

≈ 50 mA If 1 and 2 OK, greater than ≈ 50 mA
but less than 65 mA indicates

backward wiring.

4 Cable and remote
transducer connected.

≈ 70 mA Slight leakage to full short circuit.

NC

SLEEVE

RING

TIP

STEREO 1/4" PHONE PLUG

DVM

mA

COMMON

BANNANA PLUGS

TO REMOTE DC mA
JACK ON REAR PANEL

BNC FEMALE
BNC MALE

Figure 4.21  Remote Transducer DC Current Monitor Cable
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The Remote Transducer DC Current Monitor Cable is contained in
the Remote Transducer Test Kit (P/N 6500-059).
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Rear Panel Power Amplifier Transmit Level Control
Adjustment

The Power Amplifier (PA) Transmit Level control is used in conjunction with
the PA Monitor BNC connector to set the output level of the Rack-mount CMX
PA.  More importantly, it must be used to prevent PA clipping and distortion
from causing interference with adjacent channels.  This is typically a problem on
energy source mounted Remote Transducer installations with cable lengths
exceeding about 500 ft. where line capacitance is excessive.

This procedure must be done with the Rack Mount CMX in actual
deployed conditions, i.e. full length energy source Remote Transducer
cables (including Hull-Mount), and Remote Transducers in the water.

1. Take the DMU out of the Run mode.

2. From the Operator Interface Program, select the Diagnostic / Acoustics /
Diagnostic Page command, and answer "Yes" to the "download diagnostic
configuration" prompt.

3. Enter the Unit ID of the CMX and verify successful download.  The Transmit
Channel = 0 (transmitter disabled) at this point.

4. Change the transmit channel to 1 by entering a "1" is the Transmit channel
field on the Diagnostic page.

5. Connect the rear panel PA MONITOR BNC connector to a Digital Storage
Oscilloscope (DSO).

Initial Oscilloscope setup:

Horizontal: sweep 5 ms/div.

Vertical CH1: DC coupling, 5 V/div.

Trigger: Internal CH1, normal, positive edge, +2 VDC, DC coupling

This will cause the DSO to trigger on the transient » 20 ms before the center of
the pulse as shown on Figure 4.22 (not clipped).
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Figure 4.22  Not Clipped

6. Observe the waveform at its center, » 5.12 milliseconds from its beginning.
To do this it will be necessary to delay from the waveform beginning and use
a horizontal sweep time of 5 or 10 ms.  See Figure 4.23 (clipped)
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Figure 4.23  Clipped

 The waveform envelope and the individual sinusoids must not be
clipped, "flat-topped," or distorted.  See Figure 4.24 (clipped
envelope).
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Figure 4.24  Clipped Envelope

7. If clipping or distortion is evident, use a very small flat blade screwdriver and
adjust the PA Transmit Level control counterclockwise (CCW) until the
waveform is not clipping.  This will not only reduce the output level of the
Power Amplifier, but it will reduce the clipping and/or distortion.  Leave the
control set for the maximum amplitude without clipping.  Clipping is defined
as any voltage >22.0 Volts peak to peak.  The absolute amplitude of the signal
will vary somewhat from channel to channel and is dependent on load
conditions.  A non-clipping waveform is more important than the absolute
level.

8. Perform these checks on all 5 channels and adjust for the channel with the
most clipping.  Once the control has been adjusted CCW to eliminate clipping
on one channel, never turn the control back CW because another channel is
not clipping as much.
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Dual Rack-mount CMX / Remote Transducer Post-
Deployment Checkout

The purpose of this procedure is to verify the functionality of the Dual Rack-
mount CMX unit in the instrument room equipment rack after installation and/or
to verify the functionality of the Dual Rack-mount CMX / Remote Transducer
combination after deployment.

The procedure must be performed twice to check both halves of the
Dual Rack-mount CMX.

Setup

Turn power on to both CMX units.

Communication Check

1. In the Operator Interface Program, click on the Diagnostics / Acoustics
command.

2. Select the Read Unit ID function to interrogate the CMX by Serial number and
verify the previously assigned Unit ID. It is assumed that at this stage the
correct Unit ID has been assigned before deployment.

3. Verify interrogation by the Unit ID by clicking on Read/Swap Serial No.

Status Checks

1. Take the DMU out of the Run Mode.

2. In the Operator Interface Program, click on the Diagnostic / Acoustic
command. Select the Diagnostic Page and answer “Yes” to the question..

3. Enter the Unit ID of the CMX and verify successful download. Transmit
channel = 0 (transmitter disabled) at this point.

Signal

Volt (V) = 0.0 0.0

Off  (V) = 2.5

If the "Off" (V) does not equal 2.4 or 2.5  it is probably due to interference from
electronic equipment in the instrument room.
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Depth/Temperature

Depth = 0.00  PSI 0.0 M

Temperature (C)  = -24.0

These fields are reserved for the Depth and Temperature
measurement option on Cable-mount CMXs and will not be used on
Dual Rack-mount CMXs.

Pulse Monitor

Count  = 0.0 0.0

At this point the acoustic pulse transmitter is OFF as indicated by Transmit
Channel : 0.

Status Display

Depth Acq module should have a red status color (failure).  This is normal.

All others items should read "check."

The CMX Diagnostic Page may also be used to diagnose problem CMXs.

See the Off-Line Diagnostics section for more information on Status.

Transmitter Functional Check (Pulse Monitor)

Select Tx channel 1 by entering "1" in the TX channel field of the Diagnostic
Page; observe PULSE MONITOR.  Counts should be within the following limits:

Remote Transducer (Energy Source) or Remote Hull-mount Transducer

• CH 1  (both + and - counts) = 100 (approximately)

• CH 1  (both + and - counts) = 40 ± 10 (only when using Remote Transducer 
  Test Cable).
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TEST CABLE:
RACK MOUNT CMX TO
REMOTE TRANSDUCER

TO:
REAR PANEL, REMOTE TRANSDUCER
CONNECTOR OF 9000-4031 (-3)
DUAL RACK MOUNT CMX

TO:
9000-4051 REMOTE TRANSDUCER
OR 9000-4111 REMOTE HULLMOUNT

REED 6400-201MS3106A-14S-02P

97-3057-1007-1

25 FT. LONG

P1 J1

P

1

2

3

4

P

LINE +

LINE -

SHIELD
DRAIN

18 AWG SHIELDED, TWISTED
PAIR WITH OVERALL FOIL SHIELD
AND DRAIN WIRE.
BELDEN 8760 OR EQUIVALENT

NCNC

TRANSDUCER

A

B

C

D

 Figure 4.25  Remote Transducer Test Cable (P/N 3300-009)

 Receiver Functional Check

 Background Signal Check

 Select Tx channel 0 by entering "0" in the TX channel field on the Acoustic
Diagnostic Page. With a known good Remote Transducer (P/N 9000-4051)
connected to the remote transducer connector on the rear of the Dual Rack-mount
CMX, perform the following:

 Background Signal Check

 With Tx channel 0 selected, observe the background SIGSTRengths for apertures
1 - 5; all shall be within the limits of -72 to -84 dB.

 Transducer Functional Check

 Using fingernails, keychain, or other suitable object, scratch or tap the Remote
Transducer briskly while observing SIGSTR for apertures 1 - 5. Readings for all 5
apertures should change to about 20 dB more (less negative) than those observed
above in the "Background Signal Check" section.

 

 This is a qualitative check only and is intended to determine that
the transducer is actually connected to the receiver. Readings are very
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much dependent on how hard or how fast the Transducer is scratched.

 Dual Rack-mount CMX 2nd Half Checkout

 From the CMX Diagnostics menu, select CMX INFO and then enter the serial
number of the second side of the Dual Rack-mount CMX. The serial number is
shown on the power switch key cap. Then repeat the checks described above.

 Range Accuracy Verification (refer to Section 11.2.6)

 This test involves acquiring a range between a pair of Remote Transducers
(energy source or hull-mount) arranged  transducer to transducer (0 distance),
maintaining contact with each other through a "bubble pack" or any other suitable
non-metallic impeding medium.

 The range value reported between the transducer pair is an indication of the
accuracy of the pair.  This is essentially a zero-range verification test. To pass this
test, the pair must consistently provide a range time limited to  0 +/- 0.1 ms. This
test can also be run using a Cable-mount CMX together with a Remote
Transducer / Dual Rack-mount CMX (provide they are on the same modem
transmission line).

 The following steps are required to perform this test:

 1. Position the two Remote Transducers so that the transducers are barely in
contact. Minimal contact is recommended. Place a suitable impeding medium
(the recommended medium is the bubble pack wrapping used to ship the
battery packs) between the transducers.

 2. Connect the two transducers to a Dual Rack-mount CMX unit (or to two
separate Dual Rack-mount CMX units) and power up.

 3. If using two separate Dual Rack-mount CMX units, make sure that they
are connected to the same modem transmission line. The two CMXs must
have different unit number assignments.

 4. Follow the steps for CMX Verification Test in the Section III Diagnostics,
Troubleshooting Utilities.
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 Remote Transducer (Energy Source/Hull-Mount) Pre-
Deployment Checkout

 The purpose of this procedure is to verify the functionality of the 9000-4051
DigiRANGE Remote Transducer (energy source) or the 9000-4111 Remote Hull-
mount Transducer in the instrument room before deployment. This procedure can
also be used for the older 8000-376 and 8000-378 Remote Transducers.

 Remote Transducer Setup

 Connect the Remote Transducer under test to a known good Dual Rack-mount
CMX configured in System 3. The only exception to this is that the Remote
Transducer Test Cable is needed to make the connection between the Remote
Transducer and the Dual Rack-mount CMX.

 Transmitter Functional Check (Pulse Monitor)

 Select Tx channel 1 by entering "1" in the TX channel field of the Diagnostic
Page; observe PULSE MONITOR.  Counts should be within the following limits:

 Remote Transducer (Energy Source) or Remote Hull-mount Transducer

• CH 1  (both + and - counts) = 100 (approximately)

• CH 1  (both + and - counts) = 40 ± 10 (only when using Remote Transducer 
  Test Cable).

 Receiver Functional Check

 Background Signal Check

 Select Tx channel 0 by entering "0" in the TX channel field of the Diagnostic
Page.. Observe the background SIGSTRengths for apertures 1 - 5; all SIGSTRs
should typically be within the limits of -72 to -78 dB. These readings may get as
high as -54 dB in rough weather.

 Remote Transducers on the energy sources may experience high noise
conditions because of flow noise from the energy sources themselves, energy
source air leaks, etc. SIGSTR readings greater than -54 dB can keep the
CMX/Remote Transducer from being able to successfully receive the longer
ranges.  High SIGSTR readings indicate a possible deployment problem and
deserve attention.

 Remote Hull-mount Transducers may experience high noise conditions because
of ships mechanical noise transferred through the water to the Transducer. This
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noise may emanate from the propellers (intensity and frequency will change with
both rpm and pitch), high pressure compressors, engines, etc.

 SIGSTR readings greater than -45 dB can keep the CMX/Remote Hull-mount
Transducer from being able to successfully receive the longer ranges. SIGSTR
readings higher than about -45 dB indicate a possible deployment or stem location
problem and deserve attention.

 High noise readings on Remote Transducers may also indicate a wiring or
grounding problem or be caused by electrical (or acoustic) interference from
another system. Thoroughly check all wiring and interconnections. If electrical or
acoustic interference is suspected, shut off the system suspected of creating the
noise to isolate the cause. Elimination of the noise source may not be that easy.

 Transducer Functional Check

 Using fingernails, keychain, or other suitable object, scratch or tap the Remote
Transducer briskly while observing SIGSTR for apertures 1 - 5. Readings for all 5
apertures should change to about 20 dB more (less negative) than those observed
above in the "Background Signal Check" section.

 

 This is a qualitative check only and is intended to determine that
the transducer is actually connected to the receiver. Readings are very
much dependent on how hard or how fast the Transducer is scratched.
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 CABLE-MOUNT CMX UNITS

 

 The terms “Cable-mount CMX” and “Streamer-mount CMX” are
used interchangeably.

 Overview
 The Cable-mount Concurrent Multichannel Transceiver (CMX) (P/N 9000-4012)
is a measurement device that makes up a node in the DigiRANGE acoustic
system. The device contains a telemetry system interface, control logic, and
transceiver circuitry. The cable-mount CMX has an integral transducer designed
to be mounted on a cable or tailbuoy.

 Each CMX can transmit on one of five channels in the 50 kHz to 100 kHz
acoustic band.  Up to eight different range measurements may be acquired by each
CMX on each measurement cycle. The system is designed to support acoustic
transit time measurements accurate to 0.1 ms.

 

 

 Figure 4.26  CMX Unit (cable-mounted)

 Specifications

 Physical Characteristics

  Length:  106.7 cm (42 in)

  Diameter:  12.1 cm (3.5 in)

  Weight:  approx. 4.3 kg (9.6 lbs in water)
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 Performance Characteristics

 Number of Channels  5

  Acoustic Band  50 kHz - 100 kHz

  Ranges per Node  8

  Battery Life  65 days
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 Cable-Mount CMX Pre-Deployment Checkout
 The purpose of this procedure is to verify the functionality of the Cable-mount
CMX in the instrument room before deployment on the streamer cable. This
procedure is to be performed with a load tested battery pack and nose assembly
installed in the CMX. A Test Coil (P/N 9000-388/01) will be used for
communicating with the Cable-mount CMXs during checkout.

 Test Coil Installation

 Connect the 9000-388/01 Test Coil to a Line on the LIU panel.  Place the coil
section of the Test Coil as near to the Cable-mount CMX coil (see coil indicator
line on nose assembly) as possible for the following tests.  Avoid high electrical
noise environments caused by monitors and other equipment.

 Communication Check

 1. In the Operator Interface Program, click on the Diagnostics / Acoustics
command.

 2. Select the Read Unit ID function to interrogate the CMX by Serial number
and verify the previously assigned Unit ID. It is assumed that at this stage the
correct Unit ID has been assigned before deployment.

 3. Verify interrogation by the Unit ID by clicking on Read/Swap Serial No.

 Status Checks

 1. Take the DMU out of the Run Mode.

 2. In the Operator Interface Program, click on the Diagnostic / Acoustic
command. Select the Diagnostic Page and answer “Yes” to the question..

 3. Enter the Unit ID of the CMX and verify successful download. Transmit
channel = 0 (transmitter disabled) at this point.

 Signal

 Volt (V) = 0.0 0.0

 Off  (V) = 2.5

 If the "Off" (V) does not equal 2.4 or 2.5  it is probably due to interference from
electronic equipment in the instrument room.
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 Depth/Temperature

 Depth = 0.00  PSI 0.0 M

 Temperature (C)  = -24.0

 

 These fields are reserved for the Depth and Temperature
measurement option on Cable-mount CMXs and will not be used on
Dual Rack-mount CMXs.

 Pulse Monitor

 Count  = 0.0 0.0

 At this point the acoustic pulse transmitter is OFF as indicated by Transmit
Channel : 0.

 Status Display

 Depth Acq module should have a red status color (failure).  This is normal.

 All others items should read "check."

 The CMX Diagnostic Page may also be used to diagnose problem CMXs.

 See the Off-Line Diagnostics section for more information on Status.

 

 Transmitter Functional Check (Pulse Monitor)

 Select Tx channel 1 by entering "1" in the TX channel field of the Diagnostic
Page; observe PULSE MONITOR.  Counts should be within the following limits:

 Remote Transducer (Energy Source) or Remote Hull-mount Transducer

• CH 1  (both + and - counts) = 100 (approximately)

• CH 1  (both + and - counts) = 40 ± 10 (only when using Remote Transducer 
  Test Cable).

 

 Receiver Functional Check

 Background Signal Check

 Select Tx channel 0 by entering "0" in the TX channel field of the Diagnostic
Page.. Observe the background SIGSTRengths for apertures 1 - 5; all SIGSTRs
should typically be within the limits of -72 to -78 dB. These readings may get as
high as -54 dB in rough weather.



System 3 (Version 4.0) User’s Manual

136

 Cable-mount CMXs on sleds or tail buoys may experience high noise conditions
because of generator noise or flow noise from the buoy itself. Cable-mount CMXs
on the first or second active streamer sections may experience high noise
conditions because of flow noise from the paravanes, doors, energy sources,
energy source air leaks, etc.

 In any case, SIGSTR readings greater than -54 dB can keep the CMX from being
able to successfully receive the longer ranges. High SIGSTR readings indicate a
possible deployment problem and deserve attention.

 Transducer Functional Check

 Using fingernails, keychain, or other suitable object, scratch or tap the Remote
Transducer briskly while observing SIGSTR for apertures 1 - 5. Readings for all 5
apertures should change to about 20 dB more (less negative) than those observed
above in the "Background Signal Check" section.

 

 This is a qualitative check only and is intended to determine that
the transducer is actually connected to the receiver. Readings are very
much dependent on how hard or how fast the Transducer is scratched.

 

 CMX Verification Test

 See the instructions for conducting the CMX Verification Test in Section III
Diagnostics, Troubleshooting Utilities.

 Latch Mechanism Physical Inspection

 Since it is not always obvious that the latch is properly engaged when installing
a Cable-mount CMX on a streamer, it is imperative that the latch mechanisms be
checked from time to time to ensure proper operation, and that CMX to collar fit
be checked during streamer deployment.

 Prior to streamer deployment, all Cable-mount CMX latch assemblies should be
checked for proper operation (as described below) and , if necessary, cleaned and
lubricated.

 Check that the dovetail pin on top of each pylon extends and retracts fully as the
eccentric pin (slotted hex on either side of the pylon) is rotated.  There should be
no tendency for the dovetail pin to stick or bind.  The locking link (in front of the
dovetail pin) should extend as the pin retracts.  Use a collar outer ring to check
latch operation.  When retracted, the dovetail pin should retain the test collar
tightly against the pylon with the locking link (in front of pin) fully extended.
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 Buildups of fine grained mud and sea salts can eventually impair proper operation
of the latch mechanism. After streamer retrieval and before storage of the Cable-
mounted CMXs, latch mechanisms should be flushed with a light oil or silicone
lubricant to ensure continued reliable operation. Use of CMXs with
malfunctioning latches can result in loss of, or damage to the CMX.
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 Cable-Mount CMX Deployment

 

 Perform pre-deployment checks prior to installing a CMX unit to a
cable.

 Collar to Streamer Orientation

 Cable-mount CMXs are mounted to the streamer cable utilizing the industry
standard of rotating keyhole collars spaced at 22.5 inches between keyholes.  The
collars must be attached along the streamer in locations that allow the
communication coil of the CMX to be positioned below the coil in the streamer.
The center of the streamer's coil should be lined up with the center of the CMX's
coil (marked on the top of the front latch).  The collars should be mounted with
the hole of the keyhole slot facing the head of the streamer as shown in Figure
4.27.

 

VESSELTAILBUOY

 Figure 4.27  Collar Orientation

 Cable-Mount CMX to Collars Attachment

 When attaching a Cable-mount CMX to the streamer, start with both dovetail
pins in the extended (unlatched) position with the locking links more or less flush
with the top of the pylon.  Note that, when the small hole to one side of the
screwdriver slot is up (toward the top of the pylon), the dovetail pin is in the fully
extended position. See Figure 4.28.
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 CMX pylon

hex
head

dovetail pin

 Figure 4.28  Latch in Extended Position

 As each Cable-mount CMX is installed on the collars, be sure that front and rear
pins fit into the hole on the collar rings at the same time. If it is necessary to
insert one pin onto a collar and then slide the Cable-mount CMX on that
collar to engage the other collar, then collar spacing is incorrect and both
latches may not be able to fully engage. The CMX should be oriented such that
the transducer and cage are pointing toward the tailbuoy end of the streamer.

 Next, slide the Cable-mount CMX back on the collars so that the front of both
pylons is behind the front edge of the aluminum collar ring.  Lock the CMX to the
collar rings by rotating the hex heads on the front and rear eccentric pins so that
the small holes are down (away from the top of the pylons). The hex heads should
rotate freely ¼ turn either side of this position. Shake the CMX forward and
backward along the streamer to ensure it is locked in place.  Wrap the supplied
safety cable around streamer and clip to the loop on the side of the latch.

 

 
 CAUTION: If the front of either pylon is ahead of the front edge
of the aluminum collar ring, both latches may not be fully engaged.
CHECK COLLAR SPACING BEFORE DEPLOYING. Collar spacing
is maintained by properly latched CMXs; the rear collar will move.

 

 Cable-Mount CMX to Float Tube Orientation

 A Float Tube (P/N 9000-303/01) must be mounted directly to the same collars as
a Cable-mount CMX (collars come with opposing keyhole slots). See Figure 4.29
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for Float Tube orientation. Float Tubes must be used to ensure proper orientation
of Cable-mount CMXs.

 

 

float tube

streamer vesseltailbuoy collars

 Figure 4.29 Float Tube Orientation
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 Cable-Mounted CMX to Tailbuoy Installation
 A Cable-mounted CMX can be mounted to the tailbuoy to several ways. Four
possible methods are described in the following sections.

 Tailbuoy Hard-Mount

 A Cable-mount CMX can be hard mounted to a tailbuoy provided the tow depth is
greater than two meters.  The CMX can be mounted in any orientation (horizontal,
vertical, or at an angle), as long as the transducer has an unobstructed path
forward and down to the CMXs mounted on the streamers. The CMX should be
mounted so that the transducer is directly beneath the geodetic reference on the
tailbuoy. The Cable-mount CMX can be mounted using standard collars modified
to fit the buoy structure, or it can be bound to the buoy structure with banding or
similar material. See Figure 4.30 .

 

ATTACH COIL HERE

TAILBUOY

COIL CABLE

STIC CABLE

TOW CABLE

 Figure 4.30  Tailbuoy Hard-Mount

 Tailbuoy Hard-Mount with DigiCOURSE Tail Tow Tube (TTT)

 A DigiCOURSE TTT can be mounted to a section of the buoy structure
providing a convenient attachment point for a Cable-mount CMX. Tow depth
must exceed two meters for this deployment. The TTT has two standard collars to
which the Cable-mount CMX can be attached. The bail of the TTT can be
shackled to the tailbuoy. The TTT should be shackled at a position in which the
CMX's transducer is directly beneath the geodetic reference on the tailbuoy. The
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coil end of the Coil Cable should be secured in the interior of the TTT using the
coil retaining fixture included with the TTT. See Figure 4.31.

 

 

TAILBUOY

COIL CABLE

STIC CABLE

SHACKLE

TOW CABLE

TAIL TOW TUBE

 Figure 4.31  Tailbuoy Hard-Mount with DigiCOURSE Tail Tow Tube

 Tethered DigiCOURSE Tail Tow Tube (TTT)

 A DigiCOURSE TTT can also be towed from a tow rope attached to the end of
the STIC cable, or other suitable underwater tow point.  The tow depth should be
a minimum of two meters, and the CMX's transducer should be positioned
directly beneath the geodetic reference on the tailbuoy.  A Cable-mount CMX can
be collar mounted to the TTT, with the coil from the Coil Cable secured in the
interior of the TTT. See Figure 4.32.
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TAILBUOY

COIL CABLE

STIC CABLE

TAIL TOW TUBE TOW CABLE

 Figure 4.32  Tethered DigiCOURSE Tail Tow Tube.

 Tethered Short Streamer Section

 A Cable-mount CMX can also be attached at a coil position on a short streamer
section using standard collars. This streamer section can then be attached to the
tailbuoy or STIC in a way that is similar to the methods shown in Figures 4.31 and
4.32 but with the streamer section substituted for the DigiCOURSE TTT. The
CMX's transducer should be positioned directly beneath the geodetic reference on
the tailbuoy.
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 Cable-Mount CMX Post-Deployment Checkout
 Once all equipment has been deployed, a few basic tests should be performed to
ensure all components of the deployed system are operating properly. The
following tests are performed while in the Acoustic Diagnostics section of
Operator Interface.

 The purpose of this procedure is to verify the functionality of the Cable-mount
CMX both during and after deployment on the streamer. These checks should be
performed for each Cable-mount CMX once they are deployed in the water.

 Communication Check

 1. In the Operator Interface Program, click on the Diagnostics / Acoustics
command.

 2. Select the Read Unit ID function to interrogate the CMX by Serial number
and verify the previously assigned Unit ID. It is assumed that at this stage the
correct Unit ID has been assigned before deployment.

 3. Verify interrogation by the Unit ID by clicking on Read/Swap Serial No.

 Status Checks

 1. Take the DMU out of the Run Mode.

 2. In the Operator Interface Program, click on the Diagnostic / Acoustic
command. Select the Diagnostic Page and answer “Yes” to the question..

 3. Enter the Unit ID of the CMX and verify successful download. Transmit
channel = 0 (transmitter disabled) at this point.

 Signal

 Volt (V) = 0.0 0.0

 Off  (V) = 2.5

 If the "Off" (V) does not equal 2.4 or 2.5  it is probably due to interference from
electronic equipment in the instrument room.

 Depth/Temperature

 Depth = 0.00  PSI 0.0 M

 Temperature (C)  = -24.0
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 These fields are reserved for the Depth and Temperature
measurement option on Cable-mount CMXs and will not be used on
Dual Rack-mount CMXs.

 Pulse Monitor

 Count  = 0.0 0.0

 At this point the acoustic pulse transmitter is OFF as indicated by Transmit
Channel : 0.

 Status Display

 Depth Acq module should have a red status color (failure).  This is normal.

 All others items should read "check."

 The CMX Diagnostic Page may also be used to diagnose problem CMXs.

 See the Off-Line Diagnostics section for more information on Status.

 Transmitter Functional Check (Pulse Monitor)

 Select Tx channel 1 by entering "1" in the TX channel field of the Diagnostic
Page; observe PULSE MONITOR.  Counts should be within the following limits:

 Remote Transducer (Energy Source) or Remote Hull-mount Transducer

• CH 1  (both + and - counts) = 100 (approximately)

• CH 1  (both + and - counts) = 40 ± 10 (only when using Remote Transducer 
  Test Cable).

Receiver Functional Check

Background Signal Check

Select Tx channel 0 by entering "0" in the TX channel field of the Diagnostic
Page.. Observe the background SIGSTRengths for apertures 1 - 5; all SIGSTRs
should typically be within the limits of -72 to -78 dB. These readings may get as
high as -54 dB in rough weather.

Remote Transducers on the energy sources may experience high noise
conditions because of flow noise from the energy sources themselves, energy
source air leaks, etc. SIGSTR readings greater than -54 dB can keep the
CMX/Remote Transducer from being able to successfully receive the longer
ranges.  High SIGSTR readings indicate a possible deployment problem and
deserve attention.
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Remote Hull-mount Transducers may experience high noise conditions because
of ships mechanical noise transferred through the water to the Transducer. This
noise may emanate from the propellers (intensity and frequency will change with
both rpm and pitch), high pressure compressors, engines, etc.

SIGSTR readings greater than -45 dB can keep the CMX/Remote Hull-mount
Transducer from being able to successfully receive the longer ranges. SIGSTR
readings higher than about -45 dB indicate a possible deployment or stem location
problem and deserve attention.

High noise readings on Remote Transducers may also indicate a wiring or
grounding problem or be caused by electrical (or acoustic) interference from
another system. Thoroughly check all wiring and interconnections. If electrical or
acoustic interference is suspected, shut off the system suspected of creating the
noise to isolate the cause. Elimination of the noise source may not be that easy.
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Cable-Mount CMX Battery Pack Installation/Replacement

Alkaline battery packs are HIGH VOLTAGE with 60 to 63 volts. Use
DigiCOURSE P/N 9000-4122 to test Alkaline batteries. Pack shall
measure a minimum ± 63 VDC under “no load” condition, and a
minimum ± 60 VDC under “load” condition.

Battery packs must be installed when deploying Cable-mount CMXs for the first
time (units are  not shipped with battery packs).  Weak battery packs must be
replaced with fresh packs when required.  When a Cable-mount CMX does not
operate properly or has intermittent communication, its battery pack should be
replaced with a fresh one as an initial test before unit is disassembled further.

Battery Pack Replacement Procedure

1. Remove the three screws (2800-507) that hold the nose (8000-384) in place.
Tilt the front of the CMX down to prevent water trapped around the O-rings
from dripping into the housing of the CMX. Gently slide the nose out the front
of the housing (2500-318) and unplug it from the CMX. Wipe out any water
that may have entered the housing. If necessary, remove the electronics
module ( see section tilted "Removing Electronics Module of Cable-mount
CMX") to ensure complete removal of water.

2. If the unit has a white foam spacer (3100-064) and gray PVC battery pack
spacer (2501-352) inside the CMX, remove them.

If the CMX has not previously been deployed, it may contain a shipping
spacer (2501-367) in place of the battery pack. Remove the shipping spacer. If
replacing a battery pack, unplug the pack currently in the CMX and remove
from CMX.

3. Insert the fresh battery pack (4000-036) into the front end of the CMX, with
the connector side facing out.  Plug the pack in to the three pin connector of
the wire harness coming from the CMX electronics.

4. Reinstall the gray plastic spacer and the foam spacer, in that order, into the
CMX.

5. Replace the two o-rings (2701-068) on nose  with a fresh pair and lube with
Dow Corning #4 electrical insulating compound (1600-019).

6. Mate the two pin connector of the electronics wire harness with that of the
nose.
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7. Using the Pre-Deployment Checkout procedures, check to see that CMX is
working properly before reassembling.

8. Push the wire harness down into the CMX and install the nose.  Retain the
nose with the three screws removed in step 1.
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Cable-Mount CMX Transducer Removal/Replacement
The acoustic transducer must be removed to extract the electronics module from

the housing or to replace a bad transducer.  Proper grounding techniques must be
utilized while performing the following procedure in order to prevent damaging
the CMX electronics with electrostatic discharge.

-WARNING - High voltages present. Voltages up to ±230 volts DC for
a total of 460 volts DC may be present on the CMX electronics
assembly. HANDLE WITH CARE.

1. Disconnect the battery pack from the CMX electronics by following the
procedures described in Cable-Mount CMX Battery Pack
Installation/Replacement.

2. Remove the four screws (2800-507) retaining the transducer assembly (8000-
386).  Tilt the rear of the CMX down to prevent water flowing into the
housing. Gently slide the transducer off the rear of the housing (rotate the
transducer to avoid hitting the protective cage).  Wipe out any water that may
have entered the housing.  If necessary, remove the electronics module ( see
section tilted "Removing Electronics Module of Cable-mount CMX") to
ensure complete removal of water.

3. The electronics module (8000-573) is mechanically connected the transducer
by a wire strain relief cable (2850-024).  Use this cable to pull the electronics
module out far enough to get a hold of it.  Then pull the electronics out by
hand until the transducer plug on PC board is visible.

4. Unplug the transducer from the PC board and unscrew the strain relief from
the rear support of the electronics module.

5. If replacing the current transducer with one from a spares kit, attach a #8 cable
tie (6000-019) from the spares kit to the wire of the transducer approximately
one inch past the end of the wire strain relief.

6. Put screw (2800-507) removed in step 2 through the wire strain relief and the
cable tie and screw it into the rear support of the electronics.  Feed the
electrical wire through the slot in the support and plug the connector into the
mating connector on the PC board.

7. Make sure the o-rings (two 2701-072 and one 2701-074) on the electronics
module are sufficiently lubricated with #4 insulating compound (1600-019),
and slide  the electronics back into the rear of the housing,  about one inch.
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8. Twist the transducer two times to coil the wires and insert the transducer into
the rear of the housing. Retain the transducer with the four screws removed in
step 1.
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Cable-Mount CMX Electronics Module Removal
The electronics module may need to be removed to replace a bad electronics

module or a bad CMX housing.  The electronics are meant to remain as a module
and should not be disassembled into its component parts.

-WARNING - High voltages present. Voltages up to ±230 volts DC
for a total of 460 volts DC may be present on the CMX
electronics assembly. HANDLE WITH CARE. The two high
voltage capacitors, C33 and C50, on the power module must be
discharged with a 160 ohm, 2 watt resistor before handling. The
resistor must be insulated where it  is touched.

Components on this assembly are electrostatic sensitive. Use proper 
grounding techniques to prevent static damage when handling.

1. Perform disassembly operations outlined Cable-Mount CMX Battery Pack
Installation/Replacement.

2. Perform disassembly operations outlined Cable-Mount CMX Transducer
Removal/Replacement.

3. Slide the electronics module (8000-573) out of the rear of the housing (2500-
318). See above warning.

4. Perform any necessary work on the electronics.

5. Make sure the initial seven to eight inches of the rear inner diameter of the
housing is well lubricated with #4 insulating compound (1600-019).  Lube o-
rings (two 2701-072 and one 2701-074) of electronics module with #4
insulating compound.

6. Slide the electronics into the rear of the housing, wire harness end first. Insert
the electronics module with the small modem board facing the latch side. The
tube and electronics must be well lubricated to ease installation.

7. Install the transducer as stated in Cable-Mount CMX Transducer
Removal/Replacement.

8. Install battery pack as stated in Cable-Mount CMX Battery Pack
Installation/Replacement.
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EPROM Replacement
There may be situations where the EPROM in a CMX has to be replaced. The

EPROM is the component in the CMX electronics that stores the software
required to operate a given CMX. This situation would occur if  the software
within the CMX has been updated at DigiCOURSE and then has to be installed in
the CMXs in the field. Do not replace EPROMs as a troubleshooting procedure.
EPROMS should only be replaced on instructions from DigiCOURSE.

-WARNING - High voltages present. Voltages up to ±230 volts DC
for a total of 460 volts DC may be present on the CMX
electronics assembly. HANDLE WITH CARE. The two high
voltage capacitors, C33 and C50, on the power module must be
discharged with a 160 ohm, 2 watt resistor before handling. The
resistor must be insulated where it  is touched.

Components on this assembly are electrostatic sensitive. Use proper 
grounding techniques to prevent static damage when handling.

1. Perform the disassembly procedures shown Cable-Mount CMX Electronics
Module Removal. Observe the warning shown above.

2. The EPROM is located on the solder side of the 8000-570 board at the nose
end of the assembly.  It is fully accessible without taking the electronics
assembly apart.  Remove the old EPROM by pushing the socket locking tabs
outward.  The EPROM should pop up.

3. Install the new EPROM with the same serial number as the one that was
removed (EXAMPLE:  V1.9 s/n 1234 changes to V2.0 s/n 1234).  Observe
that pin 1 of the EPROM is facing the small modem board.  Push the socket
locking tabs inward, after the pins are aligned with holes, to seat the EPROM.

4. Reassemble the CMX as show in the section Cable-Mount CMX Electronics
Module Removal.
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Cable-Mount CMX Latch Pin and Locking Link
Replacement

The entire locking link and/or its retaining pin (latch pin) may need to be
replaced if the latch pin or locking link becomes bent from minor physical
damage. If major physical damage has occurred, then the entire latch assembly
should be replaced.

1. Use 1/8-inch (or smaller) diameter punch to push out latch pin (2800-245)
retaining the locking link (2500-434).

2. Remove locking link.

3. Install a new locking link, with ball shaped portion of the link in the hole in
the side of the dovetail pin assembly (8000-890), and retain with a new latch
pin.
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Cable-Mount CMX Rear Latch Assembly Replacement
The entire rear latch assembly may need to be replaced in the event that a

housing or rear latch has been damaged in service.  If a dovetail pin is not
operating correctly, replace the entire latch assembly.  Only the locking link and
its retaining pin are field replaceable as individual components of the overall latch
assembly.

1. Use a heat gun to soften the gray epoxy that fills the holes on top of the latch.
While heating, use a small screw driver to dig out the softened epoxy to
expose the heads of the socket head cap screws (2800-470) and washers
(2800-240).

2. Use a 3/16 hex key  to remove the screws and remove the latch assembly
(8000-385).

3. Clean the area of the housing where the latch assembly was seated.  Press the
sealant (supplied with the latch assembly replacement kit) around the threaded
bosses per the diagram supplied with the kit.

4. Place the new latch assembly on the housing (2500-318) of the CMX with the
dovetail pin end facing toward the front of the CMX. Retain the latch
assembly with the two socket head cap screws (2800-470) and two flat
washers (2800-240). Use 277 or 271 red Loctite on the threads of the screws.
Tighten the screws to a torque of 140 - 150 in-lbs. Refill the holes with epoxy
if available.
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Cable-Mount CMX Protective Cage Replacement
The protective cage on a Cable-mount CMX may have to be replaced if it is bent

or damaged beyond repair.  Also, cage installation is required for new housings
being readied for use.

1. Remove the truss head screws, washers, and nut that retain the cage (2500-
323).

2. Remove the cage.

3. Inspect the condition of the housing (2500-318) around the cage attachment
points for any damage that may require the housing to be replaced in addition
to the cage.

4. Attach the front of the new cage to the housing first, with the 3/4 inch truss
head screw (2800-512), two washers (2800-240), and a nut (2800-241)(use
new equipment if needed).  Apply 277 or 271 red Loctite to the threads of the
screw. Do not completely tighten nut.

5. Apply 277 or 271 red Loctite to the threads of the two 3/8 inch truss head
screws (2800-511), and use them with two washers (2800-240)(one for each
"leg") to retain the "legs" of the cage to the sides of the housing. Tighten all
three bolts completely.
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Cable-Mount CMX Nose Assembly Replacement
The nose may have to be replaced in the event of a bad communications coil,

damaged sealing areas, faulty latch mechanism, or damaged wires.  Replace the
entire nose if the dovetail pin is not working properly.  Only the locking link and
its retaining pin components of the latch mechanism are field replaceable.

1. Remove the three screws (2800-507) that hold the nose (8000-384) in place.
Tilt the front of the CMX down to prevent water trapped around the O-rings
from dripping into the housing of the CMX.  Gently slide the nose out the
front of the housing (2500-318) and unplug it from the CMX. Wipe away any
water that may have entered the housing. If necessary, remove the electronics
module (see section tilted Cable-Mount CMX Electronics Module Removal)
to ensure complete removal of water.

2. Lubricate the two o-rings (2701-068) with #4 insulating compound (1600-
019) and install them on a new nose assembly.

3. Plug the new nose into the wire harness of the CMX.

4. Using the Pre-Deployment Checkout procedures, check to see if the CMX is
working properly before reassembling.

5. Push the wire harness down into the CMX and install the nose.  Retain the
nose with the three screws removed in step 1.
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Cleaning Deployed Equipment
All equipment that has been deployed in saltwater should be rinsed with fresh

water when retrieved.  All latch mechanisms should be lubricated with a light oil
or silicone lubricant when the equipment is retrieved.

When CMXs are to be opened to perform internal repairs or change batteries,
they should be rinsed thoroughly with fresh water and dried completely before
opening.  A mild detergent may be used to remove material that cannot be washed
off by rinsing alone.  Again be sure to lubricate the latch mechanisms with a light
oil or silicone lubricant when cleaning is completed.

The black polyurethane transducers should be cleaned with a mild abrasive
agent, i.e. Comet Cleanser. They should always be free of grease, oil or any type
of marine growth for optimum acoustic performance.
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CTX UNITS

Overview
CTX Units are modular forms of the CMX with equivalent performance
specifications, each consisting of a CTX electronics module and a separately-
housed transducer (pinger).

BUOY-MOUNTED CTX ELECTRONICS MODULE

Overview
The Buoy-mounted CTX Electronics Module (P/N 9000-4022) is designed for
deployment on tail buoys, Nav buoys, energy sources, and hull-mounts.

Deployment at the energy source requires special installation
instructions.  These instructions are outlined in the CTX Energy
Source Application Mounting section below.

Figure 4.33  Buoy-Mounted CTX Electronics Module (Pod)

CTX Electronics cannot be swapped for the DigiRANGE CMX
electronics.

Specifications

Physical Characteristics

Length: 83.8 cm (33 in)

Diameter: 8.3 cm (3.25 in)

Weight: 5 kg (11 lbs) in air
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CTX ENERGY SOURCE APPLICATION MOUNTING

CAUTION: Any variation to this deployment scheme requires review
and approval by DigiCOURSE Engineering.

For energy source applications, the CTX must be placed inside a protective
housing.  DigiCOURSE supplies this housing and hardware in the CTX Source
Application Kit (P/N 8200-037).

1. Position the housing. When determining the location of the housing,  position
it to minimize impacts during gun retrieval and deployment, and place it no
more than 30 meters from the pinger. (A maximum of 30 meters of cable
between the CTX and the pinger is allowed.)

The 10-meter cable supplied by DigiCOURSE does not have a
grounded shield. The CTX may experience interference from other
electrical sources on the cable, and the CTX may in turn interfere with
other non-shielded equipment.

2.  Secure the housing either to a gun rack or to a gun plate. If you are attaching
the housing to a gun rack, proceed to Step 3; however, if you are attaching the
housing to a gun plate, skip to Step 4.

CAUTION: Do not mount the CTX any closer than one meter to a
gun; mounting further away from the guns is preferred.

3. If you are attaching the housing to a gun rack, weld the housing to the top of
the rack from which the guns are suspended as described in Figure 4.34, Weld
Installation Detail. Weld all metals, which are 316L stainless steel, with
appropriate electrodes, then proceed to Step 5.

CAUTION: If you weld the housing to a gun rack, do not place the
CTX module and rubber spacers inside the housing until the welding
is completed.
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4. If you are attaching the housing to a gun plate, bolt the housing to the gun
plate as described in Figure 4.35, Bolt On Installation Detail. Place a
customer-supplied Nitrile rubber (BUNA-N) spacer between the u-bolts and
the housing as well as between the housing and the gun plate, then proceed to
Step 5.

5. After securing the housing, insert the CTX module and spacers as detailed in
Steps 6 through 9. See Figure 4.36, Assembly of Housing, for the order of
assembly.

6. Insert an end spacer (the spacer material is nitrile) into the housing, then insert
the housing spacer. Roll up the housing spacer lengthwise to facilitate
insertion into the housing.

7. Insert the CTX module. Ensure this module is firmly pushed all the way into
the housing.

8. Place another end spacer inside the housing, and bolt the end flange in place.
Use the 5/16-18x1-1/2 316L screws and locknuts supplied.

9. Secure the cables extending from the CTX to within 25 cm of the end
connectors to prevent whipping.

Figure 4.34  Weld Installation Detail
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Figure 4.35  Bolt On Installation Detail

Figure 4.36  Assembly of Housing
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RADIO CTX

Overview
A radio telemetry option is provided with the Radio CTX (P/N 9000-4022/10) in
conjunction with the CTX Remote Radio (P/N 9000-4027) and CTX Vessel
Radio (P/N 9000-4028). This option allows the DigiRANGE shipboard equipment
to communicate with CTX units located at nodes not conducive to hardwired
connections.

Specifications

Radio CTX Physical Characteristics

Length: 92.7 cm (36.5 in)

Diameter: 8.9 cm (3.5 in)

Weight: 3.6  kg (8 lbs) in water

3.7  5.4 kg (12 lbs) in air

CTX Remote Radio Physical Characteristics

Length: 61.0 cm (24 in)

Diameter: 11.4 kg (4.5 in)
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CTX BATTERY MODULE

Overview
The CTX Battery Module (P/N 9000-4023/01) is provided for applications with
no available power. This module uses two 42C-cell alkaline battery packs and can
power a Buoy CTX for 120 days. Power consumption by the Radio CTX and
CTX radio is high enough to limit this module to a backup role for these style
units (7 days maximum life). Several battery modules may be deployed in series
using the Multiple Battery Module Adapter Kit (P/N 8200-023).

Figure 4.37  CTX Battery Module

Specifications

Physical Characteristics

Length: 104 cm (41 in)

Diameter: 8.3 cm (3.25 in)

Weight: 11.6 kg (25.5 lbs) in air
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FLANGED PINGER

Overview
The Flanged Pinger (P/N 9000-4112/01) is similar in design to hull-mounted
remote transducers (though NOT interchangeable because Flanged Pingers work
only with CTX electronics) and is designed for hull-mount deployment. However,
the flanged design readily adapts to a variety of customer-designed mounts for
tailbuoy, Nav buoy, or energy source deployment.

Figure 4.38  Flanged Pinger

Specifications

Physical Characteristics

Length: 31.1 cm (12.25 in)

Diameter: 15.2 cm (6 in)

Weight: 4.1  kg (9 lbs) in water

5.9 kg (13 lbs) in air



Section IV   Hardware

165

TOWED PINGER

Overview
The Towed Pinger (P/N 9000-4112/02) is similar in design to the Remote
Transducer used with the Rack-mounted CMX  (though NOT interchangeable
because Towed Pingers work only with CTX electronics). It may be deployed
where a rugged, free-flying housing is required.

Figure 4.39  Towed Pinger

Specifications

Physical Characteristics

Length: 98.4 cm (38.75 in)

Diameter: 16.2 cm (6 3/8 in) maximum

Weight: 26.3  kg (58 lbs) in water

26.4  33.6 kg (74 lbs) in air
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RIGHT ANGLE PINGER

Overview
The Right Angle Pinger (P/N 9000-4112/03) is another rugged design, but
requires hard-mounting.

Figure 4.40  Right Angle Pinger

Specifications

Physical Characteristics

Length: 74.7 cm (29.4 in)

Diameter: 8.9 cm (3.5 in)

Height: 28.6 cm (11.25 in)

Weight: 9.6  kg (21 lbs) in water

15.9 kg (35 lbs) in air
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THREADED PINGER

Overview
The Threaded Pinger (P/N 9000-4112/04) is a reduced-sized transducer that must
be mounted into a properly threaded pipe. (The mating threads in the pipe are 2 ¼
x 8 UN Class 2B.)

Specifications

Physical Characteristics

Length: 18.4 cm (7.25 in)

Diameter: 6.0 cm (2 3/8 in)

Weight: .25 kg (.5 lb) in water

1.4 kg (3 lbs) in air (with cable)
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This section describes in detail each function of the Setup Program.
If you want to create a System 3 Setup file, see Section II, Setup and
Operation, which describes the functions in a step-by-step sequence.

SYSTEM 3 SETUP WINDOW
When the System 3 Setup program is run, the main System 3 Setup window is
automatically displayed. The main System 3 Setup window is segmented into two
views: an Equipment Tree (on the left), which in this manual will be called the
“Text side,” and an Equipment Graphic Display (on the right), which will be
called the “Graphic side.” Additionally, the main window is composed of a title
(caption) bar, a menu bar, two toolbars (the Main Toolbar and the Setup Toolbar),
and a status bar.

Figure 5.1  Setup Window
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The Text Side
The text side of the System 3 Setup window displays, in a hierarchical format, all
vessels, lines, and sensors that have been created for the System 3 file.

When a System 3 file is opened, a Vessel is displayed: 

Click on the plus symbol or double-click on the vessel icon (in the Text side; not
in the Setup Toolbar) to reveal the lines that have been created for this System 3
file. An example of a typical line tree follows:

To reveal the sensor components that reside on each line, either click on the plus
symbol next to the line or double-click on the line icon. All hardware components
on the line are displayed. Each component, represented by an icon, is followed by
a character string which describes the component type, the unit number, and the
offset from the towpoint. Examples of each follow:
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Double-click on a component to open that component’s sensor information dialog
box. For example, by double-clicking on a bird:  , the following
dialog box is opened.

Figure 5.2 Bird Sensor Information Dialog Box

The information fields in the dialog box can be changed as needed.

The Graphic Side
The Graphic side displays all vessels, lines, and sensors that have been created for
the System 3 file in an overhead, or “bird’s-eye” view.

Double-click on a component to open that component’s  information dialog box.
The information fields in the dialog boxes can be changed as needed.

Position you cursor on a component in the Graphic side (but do not click the
mouse button) to view a pop-up summary field, or a “tool tip” for the selected
component.

The tool tip for an acoustic unit includes a character string which describes the
component type, the unit number, the offset from the towpoint, the number of
ranges assigned to that acoustic unit, and the line number. An example follows:

The tool tip for a birdunit includes a character string which describes the
component type, the unit number, the offset from the towpoint, the serial number,
and the line number. An example follows:
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The Main Toolbar

The Main Toolbar, in conjunction with the Setup Toolbar, provides you with
shortcut methods to configure, view, and control System 3 Setup operations.

The “New,” “Open,” “Save,” “About,” and “Help” buttons are always
active. The other buttons on the Main Toolbar are active only when
the Equipment Graphic Display is selected.

Use the Main Toolbar buttons as follows:

The “New” button    creates a new System 3 file.

The “Open” button    opens an existing System 3 file.

The “Save” button    saves the open or active System 3 file using the same file
name.

Click on the “Move Sensors” button     and, using the cursor, draw a box
around (rubberband) the sensors that you want to offset. When the sensors are
selected, the Move Sensor(s) Dialog Box is displayed. Enter the offset in meters
and click on the “OK” button to move/offset the sensors.

Click on the “Create Ranges” button     to access a list of all defined groups
(the Group list), which is used to select the group of sensors whose ranges are to
be defined. Then click on an acoustic sensor in the Equipment Graphic Display;
all ranges for that acoustic sensor will be displayed. Double-click on a second
acoustic sensor (which is ranged to the first sensor) to access the Edit Ranges
Dialog Box. (You may instead, right click on an acoustic sensor in the Equipment
Graphic Display, and select Summary / Ranges. Select from Group 1 through 9,
and click the “OK” button; the Ranges Summary Dialog Box for the selected
group will be displayed. Double-click on the sensor line to access the Edit
Ranges Dialog Box.)

The “Display Ranges” button    shows or hides all system ranges in the
Equipment Graphic Display.

The “Display Full Scale” button    shows the entire system network in the
Equipment Graphic Display.
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The “Zoom Area” button   enlarges a specified area in the Equipment Graphic
Display.

The “Print Setup” button     selects a printer and define printer properties.

The “About” button     accesses the Sys3w Information Box, which lists
software version and copyright information.

The “Help” button    accesses a help icon. Move the icon to any item in the
Main Window (including all buttons, graphics, and menu items), and click a
second time to access the Help topic.

The View / Toolbar command is an on/off switch for the Main Toolbar. Deselect
the item to hide the toolbar.

The Setup Toolbar
The Setup Toolbar, in conjunction with the Main Toolbar, provides you with
shortcut methods to configure, view, and control System 3 Setup operations.

The Setup Toolbar is active only when the Text side is selected.
Initially, only the Vessel and Platform/Line tools are active. When a
line is accessed in the Text side, the Acoustic, Bird, Compass, and
Depth tools are then made active.

Use the Setup Toolbar buttons as follows:

The “Add Vessel” button   adds a vessel to the array.

The “Add Platform/Line” button     accesses the Platform/Line Information
Dialog Box. Complete the information in the box to add any type of platform/line
to the array of a given vessel. The types are: Streamer Cable, Vessel, Gun Array,
Tail Buoy, Paravane, Tow Fish, Nav Sled, and Test Cable.

The “Add Acoustic” button     accesses the Acoustic Sensor Information
Dialog Box. Complete the information in the box to add an acoustic sensor to an
existing line (cable, gun line, radio, etc).

The “Add Bird” button     accesses the Bird Sensor Information Dialog
Box. Complete the information in the box to add a bird sensor to a line.
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The “Add Compass” button     accesses the Compass Sensor Information
Dialog Box. Complete the information in the box to add an in-streamer compass
sensor to a line.

The “Add Depth” button    accesses the Depth Sensor Information Dialog
Box. Complete the information in the box to add an in-streamer depth sensor to a
line.

The “Add Velocimeter” button  accesses the Velocimeter Sensor
Information Dialog Box. Complete the information in the box to add a
velocimeter to a line.

The View / Sys3 Toolbar command is an on/off switch for the Setup Toolbar.
Deselect the item to hide the toolbar.
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SETUP MENUS

The File Menu

Save As

The File / Save As command saves changes made to the open System 3 file.
Changes can be saved under a new file name and/or a new folder.

You can also save changes made to a file by any of the following methods:

• Click on the File menu, Save command.

• Press Ctrl + S.

• Click on 
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Receive from DMU

The File / Receive from DMU command uploads information from the Data
Management Unit to the Operator Interface computer. The active Setup file data is
retrieved from the DMU and is loaded into the Operator Interface’s Setup program
workspace, where it can be edited or saved.

Compile

The File / Compile command compiles an acoustic system configuration file. The
Compile function uses system, line, acoustic sensor (CMX), and range
information, combined with rules and algorithms, to calculate and optimize all
aspects of the acoustic transmit and receive signals. This acoustic system
configuration file must be compiled prior to downloading individual unit
configuration information to the CMXs in the Operator Interface (OI) program.
Whenever acoustic parameters are changed, a new compilation may be required;
the Setup program will indicate when this is necessary.

Cycle Estimate

The File / Cycle Estimate command accesses (after the acoustic system
configuration file has been compiled) the Cycle Estimates window. The Bird
Communications Rate and Acoustic Range Completion Rate can be changed to
generate an acquisition cycle time estimate based on current observations.

When using a system with multiple DMU modem processors or in multi-boat
acoustic operations, the secondary acoustic sync must be after the primary cycle
time. The total cycle time must be less than the fastest switch closure or trigger to
the system.

The total cycle time can be used to determine if all data acquisition is complete
prior to the next trigger (shot). The primary cycle time can be used to determine
the time to set the second acoustic sync time. Calculate the secondary acoustic
sync time by using the primary cycle time, adding 750 ms, and rounding the
number to the next highest 1/10 second.

Example:

Primary Cycle time = 4495

4495 + 750 = 5245

5245 rounded to next highest 1/10 second = 5300

Set the secondary acoustic sync to 53 and run Cycle Estimate again to check
that the total cycle time is less than switch closure or trigger time.
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Compile the acoustic system configuration file prior to using the Cycle
Estimates function.

Transfer to DMU

The File / Transfer to DMU command downloads a System 3 Setup
configuration file from the Operator Interface computer and transfers that file to
the DMU. Before System 3 can use a Setup file created with the Setup program,
the file must be transferred to the DMU. Following the entry of all setup data, an
acoustic compile is performed (if required) and the Setup file is stored on disk
using one of the Save commands under a file name of your choice. This file can
be opened later for updates, and the modified setup can be stored on disk under
the same name or under a new name. In any case, the Setup file does not become
active until it is transferred to the DMU.

The Operator Interface computer first sends an Initialize Link message to the
DMU and waits for an acknowledgment. If no acknowledgment is received, an
error is reported. If the DMU is prepared to accept the Setup file, it sends an
acknowledgment to the Operator Interface, and the Setup data is transmitted to the
DMU.

Following the transfer of the Setup file information to the DMU, the
acoustic configuration must still be downloaded to each CMX from the
Operator Interface runtime program.

Spectra File Exchange

This feature is available only if it is enabled during installation.  If
Spectra has not been enabled during installation, you must re-run
installation.

Purpose

The purpose of the configuration file exchange is to increase productivity by
minimizing the number of times you must input system configuration data.
Previously you had to input the system configuration, i.e., vessels, platforms,
birds, acoustic nodes, and range observations, once in Spectra and then again in
System 3. This new feature of exchanging configuration files requires you to enter
the system configuration only once.
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In addition, once the exchange cycle is completed, both systems will have the
same configuration. Previously, when errors were made the two systems did not
have the same configuration.

Initial System Configuration

See Figure 5.3, File Exchange: Initial System Configuration.

1. Completely define the system setup on the Spectra system. Input vessel
information, platforms, birds, and acoustic nodes. Ranges can be defined
in either system.

The Spectra system platform screen will include a field for the System
3 transmission port number. The Spectra system will accept System 3
unit numbers on the bird and acoustic node screens, and will enforce
the System 3 rules that require unique unit numbers for sensor types
on any given transmission port. It is suggested that you input the serial
numbers for sensors when they are defined in the Spectra system.

2. Once finished entering data on the Spectra system, select the Export
selection from the File menu on the Spectra SNN Program. This creates an
exchange file based on the current configuration.

3. Go to the System 3 operator interface terminal, and from the Setup
program select File / Spectra Interface (Read).  If there is no file open in
Setup, the file read from Spectra into System 3 will result in a new
configuration being created, including all platforms and sensors.

If ranges exist in the exchange file, they will be created with default
aperture and threshold settings. If ranges do not exist, then create the
range observations for the current system in the System 3 Setup
program.

4.  Compile the acoustic system, and transfer the configuration to the System
3 DMU.  The Setup program will put the configuration on the Spectra
system automatically.  Then select the Import selection from the File menu
on the Spectra SNN Program. This updates the Spectra system based on
the current exchange file. The exchange is now complete with both
systems having the same configuration.
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Figure 5.3  File Exchange: Initial System Configuration
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Changes After Initial Configuration

See Figure 5.4, File Exchange: Changes to System Configuration.

If changes need to be made in either system the following procedure
should be followed.

1. If Spectra system changes are needed, such as, offset changes, adding a
node, or deleting a node, do these changes first.

2. Once finished changing data on the Spectra system, select the Export
selection from the File menu on the Spectra SNN Program. This creates an
exchange file based on the current configuration.

3. From the Setup program, select File / Receive from DMU.

4. From the Setup program select File / Spectra Interface (Sync).  The
Setup program will ask which system’s serial numbers to preserve:
DigiCOURSE or Spectra.  It will then ask if the system should keep the
acoustic aperture settings or reset the apertures to the default settings. The
Spectra configuration will be merged with the System 3 configuration.
This will preserve the System 3 specific parameters.

5. Add or delete ranges if needed.

6. Compile acoustics.  This must be done any time a configuration is
received from Spectra.

7.  Transfer the configuration to the System 3 DMU. The Setup program will
put the configuration on the Spectra system automatically.  Then select the
Import selection from the File menu on the Spectra SNN Program. This
updates the Spectra system based on the current exchange file.  The
exchange is now complete with both systems having the same
configuration.
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Figure 5.4  File Exchange:  Changes to System Configuration
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Limits

At this time, no mechanism exists to automatically keep the two systems
synchronized.  You must follow the above procedures to manually keep the
System 3 and Spectra systems in sync.
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The System Menu

Global Parameters

The System / Global command accesses the Global Parameters Dialog Box,
which allows you to define system-wide parameters that are not associated with
any subsystem. The parameters are Vessel Number, Number of Transmission
Ports, Units for Depth Measurement, and Emergency Dive Depth. The Emergency
Dive Depth must be set before the creation of a Setup configuration.

Do not click on the “Add Vessel” button     on the Setup Toolbar;
that button will add another vessel to the array; it will not access the

Figure 5.5  Global Parameters Dialog Box
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Vessel Number

The range of entries is 1 to 4. The default is 1. This data field is used primarily in
multi-boat configurations.

Number of Transmission Ports

This parameter is the number of transmission lines used in a given installation.
Each DMU modem supports up to seven transmission lines (including the radio
port). The range is 1 to 20.

Ports 7 and 14 are used for radio data telemetry only.

Units of Depth Measurement

The depth can be displayed in either feet or meters. This selection also effects the
unit of depth measurement that is sent to the Host computer.

Emergency Depth

The range is between 0 to 125 meters. The default is 0. The emergency dive depth
specifies the target depth for all lines when an emergency dive command is
executed. The Emergency Dive Depth must be set before the creation of a Setup
configuration.

When using Model 5010E or 5011E birds, do not enter depths greater
than 31 meters (103 feet).

Host Parameters

The System / Host command accesses the Host Parameters Dialog Box, which
allows you to define the configuration of the communications ports. These ports
are used to transfer data to the Host computer and to select the data formats for
acoustic and non-acoustic data. The parameters that can be defined (or edited)
include the selection of the Logging Mode, Non-acoustic data format, Non-
acoustic data sort direction, Acoustic data port, Acoustic data protocol, and
Acoustic port characteristics.

Do not click on the “Add Vessel” button     on the Setup Toolbar;
that button will add another vessel to the array; it will not access the
Host Parameters Dialog Box.
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Figure 5.6  Host Parameters Dialog Box

Logging Mode

The Logging Mode determines when sensor data is sent to the Host. Select one of
the four modes:

Disable Logging:  When Data Logging is turned off; no data is sent to the Host
on trigger.

Data Request:  Non-acoustic data (depth, heading, fin) is sent to the Host when a
specific code (separate from the trigger character) is requested by the Host.
Request code 1 is for heading data; request code 2 is for depth data; and request
code 3 is for fin angle data. The request codes are binary numbers, and the non-
acoustic sensor data is returned in binary format. No request code exists for
acoustic data. Acoustic data is logged automatically on receipt of the scan trigger
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if Port 3 is selected as the acoustic data port. If Port 2 is selected as the acoustic
data port (and Data Request is selected as the Logging Mode), acoustic data will
not be sent to the Host.

Scan Trigger:  Data is sent to the Host on the receipt of every external scan
trigger. The external trigger may be a character received from the Host or from an
electronic closure supplied to the Contact Closure Unit. The format of the sensor
data returned is determined by the selections made for the Non-acoustic Data
Format and the Acoustic Data Protocol.

Scan or Internal Timer:  Data is sent to the Host on the receipt of every external
or internal trigger. Internal triggering occurs in the absence of external triggering.
The format of the sensor data returned is determined by the selections made for
Non-Acoustic Data Format and the Acoustic Data Protocol.

Port 2 Acoustic/Non-Acoustic

The primary Host port (Port 2) is a bi-directional serial link between your Host
computer and the System 3 Data Management Unit. The Data Management Unit
responds to commands from the Host computer to perform various functions
related to data acquisition and output, including timing control for data acquisition
triggering.

If the Port 2 is selected for the output of acoustic range data, an acoustic range
message is transmitted every time a Host log event is scheduled. The range
message follows the non-acoustic data message. Port 2 shows Acoustic, Port 3
shows Not In Use.

Port 2 Baud

This parameter is determined by your Host computer. The selection options are
1200, 2400, 4800, 9600, and 19200.

Port 2 Stop Bit

This parameter is determined by your Host computer. The selection options are 1
and 2.

Port 2 Parity

This parameter is determined by your Host computer. The selection options are
None, Even, and Odd.

Port 2 Data Bits

This parameter is determined by your Host computer. The selection options are 5,
6, 7, and 8.
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Port 3 Acoustic/Not In Use

If the acoustic data port (Port 3) is selected, an acoustic data message is output at
the beginning of each scan cycle. The type of message to be output is specified as
a configuration parameter. Port 3 shows Acoustic, Port 2 shows Non-Acoustic.

Port 3 Baud

This parameter is determined by your Host computer. The selection options are
1200, 2400, 4800, 9600, and 19200.

Port 3 Stop Bit

This parameter is determined by your Host computer. The selection options are 1
and 2.

Port 3 Parity

This parameter is determined by your Host computer. The selection options are
None, Even, and Odd.

Port 3 Data Bits

This parameter is determined by your Host computer. The selection options are 5,
6, 7, and 8.

Non-Acoustic Data Format

This parameter is determined by your Host computer. Five types of data formats
are supported for the transfer of non-acoustic sensor data via the primary Host
data port:

• Binary

• ASCII

• Western

• Extended Binary

• Gbird

 Both solicited and unsolicited output of sensor data are supported. For solicited
output, a data request must be received from the Host. Unsolicited output occurs
automatically once each shot interval, with its timing controlled by the internal
scan trigger.

 Set Offset Sort Order

 This parameter determines whether non-acoustic unit data is output in ascending
or descending order by streamer cable offset. The selection options are
Descending and Ascending.
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 Acoustic Data Protocol

 This selection defines which data protocol is used to output acoustic range data to
the Host. This parameter is determined by your Host computer. The available
protocols are:

• DigiCOURSE (P/N 1000-132)

• CLS

• GLS

• HGS  (P/N 1000-388)

• Extended DigiCOURSE  (P/N 1000-361)

• GECO Binary

• Standard Ethernet

• PGS Ethernet

 Assign Acoustic Port

 This option determines which serial port (Port 2 or Port 3) is used to send acoustic
data to the Host. Port 3 is the default. If Port 2 is selected as the acoustic port, Port
3 is inactive and its parameters cannot be set. Port 2, which is the primary Host
port, can be used for either acoustic or non-acoustic data.

 Data Acquisition Parameters

 The System / Data Acquisition command accesses the Data Acquisition
Parameters Dialog Box, which allows you to define how often data is requested
by and from the Data Management Unit. The parameters that can be defined (or
edited) are Self Trigger Interval, Number of Poll Retries, and Scan Start Delay.

 
 Do not click on the “Add Vessel” button     on the Setup Toolbar;
that button will add another vessel to the array; it will not access the
Data Acquisition Parameters Dialog Box.
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 Figure 5.7  Data Acquisition Parameters Dialog Box

 Self Trigger Interval

 This parameter specifies the  interval (from 1 to 255 seconds) between
consecutive system-generated internal scan triggers in the absence of an external
trigger from the Host. If the Host stops triggering, the system initiates internal
triggering after expiration of a two-minute timer unless another external trigger is
received. Internal triggering terminates when external triggering resumes.

 Number of Poll Retries

 This parameter specifies the number of times (from 0 to 3) the modem will issue a
communication retry to a sensor failing to respond to the initial data acquisition
poll. The default value is 1.

 Scan Start Delay

 This parameter specifies the length of time (in tenths of seconds, from .3 second
to 25.5 seconds) between the external trigger and the primary acoustic sync sent
out by the Data Management Unit. This parameter can be used to change the delay
time between trigger and primary acoustic ranging to move the acoustic ranging
time away from the gun blast.

 

 Increasing the value of the scan start delay extends the acquisition
cycle time.
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 Acoustics Parameters

 The System / Acoustics command accesses the Acoustic Parameters Dialog
Box, which allows you to define system level acoustic parameters. The parameters
that can be defined (or edited) are Secondary Acoustic Sync, Speed of Sound,
Same Channel Aperture Separation, Aperture Size for Same Line, Aperture Size
Transmission, Distance to Bottom Minimum/Maximum, Different Line Aperture
Sizes, Pulse Size Number, and Default Threshold.

 
 Do not click on the “Add Vessel” button     on the Setup Toolbar;
that button will add another vessel to the array; it will not access the
Acoustic Parameters Dialog Box.

 

 Figure 5.8  Acoustics Parameters Dialog Box

 Range Creation

 This option specifies the mode of operation for range data acquisition: one-way
ranging or two-way ranging (default). When one-way ranging is selected, a range
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consists of a single path time measurement, with one unit receiving the acoustic
signal transmitted by the other unit. Range acquisition time is generally shorter
when one-way ranging is in use. When two-way ranging is selected, a range
consists of two path time measurements combined to make a range value, with
each of the two units both transmitting to and receiving from the other unit.

 Secondary Acoustic Sync

 This parameter specifies the length of time (in tenths of seconds, from 0 to 10
seconds) desired between the trigger and the secondary sync sent out. The purpose
of the secondary sync is to initiate a retry for ranges that failed in the primary
acquisition. The value entered must be greater than Primary offset and less than
100 (10 seconds). The default value is 40 (4 seconds). A setting of 0 disables
secondary acquisition.

 Speed of Sound

 This parameter is a fixed nominal sound speed used internally to convert distances
to transit times and vice versa. The accuracy of this value determines the accuracy
of the ranges displayed during run time. The entered value must be from 1400 to
1600 meters/second. The default is 1500 meters/second. (NOTE: This value does
not affect the accuracy of range data transferred to the Host computer.)

 Same Channel Aperture Separation

 This parameter specifies the minimum delay time (in milliseconds) between two
receiver apertures on the same channel. The entry must be from 0 to 999
milliseconds. The default value is 25 milliseconds.

 Aperture Size for Same Line

 This parameter specifies the size of the apertures (in milliseconds) for ranges
between two CMXs attached to the same line. The entered value must be from 1
to 999 milliseconds. The default value is 10 milliseconds.

 Aperture Size Transmission

 This parameter specifies the amount of time (in milliseconds) to be taken for a
CMX to transmit an acoustic pulse. The valid value must be from 0 to 10,000
milliseconds. The default value is 25 milliseconds and should not be changed.

 Shallow Water Reflections: Minimum/Maximum Depth

 These parameters are used by the acoustic compiler to eliminate reflections
between different range pairs. An acoustic pod’s self generated reflection is also
eliminated. Survey water depth minimum and maximum values (in meters) should
be entered at the start of the survey. The default values for both parameters is
9999m. Typically, the default values can be used for water depths of greater than
85m.
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 Different Line Aperture Sizes

 These parameters specify the sizes of the apertures (in milliseconds) for ranges
between two CMXs attached to different lines.

 0 to 999 meters: Enter the different line aperture size for ranges in which the
offsets of both CMXs are less than 1000 meters. The default value is 20
milliseconds.

 1000 to 2999 meters: Enter the different line aperture size for ranges in which the
offsets of one or both CMXs are from 1000 to 2999 meters. The default value is
40 milliseconds.

 3000 meters and above: Enter the different line aperture size for ranges in which
the offsets of one or both CMXs are from 3000 meters and above. The default
value is 60 milliseconds.

 Pulse Size Number

 This parameter affects the acoustic transmit waveform parameters. The pulse size
number is set to its default value of F010 Hex and cannot be changed by you.

 Default Threshold

 This parameter specifies a threshold value that will be used as the default value
when ranges are created. To change the default threshold value for ranges that
have already been created, the ranges must be deleted and re-created after the new
default threshold value has been entered in the default threshold field.

 0 to 999 meters: Enter the default threshold desired for paths in which the offsets
of both CMXs in the range are less than 1000 meters. The default is -6.

 1000 to 2999 meters: Enter the default threshold desired of both CMXs in the
range are from 1000 to 2999 meters. The default is -6.

 3000 meters and above: Enter the default threshold desired for paths in which the
offsets of both CMXs in the range are above 3000 meters. The default is -6.

 

 Radio Configuration Parameters

 The System / Radio Configuration command accesses the Radio Parameters
Dialog Box, which allows you to define radio timing parameters. The parameters
that can be defined (or edited) are Baud Rate, Radio Transmission Delay,
Response Time-out, RTS to Transmission Delay, and Transmission to Reception
Turnaround Delay.
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 Do not click on the “Add Vessel” button     on the Setup Toolbar;
that button will add another vessel to the array; it will not access the
Radio Configuration Parameters Dialog Box.

 

 

 Figure 5.9  Radio Parameters Dialog Box

 Baud Rate

 This parameter is determined by the radio you are using. Ensure that the baud rate
selected matches the baud rate of the radio. The selection options are 1200, 2400,
4800, 9600, and 19200.

 

 The parameters shown in the example are the default values for the
TSI 9600 Radio Modem operating at 9600 baud rate.  Contact
DigiCOURSE before altering the default settings.

 Radio TX Delay (tb)

 This parameter is determined by the radio you are using, since the delay is
introduced by the radio’s buffer. The radio transmission delay is the delay from
the time that the sending device starts transmitting until data is actually received.
The selection options are from 0 to 1000 (in 1/10 ms). For TTI radios, tb = 0 ms;
for TSI radios, tb = 23 ms.
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 To measure tb, first use the radio manual to determine a close estimate, then
compare the sync bit from the radio CMX to the FSK CMX to fine tune this
number. Attempt to get a zero mean spread on the sync bits deviation. An
alternate method of measuring tb is to compare the line 1 start of sync transmit to
the radio line 7 (or radio line 14). For a six streamer system, compare (TXD) MP
1, connector 1, pin 5 to (TXD) MP 1, connector 7, pin 5. For a twelve streamer
system, compare (TXD) MP 1, connector1, pin 5 to (TXD) MP 2, connector 7, pin
5.

 Response Time-out (te)

 This parameter specifies the time-out period in the radio multiplex port from the
end of the TX to RX Turnaround period to the first bit in the response message.
The default is 60 ms. The selection options are from 0 to 255 (in ms); however,
never use 0.

 RTS to TX Delay (ta)

 This parameter specifies the delay required from the activation of RTS to the start
of transmission from the sending device to the radio modem. The selection
options are from 0 to 255 (in ms); however, never use 0. For TTI radios, ta = 25
ms; for TSI radios, ta = 3 ms.

 TX to RX Turnaround (tc)

 This parameter specifies the delay required as dead time between the end of
transmission and the start of reception. This delay is necessary in some radios due
to the transmitter decay time. The selection options are from 0 to 255 (in ms);
however, never use 0. For TTI radios, tc = 30 ms; for TSI radios, tc = 1 ms.

 

 Parameters td and tf are embedded in the CTX and, therefore, are not
adjustable in the Radio Configuration Parameters Dialog Box.

 

 Baud Rate Compensation Delay in the CTX (td)

 This parameter is the delay that is embedded in the CTX to compensate for the
differences in baud rates between the radio and FSK ports. This is only relevant
when timing accuracy is required. Only the sync message needs this delay. The
value embedded in the CTX take into account the actural baud rates of the MP
and the CTX units.

 Message Time-out in the CTX (tf)

 This parameter is the time-out period in the CTX from the start of the Data Carrier
Detect to the start of the first bit in the incoming message. The tf = 32 ms.
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 Host Test

 The System / Host Test command tests the interface between the DMU and the
Host computer. When this option is selected, the DMU is taken off-line and a
fixed pattern of sensor depth, heading, and range data is generated and output to
the Host at each external trigger. The data patterns are generated by starting with
an initial value for the first sensor or range defined, and incrementing (or
decrementing) the value by one unit for each subsequent sensor or range.
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 The Edit Menu

  

 Create Vessel

 The Edit / Create Vessel command adds a vessel to the array.

 Edit Line

 The Edit / Platform Line / Edit command allows you to edit an existing line. To
edit a line, first select (highlight) a line in either the Text side or the Graphic side,
then click on the Edit command. Change the necessary fields in the
Platform/Line Information Dialog Box. You may redefine any of the following
Platform/Line parameters: Line ID, Vessel, Name, Type, Cable, Port, Line Length,
Lateral Offset, Cable Depth and Disable Cable Screen Display.

 Line ID

 The line identifier is a letter or a digit-letter combination that serves as a reference
for a line. The identifiers are A to Z for lines 1-26, 1A to 1Z for lines 27-52, and
2A to 2K for lines 53-63 (63 total lines).  No two lines can have the same
identifier.

 Vessel

 The vessel number allows System 3 to associate a line to a vessel. This feature
also allows a multi-vessel system to be treated as a single system. The limits for
vessel number are 1 to 4, and the default is 1.

 Name

 The line name is used only for display purposes. The name can be any character
string up to 20 characters long, and can include blanks. There is no default for line
name.
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 Type

 The type identifies the type of platform line, and is used both for display purposes
and for identification of streamer cables in the bird data sent to the Host. The
selections available are Streamer Cable, Vessel, Gun Array, Tail Buoy, Paravane,
Tow Fish, Nav Sled, and Test Cable.

 Cable

 The cable number is used for identification of streamer cables in the bird data sent
to the Host. This field is locked out unless the “Line Type” is “Streamer”. Cable
numbers must be sequential with no numbers skipped.

 Port

 The port corresponds to the line number on the Line Interface Unit to which the
communications link for the defined line is connected. Line Interface Unit
numbers are 1 to 6, 8 to 13, and 15 to 20. Port numbers 7 and 14 are for radio
telemetry only and are not to be used as streamer cables.

 Line Length (m)

 The line length is the total length of the platform line (in meters), and is used for
display purposes. The line length must be greater than the largest unit offset.

 Lateral Offset (m)

 The lateral offset is the lateral offset distance (in meters) from a system-wide
reference line to the line being entered. Normally, all lines are referenced from the
vessel center line. Lines to port of the reference have a negative lateral offset and
lines to starboard have a positive offset. The limits are -9999 to +9999; and the
default is 0. For multi-vessel systems, all lines must be referenced from the same
reference line (which is normally the centerline of Vessel 1).

 Cable Depth (m)

 The depth is the desired target depth for the line. The limits for depth are from 0
to 115 meters (0 to 378 feet), and the default is 0.

 

 An emergency dive depth, which specifies the target depth for all
cables when an emergency dive command is executed, is input during
the Setup program by selecting System menu, Global submenu,
Emergency Depth command.

 
 

 
 When using Model 5010E or 5011E birds, DO NOT ENTER VALUES
GREATER THAN 31 METERS (103 feet).
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 Create Line

 The Edit / Platform Line / Create command allows you to add a new line to the
array of a vessel (that is, to create or define a new line to which sensors can be
attached, such as streamer cables, gun arrays, tail buoys, etc.) by accessing a new
Platform/Line Information Dialog Box and completing the information fields in
the box. Platform/Line parameters that can be defined are Line ID, Vessel, Name,
Type, Cable, Port, Line Length, Lateral Offset, Cable Depth and Disable Cable
Screen Display.

 Delete Line

 The Edit / Platform Line / Delete command deletes the selected line (and
associated sensors).

 Copy Line

 The Edit / Platform Line / Copy command allows you to copy a selected line
that has previously been defined. If the line sensors have been defined, this
command will also copy all sensor information (except the serial numbers) to the
new line. To copy a line, first select an existing line from the Graphic side, then
click on the Copy command. Once the line has been copied it is necessary to set
the line parameters for the new line and enter the sensor serial numbers.

 Populate Line

 The Edit / Platform Line / Populate command accesses the Populate Line
Dialog Box, which allows you to add Model 5011 birds (or acoustic units) to a
selected streamer at regularly-spaced offsets.

 

 

 The Populate command is more useful for adding birds than for
adding acoustic units because birds are normally spaced at regular
intervals along the entire length of a streamer cable.

 

 

 For a shortcut to the Populate
command, right mouse click on
the desired Line on the Text side,
which will display the following
submenu:
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 Figure 5.10  Populate Dialog Box

 Total Number of Units

 Enter the number of units (from 1 to 63) that you desire to add to the line.

 

 The populate action terminates when the offset of the next unit to be
added exceeds the platform line length.

 First ID

 Enter the unit number (from 1 to 63) for the first unit you are adding to the line.

 Starting Offset

 The offset from tow-point is the linear offset distance (in meters) from a system-
wide reference point to the bird. Normally, all units are referenced from the center
stern of the vessel (or navigation reference point). Units in front of this point have
a negative offset and birds behind this point have a positive offset. The limits are
-600 to +10000 meters.

 Spacing

 Enter the spacing (in meters) between the birds. The spacing must be from 10 to
1000 meters.
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 After populating a line with birds (or acoustic units), you must enter the serial
numbers for each unit. Use the Edit / Unit Sensor / Add Serial Numbers
command to open the Set Sensor Serial Number Dialog Box (which lists only
the sensor that do not already have serial numbers) and assign serial numbers to
each unit on the list.

 Edit Unit/Sensor

 The Edit / Unit Sensor / Edit command accesses a Sensor Information Dialog
Box.  To edit an existing sensor, select (highlight) a sensor in either the Text side
or the Graphic side, then click on the Edit menu, Unit/Sensor submenu, (Bird,
Acoustic, Compass, Depth, or Velocimeter) command. Change the necessary
fields in the Sensor Information Dialog Box.

 

 When using free-form unit names, the Dialog Box contains a field for
the entry of Unit Name.  Enter any alphanumeric character string up
to six characters long.

 

 Create Acoustic Unit

 The Edit / Unit Sensor / Create / Acoustic command accesses the Acoustic
Sensor Information Dialog Box.  You can add an acoustic sensor to a line by
completing the information fields in the box.

 Access a new Acoustic Sensor Information Dialog Box by any of the following
methods:

• Click on the Edit menu, Unit/Sensor submenu, Create submenu,
Acoustic command.

• Click on 

• Click the right mouse button on the platform/line icon    in
the Text side to reveal a submenu, then click on the Create submenu,
Acoustic command.

• Click the right mouse button on any sensor icon in the Text side to reveal a
submenu, then click on the Create submenu, Acoustic command.

 To edit an existing acoustic sensor, select (highlight) an acoustic sensor, then click
on Edit menu, Unit/Sensor submenu, Edit command. Alternatively, you can
double-click on the sensor in the Graphic side.
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 Acoustic Sensor Information Dialog Box

 Acoustic sensors must be uniquely identified to all system components For
system-wide identification, a unique global identifier is assigned to each sensor by
using the Setup program.

 When standard Input/Output names are in use, a 4- or 5-character alphanumeric
identifier is assigned to each sensor during Setup. This identifier is guaranteed to
be unique by the Setup program, and is stored in the sensor equipment table of the
configuration file. The first character (or two characters for lines 27-63) of the
identifier is a letter or digit-letter pair designating the line (platform) to which the
sensor is attached. The next character is the letter A (designating an acoustic
sensor), and the last two characters are digits designating the unit number.

 Unit Number

 The unit number determines the last two characters of the unique sensor identifier
(BA01, 1CA03), and is used to construct a unique address for communications
with the sensor. The limits for CMX unit number are 1 to 31. The CMXs are
stored in alphanumeric order, and, for existing setup files, the first CMX initially
displayed is the one with the lowest unit number on the first line.

 Serial Number

 The serial number is the unique number assigned to each DigiCOURSE product
when it is manufactured. The serial number is printed on the label of each CMX,
and must be entered here. Duplication of serial numbers is not allowed.

 Offset from Towpoint

 The offset from towpoint is the linear offset distance (in meters) from a system-
wide reference point to the CMX. Normally, all units are referenced from the
center stern of the vessel (or navigation reference point). CMXs in front of this
point have a negative offset and CMXs behind this point have a positive offset.
The limits are -9999 to the defined line length, and the default is 0.

 Group Number

 The group number associates the CMX with an acoustic group, such as front,
middle or tail. It is used primarily for display purposes. The limits for group
number are 1 to 9.

 If the TAGS protocol is in use, this field is locked out. The TAGS ID determines
the group number (F=1, T=2, M=3, N=4, O=5, P=6, Q=7, R=8, S=9).

 Geco/CLS/GLS ID

 The protocol identifier selects the Host protocol in use. If the CLS or GLS Host
protocol is in use, this entry identifies the CMX unit in the nomenclature defined
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in that protocol. If the HGS (TAGS) Host protocol is in use, this entry identifies
the CMX unit in the nomenclature defined in that protocol.

 Transmit Channels 1, 2, 3, 4, and 5

 These entries allow you to limit the freedom of the compiler by disallowing
certain transmit channels. This causes the transmit channel of the CMX to be
limited to the allowed channels. If a particular channel is causing interference to
another system, that channel can be disallowed here. Check (or un-check) the
appropriate check box to allow (or disallow) the use of a channel. There must be
at least one transmit channel allowed. The default is all channels allowed. If any
of these entries are changed, the acoustic data must be compiled.

 Receive Channels 1, 2, 3, 4, and 5

 These entries allow you to limit the freedom of the compiler by disallowing
certain receive channels. This causes all ranges associated with the CMX to be
limited to the allowed channels. If background noise levels are too high for a
particular channel, that channel can be disallowed here. Check (or un-check) the
appropriate check box to allow (or disallow) the use of a channel. There must be
at least one receive channel allowed. The default is all channels allowed. If any of
these entries are changed, the acoustic data must be compiled.

 Create Bird Unit

 The Edit / Unit Sensor / Create / Bird command accesses a new Bird Sensor
Information Dialog Box.  You can add a new bird sensor to a line by completing
the information fields in the box.

 Access a new Bird Sensor Information Dialog Box by any of the following
methods:

• Click on the Edit menu, Unit/Sensor submenu, Create submenu, Bird
command.

• Click on 

• Click the right mouse button on the line icon    in the Text
side to reveal a submenu, then click on the Create submenu, Bird
command.

• Click the right mouse button on any sensor icon in the Text side to reveal a
submenu, then click on the Create submenu, Bird command.

 To edit an existing bird sensor, select (highlight) a bird in either the Text side or
the Graphic side, then click on the Edit menu, Unit/Sensor submenu, Edit
command. Alternatively, you can double-click on the sensor in the Graphic side.
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 Bird Sensor Information Dialog Box

 Bird sensors must be uniquely identified to all system components. For system-
wide identification, a unique global identifier is assigned to each sensor by using
the Setup program.

 When standard Input/Output names are in use, a 4- or 5-character alphanumeric
identifier is assigned to each sensor during Setup. This identifier is guaranteed to
be unique by the Setup program, and is stored in the sensor equipment table of the
configuration file. The first character (or two characters for lines 27-63) of the
identifier is a letter or digit-letter pair designating the line (platform) to which the
sensor is attached. The next character is the letter B (designating a bird), and the
last two characters are digits designating the unit number.

 Unit Number

 The unit number determines the last two characters of the unique sensor identifier
(AB01), and is used to construct a unique address for communications with the
sensor. The limits for bird unit number are 1 to 63. The birds are stored in
alphanumeric order, and, for existing setup files, the first bird initially displayed is
the one with the lowest unit number on the first line.

 Serial Number

 The serial number is the unique number assigned to each DigiCOURSE product
when it is manufactured. The serial number is printed on the label of each
DigiBIRD, and must be entered here. Duplication of serial numbers is not
allowed.

 Offset from Towpoint

 The offset from towpoint is the linear offset distance (in meters) from a system-
wide reference point to the bird. Normally, all units are referenced from the center
stern of the vessel (or navigation reference point). Birds in front of this point have
a negative offset and birds behind this point have a positive offset. The limits are -
9999 to the defined line length, and the default is 0.

 Subtype

 It is vital to streamer depth control that the model defined by the subtype entry
agrees with the type of bird installed on the streamer. Model types may be mixed
on the streamer providing they are correctly identified.

 Depth

 The depth defines the assigned target depth (in meters) of the bird. The default
value is the depth of the line to which the bird is attached. The limits are 0 to 115
meters (0 to 378 feet).
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 When using Model 5010E or 5011E birds, DO NOT ENTER VALUES
GREATER THAN 31 METERS (103 feet).

 

 Include data to Host  Yes/No

 If the Host protocol you are using limits the number of sensors that can send data
to the Host, you may select which sensors are allowed to send data.

 Create Velocimeter Unit

 The Edit / Unit Sensor / Create / Velocimeter command accesses a new
Velocimeter Sensor Information Dialog Box.  You can add a new velocimeter
sensor to a line by completing the information fields in the box.

 Access a new Velocimeter Sensor Information Dialog Box by any of the
following methods:

• Click on the Edit menu, Unit/Sensor submenu, Create submenu,
Velocimeter command.

• Click on 

• Click the right mouse button on the line icon    in the Text
side to reveal a submenu, then click on the Create submenu, Velocimeter
command.

• Click the right mouse button on any sensor icon in the Text side to reveal a
submenu, then click on the Create submenu, Velocimeter command.

 To edit an existing sensor, select (highlight) a velocimeter in either the Text side
or the Graphic side, then click on the Edit menu, Unit/Sensor submenu, Edit
command. Alternatively, you can double-click on the sensor in the Graphic side.

 Velocimeter Sensor Information Dialog Box

 Velocimeter sensors must be uniquely identified to all system components. For
system-wide identification, a unique global identifier is assigned to each sensor by
using the Setup program.

 When standard Input/Output names are in use, a 4- or 5-character alphanumeric
identifier is assigned to each sensor during Setup. This identifier is guaranteed to
be unique by the Setup program, and is stored in the sensor equipment table of the
configuration file. The first character (or two) of the identifier designates the line
(platform) to which the sensor is attached. The next character is the letter V
(designating a velocimeter sensor), and the last two characters are digits
designating the unit number.
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 Unit Number

 The unit number determines the last two characters of the unique sensor identifier
(BV01), and is used to construct a unique address for communications with the
sensor. The limits for velocimeter unit number are 1 to 10. The units are stored in
alphanumeric order, and, for existing setup files, the first unit initially displayed is
the one with the lowest unit number on the first line.

 Serial Number

 The serial number is the unique number assigned to each DigiCOURSE product
when it is manufactured. The serial number is printed on the label of each
velocimeter, and must be entered here. Duplication of serial numbers is not
allowed.

 Offset from Towpoint

 The offset from towpoint is the linear offset distance (in meters) from a system-
wide reference point to the velocimeter. Normally, all units are referenced from
the center stern of the vessel (or navigation reference point). Units in front of this
point have a negative offset and units behind this point have a positive offset. The
limits are -9999 to the defined line length, and the default is 0.

 

 Create In-Streamer Compass Sensor

 The Edit / Unit Sensor Create / Compass command accesses a Compass Sensor
Information Dialog Box. You can add an in-streamer compass to a line by
completing the information fields in the box.

 Access a new Compass Sensor Information Dialog Box by any of the following
methods:

• Click on the Edit menu, Unit/Sensor submenu, Create submenu,
Compass command.

• Click on 

• Click the right mouse button on the line icon    in the Text
side to reveal a submenu, then click on the Create submenu, Compass
command.

• Click the right mouse button on any sensor icon in the Text side to reveal a
submenu, then click on the Create submenu, Compass command.

 To edit an existing in-streamer compass sensor, select (highlight)  in either the
Text side or the Graphic side, then click on the Edit menu, Unit/Sensor submenu,
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Compass command. Change the necessary fields in the Compass Sensor
Information Dialog Box.

 Compass Sensor Information Dialog Box

 Compass sensors must be uniquely identified to all system components For
system-wide identification, a unique global identifier is assigned to each sensor by
using the Setup program.

 When standard Input/Output names are in use, a 4- or 5-character alphanumeric
identifier is assigned to each sensor during Setup. This identifier is guaranteed to
be unique by the Setup program, and is stored in the sensor equipment table of the
configuration file. The first character of the identifier is a letter designating the
line (platform) to which the sensor is attached. The next character is the letter C
(designating compass), and the last two characters are digits designating the unit
number.

 Unit Number

 The unit number determines the last two characters of the unique sensor identifier
(BC01), and is used to construct a unique address for communications with the
sensor. The limits for unit number are 1 to 63. The compass sensors are stored in
alphanumeric order, and, for existing setup files, the first unit initially displayed is
the one with the lowest unit number on the first line.

 Serial Number

 The serial number is the unique number assigned to each DigiCOURSE product
when it is manufactured. The serial number is printed on the label and must be
entered here. Duplication of serial numbers is not allowed.

 Offset from Towpoint

 The offset from towpoint is the linear offset distance (in meters) from a system-
wide reference point to the compass sensor. Normally, all units are referenced
from the center stern of the vessel (or navigation reference point). Compass
sensors in front of this point have a negative offset and compass sensors behind
this point have a positive offset. The limits are -9999 to the defined line length,
and the default is 0.

 Include data to Host  Yes/No

 If the Host protocol you are using limits the number of sensors that can send data
to the Host, you may select which sensors are allowed to send data.
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 Create In-Streamer Depth Sensor

 The Edit / Unit Sensor Create / Depth command a new Depth Sensor
Information Dialog Box. You can add an in-streamer depth sensor to a line by
completing the information fields in the box.

 Access a new Depth Sensor Information Dialog Box by any of the following
methods:

• Click on the Edit menu, Unit/Sensor submenu, Create submenu, Depth
command.

• Click on 

• Click the right mouse button on the line icon    in the Text
side to reveal a submenu, then click on the Create submenu, Depth
command.

• Click the right mouse button on any sensor icon in the Text side to reveal a
submenu, then click on the Create submenu, Depth command.

 To edit an existing in-streamer depth sensor, select (highlight) a depth sensor in
either the Text side or the Graphic side, then click on the Edit menu, Unit/Sensor
submenu, Depth command. Change the necessary fields in the Depth Sensor
Information Dialog Box.

 Depth Sensor Information Dialog Box

 In-streamer depth sensors must be uniquely identified to all system components
For system-wide identification, a unique global identifier is assigned to each
sensor by using the Setup program.

 When standard Input/Output names are in use, a 4- or 5-character alphanumeric
identifier is assigned to each sensor during Setup. This identifier is guaranteed to
be unique by the Setup program, and is stored in the sensor equipment table of the
configuration file. The first character (or two) of the identifier designates the line
(platform) to which the sensor is attached. The next character is the letter D
(designating an in-streamer depth sensor), and the last two characters are digits
designating the unit number.

 Unit Number

 The unit number determines the last two characters of the unique sensor identifier
(BD01), and is used to construct a unique address for communications with the
sensor. The limits for unit number are 1 to 63. The in-streamer depth sensors are
stored in alphanumeric order, and, for existing setup files, the first unit initially
displayed is the one with the lowest unit number on the first line.
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 Serial Number

 The serial number is the unique number assigned to each DigiCOURSE product
when it is manufactured. The serial number is printed on the label and must be
entered here. Duplication of serial numbers is not allowed.

 Offset from Towpoint

 The offset from towpoint is the linear offset distance (in meters) from a system-
wide reference point to the in-streamer depth sensor. Normally, all units are
referenced from the center stern of the vessel (or navigation reference point). In-
streamer depth sensors in front of this point have a negative offset and depth
sensors behind this point have a positive offset. The limits are -9999 to the
defined line length, and the default is 0.

 Include data to Host  Yes/No

 If the Host protocol you are using limits the number of sensors that can send data
to the Host, you may select which sensors are allowed to send data.

 Delete Unit/Sensor

 The Edit / Unit Sensor / Delete command deletes the selected sensor from the
array.

 Move Sensors

 The Edit / Unit Sensor / Move Sensors command allows you to move or offset a
sensor or group of sensors.

 You can move any sensor by either of the following methods:

• Click on the Edit menu, Unit/Sensor submenu, Move Sensor command,
and, using the cursor, draw a box around (rubberband) the sensors that you
want to offset. When the sensors are selected, the Move Sensor(s) Dialog
Box is displayed. Enter the offset in meters and click on the “OK” button
to move/offset the sensors.

• Click on  , and, using the cursor, draw a box around (rubberband) the
sensors that you want to offset. When the sensors are selected, the Move
Sensor(s) Dialog Box is displayed. Enter the offset in meters and click on
the “OK” button to move/offset the sensors.
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 Figure 5.11  Move Sensor Dialog Box

 

 Add Serial Numbers

 The Edit / Unit Sensor /  Add Serial Number command accesses the Set Sensor
Serial No. Dialog Box.  This dialog box shows the list of units that have no serial
numbers. Enter the serial numbers for these units.

 

 Figure 5.12  Set  Sensor Serial Number Dialog Box

 The Set Sensor Serial No. Dialog Box shows the list of units that have no serial
numbers. Enter the serial numbers for these units.
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 This dialog box is accessed by clicking on Edit / Unit/Sensor / Add Serial
Number.

 

 You must press the Save button; otherwise, nothing is stored.

 

 Auto Create Ranges

 The Edit / Auto Create Ranges command creates a set of ranges automatically.
Acoustic ranges can be manually created one at a time by following the standard
range creation procedure, or a set of ranges meeting user-defined criteria can be
created automatically by using the Auto Create Ranges option. Significant time
can be saved for large networks by using this option. First let the program
automatically generate the most commonly configured ranges, then use the
manual range creation and deletion procedures to remove unwanted ranges and
add other desirable ranges.

 You can create all ranges that meet specified criteria by following these steps.

 1. Select the Display All Ranges option from the main toolbar. This will
permit you to view the results immediately.

 2.  Select Auto Create Ranges from the Edit menu.

 3.  The Auto Create Ranges dialog box will appear. Enter the desired
maximum range distance, the maximum number of ranges per acoustic
node, and use the “create intergroup ranges” checkbox to indicate whether
ranges are to be created between groups.

 4.  Click OK to automatically create ranges meeting the defined criteria.

 5.  If the ranges created are not satisfactory, use the Delete All Ranges
option under the Edit menu to delete these ranges, then repeat the steps.

 6.  Use the standard manual range creation and deletion procedures to
refine the network.

 Maximum Ranges per Node

 This entry limits the number of ranges that can be connected to any CMX node
during the automatic range creation procedure.  Enter a number from 1 to 8.

 Maximum Range Distances

 The three entries for maximum distance define the longest ranges that are to be
automatically created for each category. Distance is entered in meters.  The three
categories are:
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 In-line ranges between nodes on the same streamer

 Adjacent   ranges between nodes on different streamers but at the same streamer
  offset

 Cross-line ranges between nodes on different streamers with different offsets

 Create Intergroup Ranges

 This checkbox indicates whether intergroup ranges (ranges between nodes in
different groups) are to be created. They will not be created by default.

 Create Intervessel Ranges

 This checkbox indicates whether intervessel ranges (ranges between nodes on
different vessels) are to be created. They will not be created by default.

 Create Ranges

 The Edit / Create Ranges command accesses the Edit Ranges view, which is the
first step in creating new ranges or editing existing ranges.

 You can access the Edit Ranges view in either of two ways:

• Click on the Edit menu, Create Ranges command  OR

• Click on 

 Click on an acoustic unit in the Graphic side to display all existing ranges for that
unit; the icon for the selected unit will turn white.  To define a new range for that
sensor, hold the Control key (Ctrl) down and right-click (right mouse button) on
the second acoustic unit of the range pair.  A green (two-way mode) or yellow
(one-way mode) line connecting the two units representing the range will appear,
and the icon for the second unit will turn green (or yellow).  Use this method to
create up to eight ranges for the selected unit.  When all ranges are defined for the
current unit, left-click on that unit to de-select it, then right-click on the next unit
whose ranges you wish to define or edit.

 When in one-way ranging mode, the first unit selected is the transmitter and the
second unit selected is the receiver.  A unit can be on the receiving end of no more
than eight ranges; however, a transmitting unit can transmit to an unlimited
number of receiving units.  So when connecting to secondary units in one-way
mode, you may select more than eight secondary units.  When creating ranges in
one-way mode, the secondary unit is displayed in yellow if it is receiving from the
selected unit, in gray if it is transmitting to the selected unit, and in green if it is
both transmitting to and receiving from the selected unit.

 To delete an existing range, left-click to select the first unit of the range pair, then
hold the Control (Ctrl) key down and right-click on the second acoustic unit.  The
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second unit’s icon will turn gray, and the line connecting the two units will
disappear.

 Edit Range Dialog Box

 The Edit Range dialog box is used to modify parameters that affect the way the
acoustic signal for the selected range is acquired and processed in the CMX.  To
edit an existing range, left-click on one unit of the range pair, then double-click on
the second acoustic unit (which is ranged to the first unit) to access the Edit
Range Dialog Box. (You may instead, right click on an acoustic sensor in the tree
view on the Text side, and select Ranges; the Ranges Summary Dialog Box
listing all ranges for that unit will be displayed. Double-click on the desired range
to access the Edit Range Dialog Box.)

 Range Name is used to identify a range in the Operator Interface program when
viewing Signal Strength and Path Time displays. The range name can be any
character string up to 20 characters long and can include blank spaces and upper
or lower case letters.

 Path thresholds are entered as a scale factor index. Path 1 is the signal received by
the first CMX in the CMX pair, and Path 2 is the signal received by the second
CMX. The value entered is an index that corresponds to the threshold setting in
dB above RMS noise level. The DigiRANGE index also determines CMX
operational mode: reflection or normal. The following table shows the valid
indexes and their corresponding dB levels for DigiRANGE systems without
enhanced CFAR.

 



System 3 (Version 4.0) User’s Manual

212

  Normal
Mode

 Reflection
Mode

 dB Above
Noise

  -1.00  -11.00  21.5

  -2.00  -12.00  19.0

  -3.00  -13.00  17.5

  -4.00  -14 **  15.5

  -5.00  -15.00  13.0

  -6 **  -16.00  9.5

  -7.00  -17.00  5.5

  -8.00  -18.00  3.5

  -9.00  -19.00  1.0

  -10.00  -20.00  -2.5

 

 All DigiCOURSE acoustic units with serial number 7000 and higher have new
firmware with Enhanced CFARs.  This feature is an improvement over the
previous CFAR settings in that it is self-adjusting to changing noise conditions.
Also the system is more immune to false noise trips.  The new default setting for
deep water mode is -3, and for dual tracking mode -14.  The default value of -3
should be used for units 1000 meters or more behind the vessel.  For units less
than 1000 meters, the default value of -5 seems to work best.

 Adjustments should only be needed in the case of weak signals or interference
from adjacent acoustic devices.  If a signal is weak then try lowering the CFAR
setting one CFAR index at a time and observe the range for some time before
using a lower CFAR setting.

 If you are receiving interference from an adjacent acoustic device try changing the
setting to -1, and then adjusting down if needed.
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 The following table gives the expected threshold settings for minimum and
maximum noise for a given CFAR index setting.

 

   Normal  Dual
Tracking

 dB Above
Noise

   -1  -11  34.5 - 16

   -2  -12  31 - 14

  Default for
offsets >1000m

 -3  -13  28 - 13

   -4  -14  24 - 12

  Default for
offsets <1000m

 -5  -15  22 - 11

   -6  -16  19 - 9

   -7  -17  16 - 7.5

   -8  -18  12 - 6

   -9  -19  8 - 4.5

   -10  -20  6 - 2.5

 

 The minimum and maximum range distances are entered in meters. The “Retry”
option (Yes/No) determines whether this range should be retried if secondary
acquisition is enabled and the primary range data was absent or unqualified. The
“Range Data Mode” field selects the type of range data qualification: two-way,
one-way (Unit 1 receive), or one-way (Unit 2 receive). Two-way range
qualification generally results in a more accurate measurement, but one-way
qualification may be appropriate if one CMX of the pair is in a high noise
environment.  This selection is applicable only when the system is operating in
two-way ranging mode, and is not to be confused with the two operational modes.

 Delete All Ranges

 The Edit / Delete All Ranges command deletes or clears all ranges.
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 The View Menu

 

 

 A shortcut to the
Summary Information
boxes can be accessed
by a right mouse click
on the Graphic side.
The following set of
submenus will be
displayed.

 

 

 View All Ranges

 The View / All Ranges command is an on/off switch to display the ranges in the

Graphic side.  The “Display All Ranges” button  duplicates the command.

 

 Selecting All Ranges will deselect Acoustics.
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 View Lines Summary

 The View / Summary / Lines command accesses the Platforms/Lines Summary
Information Box. This summary box lists all available information on every line
in the system.

 

 Figure 5.13  Lines Summary

 View Sensors Summary

 The View / Summary / Sensors command opens the Sensor Type Selection
window. Select the type of sensor summary information that you want to view,
and press the OK button.

 

 Figure 5.14  Sensor Type Selection
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 If you select Acoustics, the Acoustic Sensor Summary Information Box will
appear. This summary box lists all available information on every acoustic unit in
the system.

 

 Figure 5.15  Acoustic Sensor Summary Information Box
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 If you select Bird, the Bird Sensor Summary Information Box will appear. This
summary box lists all available information on every bird unit in the system.

 

 Figure 5.16  Bird Sensors Summary Information Box
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 View Ranges Summary

 The View / Summary / Ranges command opens the Acoustic Sensor Group
Option window. Select the group of acoustic sensors whose summary information
you want to view, and press the OK button.

 

 Figure 5.17  Acoustic Sensor Group Option

 When you select a group and press the OK button, the Ranges Summary
Information Box will appear. This summary box lists all available information on
every acoustic unit in that group.

 

 Figure 5.18  Acoustic Ranges Summary Information Box
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 You can make changes to any of the ranges by double-clicking on the range to
access the Range Adjustment Dialog Box.

 

 Figure 5.19  Range Adjustment Dialog Box

 View Acoustics

 The View / Acoustics command is an on/off switch to display the Acoustic
sensors in the Graphic side. Deselect the item to hide the acoustic sensors.

 

 Selecting Acoustics will deselect All Ranges.

 View Birds

 The View / Birds command is an on/off switch to display the Bird sensors in the
Graphic side. Deselect the item to hide the birds.

 View In-Streamer Compasses

 The View / Compasses command is an on/off switch to display the Compass
sensors in the Graphic side. Deselect the item to hide the in-streamer compasses.

 View In-Streamer Depth Sensors

 The View / Depths command is an on/off switch to display the Depth sensors in
the Graphic side. Deselect the item to hide the in-streamer depth sensors.
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 View Main Toolbar

 The View / Toolbar command is an on/off switch to display the Main Toolbar.
Deselect the item to hide the toolbar.

 View Setup Toolbar

 The View / Sys3 Toolbar command is an on/off switch to display the Setup
Toolbar. Deselect the item to hide the toolbar.

 View Status Bar

 The View / Status Bar command is an on/off switch to display the Status Bar.
Deselect the item to hide the bar.
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 The Reports Menu

 

 Print All Data

 The All Data Report contains all data of the system being configured, including
the information in the System Setup, Line Data, Unit Data, and Range Data
Reports. The Reports / All Data command accesses a print dialog box, which
will allow you to select the printer, print range, and number of copies when
printing this report.

 Print System Setup

 The Reports / System Setup command accesses a print dialog box, which will
allow you to select the printer, print range, and number of copies when printing
this report.

 Print Line Data

 The Reports / Line Data command accesses a print dialog box, which will allow
you to select the printer, print range, and number of copies when printing this
report.

 Print Unit Data

 The Reports / Unit Data command accesses a print dialog box, which will allow
you to select the printer, print range, and number of copies when printing this
report.
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 Print Range Data

 The Reports / Range Data command accesses a print dialog box, which will
allow you to select the printer, print range, and number of copies when printing
this report.
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 The Window Menu

 

 

 Full Scale

 The Window / Full Scale command shows the entire system network in the

Graphic side. The “Display Full Scale” button    duplicates the command.

 Redraw

 The Window / Redraw command redraws or refreshes the screen.

 Zoom Area

 The Window / Zoom Area command enlarges a selected area in the Graphic side.
Following the initial command, use the cursor to draw a box around the area you

want to enlarge. The “Zoom Area” button    duplicates the command.
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 The Help Menu

 

 

 System 3 Help Topics

 The Help / Sys3w Help Topics command accesses the Help file.

 Using System 3 Help

 The Help / Using Sys3w Help command accesses a section that explains how to
use the help file. The main Help window contains Contents and Index tabs.  From
the Contents window, double-click on a book to open it and display a list of
topics, then double-click on the desired topic. From the Index window, either
double-click on the desired topic, or type the first few letters of the topic in the
window under the Index tab to find the topic, then click the Display button (or
press Enter).

 About Box

 The Help / About Sys3w command opens a box that displays the software
program version number and copyright information.
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 This section describes in detail each function of the Operator Interface
Program.    If you want to operate System 3, see Section II, Setup and
Operation, which describes the functions in a step-by-step sequence.

 SYSTEM 3 OPERATOR INTERFACE WINDOW
 When a Setup file is opened in the System 3 Operator Interface Program, the main
window is automatically displayed. The main System 3 Operator Interface
window is composed of a title (caption) bar, a color bar, a menu bar, a toolbar, a
graphic display window, and a status bar.

 

 

 Figure 6.1  Operator Interface Window

 Title Bar
 The Title Bar is displayed at the top of the main window. In addition to the name
and view of the open file (when accessed) and a pull-down menu, the title bar
contains the following three buttons:



 System 3 (Version 4.0) User’s Manual

  226
 

 Click on the “Minimize” button:  to reduce the System 3 graphic display
window to an icon, without closing the file.

 Click on the “Maximize” button:  to enlarge the System 3 graphic display
window to full screen.

 Click on the “Close” button:  to close the active or open System 3 file.

 Color Bar

 

 The Color Bar is a color legend for all pre-set display
parameters. The Color Bar can be activated by selecting the
View / Color Bar command, or by right-clicking on the graphic
display and selecting the Color Bar option.

 The colors are defined in the System Preferences Dialog Box.
(Note that if your monitor is not using True or High Color, the
colors you select may appear differently in the displays.). To
access the System Preferences Dialog Box, click on the File /
Preferences command. The System Preferences Dialog Box is
tabbed into two sections: the System Preferences for Depth
Displays Dialog Box and the System Preferences for
Ranges/Paths/Acoustics Dialog Box.

 Note that on the Color Bar, the Primary Range color is black,
the Comm. Error is red, and the Normal condition is white.
These three colors cannot be altered.

 The Color Bar can be repositioned anywhere on the screen by
clicking and dragging it to the desired location.

 

 Status Bar

 

 Title Status

 Title Status: 
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 The Title status is activated when you click on a menu item or press a toolbar
button. A description of the action that is about to be executed appears. If you do
not wish to execute the command displayed on the status bar, abort the operation.

 The above example: “For Help, press F1” is the default message.

 Shot Status

 Shot Status: 

 The Shot status codes are as follows:

 I = Internal Trigger

 E = External Trigger

 * = Waiting for Trigger

 The number following the Trigger code (which in this example is 31) is the
configuration sequence number. This number changes automatically each time
there is a change to the system configuration (for example, changes to serial
numbers, depths, and ranges).

 The number following the configuration sequence number is the time of the last
shot. The time is in hours, minutes, and seconds: 14:50:59.

 Shot Clock

 Shot Clock: 

 The shot clock is the approximate time (in seconds) until the next shot. The shot
interval can be set or changed by clicking on DMU / Change Scan Interval
(which accesses the Internal Scan Interval Dialog Box) and assigning a number
(between 0 and 255) in the Trigger field.

 DMU Status

 DMU Status: 

 The DMU status codes are as follows:

 R = Run Mode (R alone is for bird data, but no acoustic scan. A and R together
are needed for acoustic data)

 B = Background Noise Mode

 P = Path Prediction On

 Q = Path Reflection QC On

 A = Acoustics On
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 - = Position of option turned off

 ALog Status

 Acoustic Logging Counter: 

 The acoustic logging counter counts the number of shots logged and is used for
acquiring acoustic analysis data. The total number of shots to be logged can be set
by clicking on Performance / Acoustic Disk Logging (which accesses the Disk
Logging: Acoustics Dialog Box) and assigning a number (between 1 and 2000)
in the Total No. of Shots field.

 BLog Status

 Bird Logging Counter: 

 The bird logging counter counts the number of shots logged and is used for bird
ballast data. The total number of shots to be logged can be set by clicking on
Performance / Bird Disk Logging (which accesses the Disk Logging: Depth &
Fin Dialog Box) and assigning a number (between 1 and 250) in the Total No. of
Shots field.

 Keyboard Latch State

 Keyboard Latch State: 

 On the right side of the status bar, the keyboard latch state is displayed for the
CAP (all capital letters) lock key and the NUM (numbers) lock key.
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 Toolbar

 

 The Toolbar provides you with shortcut methods to configure, view, and control
System 3 operations. Use the Toolbar buttons as follows:

 Click on the “Save As” button   to save the changes to either the same file or
to a new file and/or folder.

 Click on the “Display Depths” button   to view all sensors with depth
information on selected cables in the O Graphic Display.

 Click on the “Display Headings” button   to view all sensors with heading
information on selected cables in the Graphic Display.

 Click on the “Sensor Ranges” button   to view the ranges for a single sensor in
the Graphic Display. Click on any acoustic to display all ranges for that sensor.
Click on the selected sensor a second time to turn off the range display for that
sensor. Sensor ranges can be viewed one at a time. Double-clicking on an acoustic
sensor will access that sensor’s dialog box.

 Click on the “Show All Ranges” button   to view all range information in the
Graphic Display. Press F5 to toggle to exceptions only.

 Click on the “Show All Sensors” button   to view a static display of all sensors
in the Graphic Display.

 Click on the “Dive Cables” button   to initiate the three-step command process
required to dive all streamer cables to an emergency depth. After you issue the
Emergency Dive command, a question box appears asking whether or not you
wish to proceed. A “Yes” response causes the Streamer Depth: Dive Dialog Box
to be displayed, which allows you to select the depth (if desired). Press the
“Assign” button to complete the process. Immediately following the assigning of
an emergency depth, a Multi Sensor Command: Dive the Cables Dialog Box
appears with a list of all birds affected by the command. The word “PASS” or
“FAIL” is displayed next to each bird ID as the individual bird commands are
issued. If any birds indicated “FAIL”, the streamer command can be repeated.

 Click on the “Surface Cables” button   to initiate the surfacing of all streamer
cables. After you issue the Surface Cables command, a question box appears
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asking whether or not you wish to proceed. A “Yes” response completes the
command and causes a Multi Sensor Command: Surface the Cables Dialog
Box to appear with a list of all birds affected by the command. The word “PASS”
or “FAIL” is displayed next to each bird ID as the individual bird commands are
issued. If any birds indicated “FAIL”, the streamer command can be repeated.

 Click on the “Return to Target” button   to initiate the returning of all birds to
their assigned depths (which are stored at the DMU). This command is normally
used after an Emergency Dive or Surface Cables command when the threat is
clear. After you issue the Return to Target command, a question box appears
asking whether or not you wish to proceed. A “Yes” response completes the
command and causes a Multi Sensor Command: Return to Target Depth
Dialog Box to appear with a list of all birds affected by the command. The word
“PASS” or “FAIL” is displayed next to each bird ID as the individual bird
commands are issued. If any birds indicated “FAIL”, the streamer command can
be repeated.

 Click on the “Multi Sensor Command” button   to activate a tool which allows
you to draw a box around (rubberband) a group of sensors. When the sensors are
grouped, a Multi Command Dialog Box appears. The dialog box allows you to
select from and execute the following commands: Set Bird Depth, Set Birds Fin
Angle, Set Sea State Parameters, Read Birds Voltages, Read Acoustic Voltages,
Read Serial Numbers, and Read Sensors AGCs.

 Click on the “Display Full Scale” button   to show the entire system network
in the Graphic Display.

 Click on the “Zoom Area” button   to enlarge a specified area in the Graphic
Display. Click and drag the cursor to draw a box around the area to be enlarged.

 Click on the “Copy” button   to make a copy of the text selected.

 The “Print” button   is not available in this version of System 3.

 Click on the “About” button   to access the System 3 OI Information Box.

 Click on the “Help” button   to activate the Help cursor. Position the cursor on
any item and click in order to open a popup window containing a brief description
of the item. To access the Help file for an open window or dialog box, press F1.
To access the main Help file, click on the Help / Help Topics.
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 Graphic Display
 The Graphic Display displays all vessels, platforms/lines, and sensors (acoustics,
birds, compasses, and depths) that have been created for the System 3 file in a
“bird’s-eye” view and multiple side views. Most features of the Graphic Display
are hidden and are brought to view only by clicking with your mouse on the
screen hotspots. The features of the Graphic Display are explained (each under the
action required to activate the feature) in the following sections:

 View Tool Tip

 To view a tool tip, position your cursor on a component in the Graphic Display
(but do not click the mouse button). The summary field includes the component’s
Unit ID, Serial number, the offset from the towpoint, the target depth and actual
depth, the fin angle, and the line number.

 View Streamer Cable

 To view a single cable depth display, double-click on a line in the Graphic
Display (or by clicking on Streamer / Display Depth, then double-clicking on
one of the line choices in the Select Streamer Line Dialog Box). The various
depths are color-coded according to the choices made in System Preferences
Depth Display Dialog Box (which is accessed when you click on File /
Preferences). Note that if your monitor is not using True or High Color, the
colors you select may appear differently in the displays.

 Edit Ranges

 This dialog box is accessed by clicking the “Sensor Ranges” button   on the
Toolbar, then clicking on an acoustic sensor in the Graphic Display; all ranges for
that acoustic sensor will be displayed. Double-click on a second acoustic sensor
(which is ranged to the first sensor) to access the Edit Ranges Dialog Box.  The
Edit Ranges Dialog Box can also be accessed by double-clicking on the Range
name while on the Range text page.

 Range Name is used to identify a range in the Operator Interface program when
viewing Signal Strength of Path Time displays. The range name can be any
character string up to 20 characters long and can include blank spaces and upper
or lower case letters.

 Path thresholds are entered as a scale factor index. Path 1 is the signal received by
the first CMX in the CMX pair, and Path 2 is the signal received by the second
CMX. The value entered is an index that corresponds to the threshold setting in
dB above RMS noise level. The DigiRANGE index also determines CMX
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operational mode: shallow water (reflections expected) or deep water. The
following table shows the valid indexes and their corresponding dB levels for
DigiRANGE systems.

 All units with serial numbers 7000 or greater have enhanced CFAR.  Instead of
being a fixed dB value over noise, enhanced CFAR adapts to changing noise.  The
following table gives the expected threshold settings for minimum and maximum
noise for a given CFAR index setting.

 

   Normal  Dual
Tracking

 dB Above
Noise

   -1  -11  34.5 - 16

   -2  -12  31 - 14

  Default for
offsets >1000m

 -3  -13  28 - 13

   -4  -14  24 - 12

  Default for
offsets <1000m

 -5  -15  22 - 11

   -6  -16  19 - 9

   -7  -17  16 - 7.5

   -8  -18  12 - 6

   -9  -19  8 - 4.5

   -10  -20  6 - 2.5

 

 The minimum and maximum range distances are entered in meters. The “Retry”
option (Yes/No) determines whether this range should be retried if secondary
acquisition is enabled and the primary range data was absent or unqualified. The
“Range Data Mode” field selects the type of range data qualification: two-way,
one-way (Unit 1 receive), or one-way (Unit 2 receive). Two-way range
qualification generally results in a more accurate measurement, but one-way
qualification may be appropriate if one CMX of the pair is in a high noise
environment.

 Graphic Aids Menu

 Click on the right mouse button when your cursor is positioned anywhere in the
Graphic Display (either overhead view or side view), except directly on a cable
or sensor, to view the following menu:
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 Click on Full Scale to show the entire system network in the Graphic Display.

 Click on Redraw to refresh the screen

 Click on Zoom Area to enlarge a selected area in the Graphic Display.

 Click on Color Bar to show or hide the Color Bar.

 Click on Toolbar to show or hide the Toolbar in the Main OI Window.

 Click on Status Bar to show or hide the Status Bar in the Main OI Window.

 Click on the right mouse button when you position your cursor directly on a
sensor to display a menu. The menu, which varies according to the type of sensor
selected, is identical to the menu accessed by clicking on the Diagnostic menu,
and either the Acoustic, Bird, Compass, or Depth submenu.

 Acoustic Sensor Submenu

 Right clicking on an Acoustic sensor accesses the following menu:

 

 Click on Acoustic / Battery Voltage to access the Acoustic Battery Voltage
Dialog Box. The dialog box allows you to enter the Unit ID, and read the voltage
for the specified acoustic sensor.

 Click on Acoustic / Read AGC Voltage to access the Sensor AGC Voltage
Dialog Box. The dialog box allows you to enter a Unit ID and read the voltage
present.

 Click on Acoustic / Read/Swap Serial Number to access the Read Serial
Number Dialog Box. The dialog box allows you to enter a Unit ID and read the
corresponding Serial Number. The dialog box also allows you to Swap a unit’s
Serial Number in the DMU database. Make sure the Unit ID for this Serial
Number is correct by using Assign Unit Number.
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 Click on Acoustic / Read Configuration to access the CMX Configuration
Dialog Box, which displays the CMXs internal acoustic configuration, including
transmit channel, transmit offset, receive aperture open and close times, and
aperture thresholds. The dialog box also displays the firmware version numbers of
the control processor and the digital signal processor.

 Click on Acoustic / Diagnostic Page to access the CMX Information Dialog
Box. The dialog box contains more detailed information on a specific CMX unit.
When this option is executed off-line, an option is available for downloading a
special test configuration to the selected CMX unit. This is most useful during
initial deployment, when the CMX may not have a valid configuration. After the
Diagnostic Page option is selected in off-line mode and the desired Unit ID is
entered, you can download the special configuration by pressing the Download
Diagnostic button. If the special configuration is downloaded, the previous
configuration must be re-downloaded after completing the diagnostics procedure.

 Click on Acoustic / Read Unit ID to access the Read Global ID Dialog Box.
The dialog box allows you to designate a sensor by Sensor Type, Serial Number,
and location (Platform/Line). When located, the designated sensor’s Unit ID will
be displayed.

 Click on Acoustic / Assign Unit Number to access the Assign Unit Number
Dialog Box. The dialog box allows you to assign a Unit ID to a sensor (either
Acoustic, Bird, Compass, or Depth), and assign the sensor to a specific location
(Platform/Line). The Assign Unit Number command is normally used for a
sensor not defined in the Setup file in use. Unit ID assignments made with this
option do not update the Setup file. In order to change the Unit ID of a sensor
defined in the Setup file, use the Edit menu in the Setup program. Enter the serial
number of the sensor whose unit number is to be assigned, followed by the
platform line to which the sensor is attached, then enter the desired unit number.
Or, use Swap to match the unit number to the serial number in the DMU database.
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 Bird Sensor Submenu

 Right clicking on a Bird sensor accesses the following menu:

 

 Click on Bird / Battery Voltage to access the Bird Battery Voltage Dialog Box.
The dialog box allows you to enter a Unit ID and read the current battery voltage
levels (A BANK and B BANK). When a multisensor command is used to read all
bird battery voltages (“@” for Unit ID), a prompt appears asking if the battery
voltages should be logged to a disk file. Selecting “Yes” causes a new file to be
created; the filename is constructed from the current date and time, and has the
extension “.BIR”. When the battery voltages are read, the Serial Number, Unit ID,
A and B BANK voltages, and BANK in use for each unit are written to this file.

 Click on Bird / Read AGC Voltage to access the Sensor AGC Voltage Dialog
Box. The dialog box allows you to enter a Unit ID and read the AGC voltages
measured by the bird for the high and low frequency carriers and the background
noise.

 Click on Bird / Read/Swap Serial Number to access the Read Serial Number
Dialog Box. The dialog box allows you to enter a Unit ID and read the
corresponding Serial Number. The dialog box also allows you to Swap a unit’s
Serial Number in the DMU database. Make sure the Unit ID for this Serial
Number is correct by using Assign Unit Number.

 Click on Bird / Read Depth & Temperature to access the Read Depth and
Temperature Dialog Box. The dialog box allows you to enter a Unit ID and read
depth, pressure, and temperature.

 Click on Bird / Read Heading to access the Read Heading Dialog Box. The
dialog box allows you to enter a Unit ID and read the heading for that bird.
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 Click on Bird / Calibration to access the Bird Calibration Dialog Box. The
dialog box allows you to perform a field depth calibration procedure.

 Click on Bird / Control Gains/Averaging to access the Bird Control Gains
Dialog Box. The dialog box allows you enter a Unit ID and read or assign any of
the following parameters to that bird: Depth Sample Rate, Depth Time Constant,
Heading Time Constant, Fin Angle Dead Band, Proportional Gain, Integral Gain,
Rate Gain, Control Update Rate

 Click on Bird / Compass Calibration to access the Read Compass Calibration
Dialog Box. The dialog box allows you to enter a Unit ID and review the A, B,
and C calibration coefficients of the bird’s compass.

 Click on Bird / Compass Serial Number to access the Bird Compass Serial
Number Dialog Box. The dialog box allows you to enter a Unit ID and read the
Serial Number for the compass installed in the bird.

 Click on Bird / Wing Reset/Status access the Bird Wing Status Dialog Box.
The dialog box allows you to enter a Unit ID and read the status and type of the
bird. Pressing the “Wing Reset” button causes the wings of the bird to move to a
full up position, and then return to zero degrees (level). After the wing returns to
zero, the bird will return to its previous mode of operation. In addition, a status
word is returned by the bird; this word contains the pass/fail results of several
internal diagnostic checks performed by the bird. These results are displayed in
the diagnostic window as a list of error condition messages. Refer to the Model
5000 Operation and Maintenance Manual (P/N 4200-016) for the actions to be
taken if one or more errors are indicated.

 Click on Bird / Info Page to access the Bird Information Dialog Box. The
dialog box allows you to enter a Unit ID and view a quick summary of the key
parameters that define the status of that bird. The dialog box combines diagnostic
and control information from several of the individual commands into a single
display. The display updates continually until it is exited.

 Click on Bird / Set Depth to access the Set Depth Dialog Box. The dialog box
allows you to enter a Unit ID and read the current depth of that bird. The dialog
box also allows you to assign a new depth, which updates the assigned depth
value stored in the DMU and in the bird. The assigned depth value is the depth
that a bird will go to when a Return to Target command is issued.

 Click on Bird / Set Fin to access the Set Fin Dialog Box. The dialog box allows
you to enter a Unit ID and read the current fin angle of that bird. The dialog box
also allows you to assign another fixed fin angle (-15° to +15°). This command
will take the bird out of the Depth-Keeping Mode and place it in Manual Fin
Mode. This can be seen on birds displays as a line through the bird.
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 Click on Bird / Sleep Mode to access the Set Sleep Mode Dialog Box. The
dialog box allows you to enter a Unit ID. Pressing the “Sleep Mode” button will
de-activate the bird and preserve battery power until the next communication to
the unit.

 Click on Bird / Read Unit ID to access the Read Global ID Dialog Box. The
dialog box allows you to designate a sensor by Sensor Type, Serial Number, and
location (Platform/Line). When located, the designated sensor’s Unit ID will be
displayed.

 Click on Bird / Assign Unit Number to access the Assign Unit Number Dialog
Box. The dialog box allows you to assign a Unit ID to a sensor (either Acoustic,
Bird, Compass, or Depth), and assign the sensor to a specific location
(Platform/Line). The Assign Unit Number command is normally used for a
sensor not defined in the Setup file in use. Unit ID assignments made with this
option do not update the Setup file. In order to change the Unit ID of a sensor
defined in the Setup file, use the Edit menu in the Setup program. Enter the serial
number of the sensor whose unit number is to be assigned, followed by the
platform line to which the sensor is attached, then enter the desired unit number.
Or use Swap to match units in the DMU database.

 Velocimeter Sensor Submenu

 Right clicking on a Velocimeter sensor accesses the following menu:
 

 

 

 

 

 

 

 

 Click on Diagnostic / Velocimeter / Battery Voltage to access the Velocimeter
Read Battery Voltage Dialog Box. The dialog box allows you to enter a Unit ID
and read the current battery voltage levels (A BANK and B BANK). When a
multisensor command is used to read all velocimeter battery voltages (“@” for
Unit ID), a prompt appears asking if the battery voltages should be logged to a
disk file. Selecting “Yes” causes a new file to be created; the filename is
constructed from the current date and time, and has the extension “.BIR”. When
the battery voltages are read, the Serial Number, Unit ID, A and B BANK
voltages, and BANK in use for each unit are written to this file.
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 Click on Diagnostic / Velocimeter / Read AGC Voltage to access the Sensor
AGC Voltage Dialog Box. The dialog box allows you to enter a Unit ID and read
the voltage present.

 Click on Diagnostic / Velocimeter / Read/Swap Serial Number to access the
Read Serial Number Dialog Box. The dialog box allows you to enter a Unit ID
and read the corresponding Serial Number. The dialog box also allows you to
Swap a unit’s Serial Number.

 Click on Diagnostic / Velocimeter / Read/Write Sample Rate to access the
Read/Write Sample Rate Dialog Box.  The dialog box allows you to enter a Unit
ID and read the currently selected sample rate.  The dialog box also allows you to
assign a new sample rate.  Sample rate is entered in shot cycle increments.

 Click on Diagnostic / Velocimeter / Sensor Serial Number to access the
Velocimeter’s Internal Sensor Serial Number Dialog Box. The dialog box
allows you to enter a Unit ID and read the Serial Number and status information
for the sensor installed in that velocimeter.

 Click on Diagnostic / Velocimeter / Sleep Mode to access the Set Sleep Mode
Dialog Box. The dialog box allows you to enter a Unit ID. Pressing the “Sleep
Mode” button will de-activate the velocimeter and preserve battery power until
the next communication to the unit.

 Click on Diagnostic / Velocimeter / Read Unit ID to access the Read Global ID
Dialog Box. The dialog box allows you to designate a sensor by Sensor Type,
Serial Number, and location (Platform/Line). After the sensor is polled, the
designated sensor’s Unit ID will be displayed.

 Click on Diagnostic / Velocimeter / Assign Unit Number to access the Assign
Unit Number Dialog Box. The dialog box allows you to assign a Unit ID to a
sensor (either Acoustic, Bird, Compass, Depth, or Velocimeter), and assign the
sensor to a specific location (Platform/Line). The Assign Unit Number command
is normally used for a sensor not defined in the Setup file in use. This option
should only be used for sensors communicating over a dedicated test line that is
defined in the Setup file. Unit ID assignments made with this option do not update
the Setup file. In order to change the Unit ID of a sensor defined in the Setup file,
use the Edit menu in the Setup program. Enter the serial number of the sensor
whose unit number is to be assigned, followed by the platform line to which the
sensor is attached, then enter the desired unit number.

 Click on Diagnostic / Velocimeter / Read Meas./Reset Sync to access the Read
Measured Data/Reset Sync Dialog Box.  The dialog box allows you to enter a
Unit ID and read the currently measured speed-of-sound.  The dialog box also
allows you to activate a Reset Sync Counter by checking the box.  When
activated, the velocimeter will reset its sync counter at the same time as other
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velocimeters in the system (assuming the command is a multisensor command
addressed to all units).  This feature ensures that the velocimeters in the system
are acquiring speed-of-sound measurements simultaneously.

 Click on Diagnostic / Velocimeter / Firmware Versions to access the Firmware
Versions Dialog Box. The dialog box allows you to read the version of the
firmware in the internal sensor unit and in the velocimeter control unit.

 Compass Sensor Submenu

 Right clicking on a Compass sensor accesses the following menu:

 

 Click on Compass / Read Unit Number to access the Read Global ID Dialog
Box. The dialog box allows you to designate a sensor by Sensor Type, Serial
Number, and location (Platform/Line). When located, the designated sensor’s Unit
ID will be displayed.

 Click on Compass / Read/Swap Serial Number to access the Read Serial
Number Dialog Box. The dialog box allows you to enter a Unit ID and read the
corresponding Serial Number. The dialog box also allows you to Swap a unit’s
Serial Number. Make sure the Unit ID for this Serial Number is correct by using
Assign Unit Number.

 Click on Compass / Review Calibration to access the Read Compass
Calibration Dialog Box. The dialog box allows you to enter a Unit ID and review
the A, B, and C calibration coefficients of the bird’s compass.

 Click on Compass / Read Heading to access the Read Heading Dialog Box.
The dialog box allows you to enter a Unit ID and read the heading for that bird.

 Click on Compass / Averaging to access the Heading Control Gains Dialog
Box. The dialog box allows you to enter a Unit ID and read or modify the heading
sample rate and averaging time constant for that compass.

 Click on Compass / Node Voltage to access the Read Node Voltage Dialog
Box. The dialog box allows you to enter a Unit ID and read the node voltage for
that compass.
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 Click on Compass / Read AGC Voltage to access the Sensor AGC Voltage
Dialog Box. The dialog box allows you to enter a Unit ID and read the voltage
present.

 Click on Compass / High/Low Power to access the Set Power Mode Dialog
Box. The dialog box allows you to enter a Unit ID and place the sensor in low
power mode, which permits more in-streamer devices to be served by the Line
Power Unit.

 Click on Compass / Assign Unit Number to access the Assign Unit Number
Dialog Box. The dialog box allows you to assign a Unit ID to a sensor (either
Acoustic, Bird, Compass, or Depth), and assign the sensor to a specific location
(Platform/Line). The Assign Unit Number command is normally used for a
sensor not defined in the Setup file in use. This option should only be used for
sensors communicating over a dedicated test line that is defined in the Setup file.
Unit ID assignments made with this option do not update the Setup file. In order
to change the Unit ID of a sensor defined in the Setup file, use the Edit menu in
the Setup program. Enter the serial number of the sensor whose unit number is to
be assigned, followed by the platform line to which the sensor is attached, then
enter the desired unit number.

 Depth Sensor Submenu

 Right clicking on a Depth sensor accesses the following menu:

 

 Click on Depth / Read Unit Number to access the Read Global ID Dialog Box.
The dialog box allows you to designate a sensor by Sensor Type, Serial Number,
and location (Platform/Line). When located, the designated sensor’s Unit ID will
be displayed.

 Click on Depth / Read/Swap Serial Number to access the Read Serial Number
Dialog Box. The dialog box allows you to enter a Unit ID and read the
corresponding Serial Number. The dialog box also allows you to Swap a unit’s
Serial Number. Make sure the Unit ID for this Serial Number is correct by using
Assign Unit Number.



 Section VI   Operator Interface Program

  241
 

 Click on Depth / Read Depth & Temperature to access the Read Depth and
Temperature Dialog Box. The dialog box allows you to enter a Unit ID and read
or set the depth, pressure, and temperature calibration coefficients for that depth
sensor.

 Click on Depth / Calibration to access the Depth Calibration Dialog Box. The
dialog box allows you to enter a Unit ID and read or modify the depth slope, depth
offset, and temperature offset for that depth sensor.

 Click on Depth / Averaging to access the Depth Control Gains Dialog Box. The
dialog box allows you to enter a Unit ID and read or modify the sample rate and
averaging time constant for that depth sensor.

 Click on Depth / Node Voltage to access the Read Node Voltage Dialog Box.
The dialog box allows you to enter a Unit ID and read the node voltage for that
depth sensor.

 Click on Depth / Read AGC Voltage to access the Sensor AGC Voltage Dialog
Box. The dialog box allows you to enter a Unit ID and read the voltage present.

 Click on Depth / High/Low Power to access the Set Power Mode Dialog Box.
The dialog box allows you to enter a Unit ID and place the sensor in low power
mode, which permits more in-streamer devices to be served by the Line Power
Unit.

 Click on Depth / Assign Unit Number to access the Assign Unit Number
Dialog Box. The dialog box allows you to assign a Unit ID to a sensor (either
Acoustic, Bird, Compass, or Depth), and assign the sensor to a specific location
(Platform/Line). The Assign Unit Number command is normally used for a
sensor not defined in the Setup file in use. This option should only be used for
sensors communicating over a dedicated test line that is defined in the Setup file.
Unit ID assignments made with this option do not update the Setup file. In order
to change the Unit ID of a sensor defined in the Setup file, use the Edit menu in
the Setup program. Enter the serial number of the sensor whose unit number is to
be assigned, followed by the platform line to which the sensor is attached, then
enter the desired unit number.
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  OPERATOR INTERFACE MENUS

 The File Menu

 Connect Operator Interface Computer to DMU

 The File / Connect command connects the Operator Interface computer with the
Data Management Unit and receive the current configuration of the DMU.

 Open Existing Setup File

 The File / Open command opens an existing System 3 Setup configuration file.

 The File / 1, 2, 3, or 4 File Name command allows you to reopen one of the last
four previously opened files.

 Close File

 The File / Close command closes the active or open System 3 file.

 Save File

 The File / Save command saves changes made to the open System 3 file. Changes
are saved to the OI hard drive under the same file name that appears in the Main
Title Bar.

 The File / Save As command saves changes made to the open System 3 file.
Changes can be saved to the OI hard drive under a new file name and/or a new
folder.

 Print File

 The File / Print command is not available in this release of System 3. However,
you can print Help topics from the Contents window in the Help file.

 The Print Preview command displays the file on the screen as it would appear
printed.

 The Print Setup command selects a printer and printer connection.
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 Preferences

 The File / Preferences command accesses the System Preferences Dialog Box
(which is tabbed into two sections: the System Preferences for Depth Displays
Dialog Box and the System Preferences for Ranges/Paths/Acoustics Dialog
Box. The dialog box allows you to select the default colors used in the Graphic
Display for bird and acoustic settings. These colors, once set, are displayed in the
Color Bar. Note that if your monitor is not using True or High Color, the colors
you select may appear differently in the displays.

 Sea States

 The Sea States are bird control gains settings which affect the response of the
birds. Select the Sea State that corresponds to your current operating environment.
You can set up to five Sea States. By setting the Sea States in advance, you can
instantly change how the birds are responding as you encounter different operating
conditions.

 The File / Sea States command accesses the Sea States Listing Dialog Box,
which (with the Enter New Sea State Name Dialog Box and Edit Sea State
Dialog Box) allows you to add, edit, or remove up to five sets of sea state
parameters.

 Sea States Listing Dialog Box

 This dialog box lists all designated sea states and allows you to add, edit, and
remove sea states. Up to five sea states can be specified.

 When you select the “Add” button, the Enter the New Sea State Name Dialog
Box appears. Enter the name of the new sea state and press the OK button. When
you press “OK,” you are returned to the Sea States Listing Dialog Box.

 To define the parameters of a sea state, highlight the name of the sea state in the
Sea States Listing Dialog Box, and press the ‘Edit” button. When you press the
“Edit” button, the Edit Sea States Dialog Box appears. Complete the fields and
press the “OK” button. When you press “OK,” you are returned to the Sea States
Listing Dialog Box.

 To remove a sea state from the listing, highlight the name and press the “Remove”
button.

 

 The “Remove” button is present only when a sea state has been
specified.
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 Enter New Sea State Name Dialog Box

 This dialog box is accessed by clicking on the “Add” button in the Sea States
Listing Dialog Box. The dialog box allows you to name a new sea states listing.

 Edit Sea States Dialog Box

 This dialog box is accessed by highlighting a sea state and clicking on the “Edit”
button in the Sea States Listing Dialog Box. The dialog box allows you to set the
gain parameters of the selected sea state.

 Send File

 The File / Send command sends the active file through electronic mail.

 Exit Operator Interface Program

 The File / Exit command exits the System 3 Operator Interface Program.
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 The View Menu

 View Acoustic Data

 The View / Acoustics Data command accesses a table which lists acoustic units
text data.

 View Depth Data

 The View / Depth Data command accesses a table which lists the unit number,
depth, and fin angle for all birds on each line.

 View Graphic Data

 The View / Graphic Data command accesses a submenu which contains the
commands Create View, Lines Display, and Display Type.

 The View / Graphic Data / Create View command creates a new default graphic
view.

 The View / Graphic Data / Lines Display command accesses the Select Lines
for Display Dialog Box. Select the lines that you want to be displayed in the
currently selected Graphic Display by using the cursor to check or un-check each
line option.

 The View / Graphic Data / Display Type command accesses another submenu
which contains the commands Sensor Headings, Sensor Depths, Sensor
Ranges, All Ranges, and All Sensors.

 The View / Graphic Data / Display Type / Sensor Headings command shows
all sensors with heading information in the Graphic Display.

 The View / Graphic Data / Display Type / Sensor Depths command shows all
sensors with depth information in the Graphic Display.

 The View / Graphic Data / Display Type / Sensor Ranges command displays a
view containing all acoustic units, which is used to show the ranges for a single
sensor in the Graphic Display. Click on any acoustic to display all ranges for that
sensor. Click on the selected sensor a second time to turn off the range display for
that sensor. Sensor ranges can be viewed one at a time. Double-clicking on an
acoustic sensor will access that sensor’s dialog box.

 The View / Graphic Data / Display Type / All Ranges command shows all
range information in the Graphic Display.



 System 3 (Version 4.0) User’s Manual

  246
 

 The View / Graphic Data / Display Type / All Sensors command shows a static
display of all sensors in the Graphic Display.

 View Heading Data

 The View / Heading Data command shows a table which lists the unit number
and heading for all birds on each line.

 View Velocimeter Data

 The View / Velocimeter Data command shows a table which lists the unit
number and sound speed for all velocimeters on each line.

 View Range/Path Data

 The View / Range/Path Data command accesses a submenu which displays the
commands Create View and Sort by Completion.

 The View / Range/Path Data / Create View command shows a table which lists
ranges and paths text data.

 The View / Range/Path Data / Sort by Completion command sorts the ranges
and paths text data in the order of completion.

 View Lines

 The View / Show All Singles command displays all single lines in the Graphic
Display.

 View Sensors

 The View / Acoustics command is a switch that allows you to show or hide the
acoustics in the Graphic Display.

 The View / Birds command is a switch that allows you to show or hide the birds
in the Graphic Display.

 The View / Compasses command is a switch that allows you to show or hide the
compasses in the Graphic Display.

 The View / Depths command is a switch that allows you to show or hide the
depths in the Graphic Display.
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 View Bars

 The View / Color Bar command is a switch that allows you to show or hide the
Color Bar in the main window. The Color Bar is a color legend for all pre-set
display parameters. The colors are defined in the System Preferences Dialog
Box. (Note that if your monitor is not using True or High Color, the colors you
select may appear differently in the displays.).To access the System Preferences
Dialog Box, click on the  File / Preferences command. For more information on
the Color Bar, see the Color Bar explanation under the System 3 Operator
Interface Window heading in this Section.

 The View / Toolbar command is a switch that allows you to show or hide the
Toolbar in the main window.  For detailed information on the toolbar, see the
Toolbar explanation under the System 3 Operator Interface Window heading in
this Section.

 The View / Status Bar command is a switch that allows you to show or hide the
Status Bar in the main window.  For detailed information on the status bar, see the
Status Bar explanation under the System 3 Operator Interface Window heading in
this Section.

 Make Copy

 The View / Copy command makes a copy of the text selected.



 System 3 (Version 4.0) User’s Manual

  248
 

 The Streamer Menu

 

 The Streamer menu allows you to control
the depth of the streamer cables. Selection
of any one of these options causes the
program to send the appropriate command
to the DMU where it is translated into a
series of sensor commands for
transmission to the birds.

 

 

 None of the streamer control commands alter the active assigned target
depth of a bird in the DMU database. This assigned depth is defined
initially in The Setup program and is stored at the DMU.

 Emergency Dive Streamer Cables

 The Streamer / Emergency Dive command initiates the three-step command
process required to dive all streamer cables to an emergency depth. After you
issue the Emergency Dive command, a question box appears asking whether or
not you wish to proceed. A “Yes” response causes the Streamer Depth: Dive
Dialog Box to be displayed, which allows you to select the depth (if desired).
Press the “Assign” button to complete the process. Immediately following the
assigning of an emergency depth, a Multi Sensor Command: Dive the Cables
Dialog Box appears with a list of all birds affected by the command. The word
“PASS” or “FAIL” is displayed next to each bird ID as the individual bird
commands are issued. If any birds indicated “FAIL”, the streamer command can
be repeated.

 This command is accessed in either of two ways:

• Click on the “Dive Cables” button   .

• Click on Streamer / Emergency Dive.

 Surface Streamer Cables

 The Streamer / Surface Cables command initiates the surfacing of all streamer
cables. After you issue the Surface Cables command, a question box appears
asking whether or not you wish to proceed. A “Yes” response completes the
command and causes a Multi Sensor Command: Surface the Cables Dialog
Box to appear with a list of all birds affected by the command. The word “PASS”
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or “FAIL” is displayed next to each bird ID as the individual bird commands are
issued. If any birds indicated “FAIL”, the streamer command can be repeated.

 This command is accessed in either of two ways:

• Click on the “Surface Cables” button   .

• Click on Streamer / Surface Cables.

 Maintain Streamer Cables Depth

 The Streamer / Maintain Depth command assigns the specified depth to all birds
on the selected streamer line(s) without altering the assigned target depths stored
at the DMU. A Streamer Depth: Maintain Dialog Box appears, which allows
you select a line (or all streamer lines) and assign a depth.

 Return Streamer Cables to Target

 The Streamer / Return to Target command initiates the returning of all birds to
their assigned depths (which are stored at the DMU). This command is normally
used after an Emergency Dive or Surface Cables command when the threat is
clear. After you issue the Return to Target command, a question box appears
asking whether or not you wish to proceed. A “Yes” response completes the
command and causes a Multi Sensor Command: Return to Target Depth
Dialog Box to appear with a list of all birds affected by the command. The word
“PASS” or “FAIL” is displayed next to each bird ID as the individual bird
commands are issued. If any birds indicated “FAIL”, the streamer command can
be repeated.

 This command is accessed in either of two ways:

• Click on the “Back to Target” button   .

• Click on Streamer / Return to Target.

 View Compass Birds Log

 The Streamer / Compass Birds Log command accesses the Multi Sensor
Diagnostic: Compass Birds Log Command Dialog Box, which includes the
compass birds’ Serial numbers, headings, sample rates, time constants, and A, B,
and C calibration coefficients (for the compasses).



 System 3 (Version 4.0) User’s Manual

  250
 

 View Streamer Cable Depth

 The Streamer / Depth Display command accesses the Select Streamer Line
Dialog Box. Double-click on the Line which you want to view as a single sensor
depth in the Graphic Display.
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 The Diagnostic Menu

 

 The Diagnostic menu options allow you to execute
a variety of sensor diagnostic commands. Some of
these commands can be executed either during
normal data acquisition (on-line) or with data
acquisition suspended (off-line). Other commands
can be executed off-line only, due to their potential
adverse effect on the data collection process.

 Commands above the separator bar are commands
that are common to all sensor types.

 

 Read AGC Voltage

 The Diagnostic / Read AGC Voltage command accesses the Sensor AGC
Voltage Dialog Box. The dialog box allows you to enter a Unit ID and read the
voltage present for any type unit.

 Read/Swap Serial Number

 The Diagnostic / Read/Swap Serial Number command accesses the Read Serial
Number Dialog Box.

 Read Serial Number Dialog Box

 The Read Serial Number Dialog Box allows you to enter a Unit ID and read the
corresponding Serial Number. The dialog box also allows you to Swap a unit’s
Serial Number, which updates the Setup database file with the new serial number
(the serial number in the external device cannot be changed).

 Swap Serial Number Dialog Box

 This dialog is accessed by clicking on the “Swap” button in the Read Serial
Number Dialog Box. The dialog box reports the assigned Serial number (from
the Setup file) and the reported Serial number (read from the device) for the
device selected, and allows you to update (swap) the currently assigned serial
number with the one reported by the device.

 Assign Unit Number

 The Diagnostic / Assign Unit Number command accesses the Assign Unit
Number Dialog Box. The dialog box allows you to assign a Unit ID to a sensor
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(either Acoustic, Bird, Compass, or Depth), and assign the sensor to a specific
location (Platform/Line). The Assign Unit Number command is normally used
for a sensor not defined in the Setup file in use. Unit ID assignments made with
this option do not update the Setup database file; they simply load a new unit
address into the sensor for use in subsequent communications with that sensor.
Enter the serial number of the sensor whose unit number is to be assigned,
followed by the platform line to which the sensor is attached, then enter the
desired unit number. Or use Swap to match units in the DMU database.

 Read Unit Number

 The Diagnostic / Read Unit ID command accesses the Read Global ID Dialog
Box. The dialog box allows you to designate a sensor by Sensor Type, Serial
Number, and location (Platform/Line). When located, the designated sensor’s Unit
ID will be displayed.

 Acoustic Diagnostics

 The Diagnostic / Acoustic / Battery Voltage command accesses the Acoustic
Battery Voltage Dialog Box. The dialog box allows you to enter the Unit ID, and
read the voltage for the specified acoustic sensor.  The Acoustic Mode must be
ON for this command to function.

 The Diagnostic / Acoustic / Read AGC Voltage command accesses the Sensor
AGC Voltage Dialog Box. The dialog box allows you to enter a Unit ID and read
the voltage present.

 The Diagnostic / Acoustic / Read/Swap Serial Number command accesses the
Read Serial Number Dialog Box. The dialog box allows you to enter a Unit ID
and read the corresponding Serial Number. The dialog box also allows you to
Swap a unit’s Serial Number. Make sure the Unit ID for this Serial Number is
correct by using the Assign Unit Number command.

 The Diagnostic / Acoustic / Read Configuration command accesses the CMX
Configuration Dialog Box, which displays the CMXs internal acoustic
configuration, including transmit channel, transmit offset, receive aperture open
and close times, and aperture thresholds. The dialog box also displays the
firmware version numbers of the control processor and the digital signal
processor.

 The Diagnostic / Acoustic / Diagnostic Page command accesses the CMX
Information Dialog Box. The dialog box contains more detailed information on a
specific CMX unit. When this option is executed off-line, an option is available
for downloading a special test configuration to the selected CMX unit. This is
most useful during initial deployment, when the CMX may not have a valid
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configuration. After the Diagnostic Page option is selected in off-line mode and
the desired Unit ID is entered, you can download the special configuration by
pressing the Download Diagnostic button. If the special configuration is
downloaded, the previous configuration must be re-downloaded after completing
the diagnostics procedure.

 The Diagnostic / Acoustic / Read Unit ID command accesses the Read Global
ID Dialog Box. The dialog box allows you to designate a sensor by Sensor Type,
Serial Number, and location (Platform/Line). When located, the designated
sensor’s Unit ID will be displayed.

 The Diagnostic / Acoustic / Assign Unit Number command accesses the Assign
Unit Number Dialog Box. The dialog box allows you to assign a Unit ID to a
sensor (either Acoustic, Bird, Compass, or Depth), and assign the sensor to a
specific location (Platform/Line). The Assign Unit Number command is
normally used for a sensor not defined in the Setup file in use. This option should
only be used for sensors communicating over a dedicated test line that is defined
in the Setup file. Unit ID assignments made with this option do not update the
Setup file. In order to change the Unit ID of a sensor defined in the Setup file, use
the Edit menu in the Setup program. Enter the serial number of the sensor whose
unit number is to be assigned, followed by the platform line to which the sensor is
attached, then enter the desired unit number.

 Bird Diagnostics

 The Diagnostic / Bird / Battery Voltage command accesses the Bird Battery
Voltage Dialog Box. The dialog box allows you to enter a Unit ID and read the
current battery voltage levels (A BANK and B BANK). When a multisensor
command is used to read all bird battery voltages (“@” for Unit ID), a prompt
appears asking if the battery voltages should be logged to a disk file. Selecting
“Yes” causes a new file to be created; the filename is constructed from the current
date and time, and has the extension “.BIR”. When the battery voltages are read,
the Serial Number, Unit ID, A and B BANK voltages, and BANK in use for each
unit are written to this file.

 The Diagnostic / Bird / Read AGC Voltage command accesses the Sensor AGC
Voltage Dialog Box. The dialog box allows you to enter a Unit ID and read the
AGC voltages measured by the bird for the high and low frequency carriers and
the background noise.

 The Diagnostic / Bird / Read/Swap Serial Number command accesses the Read
Serial Number Dialog Box. The dialog box allows you to enter a Unit ID and
read the corresponding Serial Number. The dialog box also allows you to Swap a
unit’s Serial Number. Make sure the Unit ID for this Serial Number is correct by
using Assign Unit Number.
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 The Diagnostic / Bird / Read Depth & Temperature command accesses the
Read Depth and Temperature Dialog Box. The dialog box allows you to enter a
Unit ID and read or set the depth, pressure, and temperature calibration
coefficients for that bird.

 The Diagnostic / Bird / Read Heading command accesses the Read Heading
Dialog Box. The dialog box allows you to enter a Unit ID and read the heading
for that bird.

 The Diagnostic / Bird / Calibration command accesses the Bird Calibration
Dialog Box. The dialog box allows you to perform a field depth calibration
procedure.

 Bird Calibration Dialog Box

 The dialog box allows you to perform a field depth calibration procedure.

 

 A regulated air source capable of at least 75 psi is required. Use of a
precision manometer (to allow measurement of absolute pressure) is
recommended. A depth calibration kit which includes a manometer can
be ordered from DigiCOURSE. An analog gauge may be used instead,
but it does not provide the same degree of accuracy as a factory
calibration. Refer to the Model 5000 Operation and Maintenance
Manual for complete instructions on connection of all equipment.

 To perform the calibration, follow the steps below:

 1. Select the Measuring Device (either the Manometer or Analog Gauge).
Ensure that your choice corresponds to the measurement device in use.
Note the maximum pressure limit.

 2. Enter the Unit ID.

 3. Select the “Full Calibration” button.

 4. Select the 5000 type of bird.

 5. The Operator Interface will read the current values, store them, then
zero them.

 6. Press the “Read” button in the Atmospheric values section. The display
shows the ambient temperature in degrees Celsius, the (low) pressure, and
the sensor count, which is the bird’s current uncalibrated depth in meters.
The Atmospheric values are continuously updated.

 7. If a precision manometer is in use, vent the manometer to the
atmosphere, wait for the depth reading to stabilize, and then enter the
displayed atmospheric pressure value. If an analog gauge is being used,
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vent the bird transducer to atmosphere and wait for the depth reading to
stabilize.

 8. Press the “Read” button in the Apply pressure section. The display
shows the bird transducer (high) pressure.

 9. Pressurize the transducer as close as possible to this value, then enter
the displayed value for the applied pressure.

 10. View the current calibration coefficients in the Calculations section
again for the Depth Slope, Depth Offset, and Temperature Offset. The
New column displays the calibration coefficients just computed; the
Current column displays the coefficients in effect prior to starting the
calibration procedure; and the Input column displays the coefficients
currently stored in the bird.

 11. When you close the Window, all values not affected by the re-
calibration will be restored.

 

 If the newly computed coefficients fall outside acceptable bounds, the
system will not allow the erroneous coefficients to be downloaded. If this
occurs, either restore the original coefficients or abort and repeat the
calibration procedure.

 The Diagnostic / Bird / Control Gains/Averaging command accesses the Bird
Control Gains Dialog Box. The dialog box allows you enter a Unit ID and read
or assign any of the following parameters to that bird:

• Depth Sample Rate

• Depth Time Constant

• Heading Time Constant

• Fin Angle Dead Band

• Proportional Gain

• Integral Gain

• Rate Gain

• Control Update Rate

 The Diagnostic / Bird / Compass Calibration command accesses the Read
Compass Calibration Dialog Box. The dialog box allows you to enter a Unit ID
and review the A, B, and C calibration coefficients of the bird’s compass.

 The Diagnostic / Bird / Compass Serial Number command accesses the Bird
Compass Serial Number Dialog Box. The dialog box allows you to enter a Unit
ID and read the Serial Number for the compass installed in the bird.
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 The Diagnostic / Bird / Wing Reset/Status command accesses the Bird Wing
Status Dialog Box. The dialog box allows you to enter a Unit ID and read the
status and type of the bird. Pressing the “Wing Reset” button causes the wings of
the bird to move to a full up position, and then return to zero degrees (level). After
the wing returns to zero, the bird will return to its previous mode of operation. In
addition, a status word is returned by the bird; this word contains the pass/fail
results of several internal diagnostic checks performed by the bird. These results
are displayed in the diagnostic window as a list of error condition messages. Refer
to the Model 5000 Operation and Maintenance Manual (P/N 4200-016) for the
actions to be taken if one or more errors are indicated.

 The Diagnostic / Bird / Info Page command accesses the Bird Information
Dialog Box. The dialog box allows you to enter a Unit ID and view a quick
summary of the key parameters that define the status of that bird. The dialog box
combines diagnostic and control information from several of the individual
commands into a single display. The display updates continually until it is exited.

 The Diagnostic / Bird / Set Depth command accesses the Set Depth Dialog Box.
The dialog box allows you to enter a Unit ID and read the current depth of that
bird. The dialog box also allows you to assign a new depth, which updates the
assigned depth value stored in the DMU. The assigned depth value is the depth
that a bird will go to when a Return to Target command is issued.

 The Diagnostic / Bird / Set Fin command accesses the Set Fin Dialog Box. The
dialog box allows you to enter a Unit ID and read the current fin angle of that bird.
The dialog box also allows you to assign another fixed fin angle (-15° to +15°).
This command will take the bird out of the Depth-Keeping Mode.

 The Diagnostic / Bird / Sleep Mode command accesses the Set Sleep Mode
Dialog Box. The dialog box allows you to enter a Unit ID and read the current
status of that bird. Pressing the “Sleep Mode” button will de-activate the bird and
preserve battery power.

 The Diagnostic / Bird / Read Unit ID command accesses the Read Global ID
Dialog Box. The dialog box allows you to designate a sensor by Sensor Type,
Serial Number, and location (Platform/Line). When located, the designated
sensor’s Unit ID will be displayed.

 The Diagnostic / Bird / Assign Unit Number command accesses the Assign
Unit Number dialog box. The dialog box allows you to assign a Unit ID to a
sensor (either Acoustic, Bird, Compass, or Depth), and assign the sensor to a
specific location (Platform/Line). The Assign Unit Number command is
normally used for a sensor not defined in the Setup file in use. This option should
only be used for sensors communicating over a dedicated test line that is defined
in the Setup file. Unit ID assignments made with this option do not update the
Setup file. In order to change the Unit ID of a sensor defined in the Setup file, use
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the Edit menu in the Setup program. Enter the serial number of the sensor whose
unit number is to be assigned, followed by the platform line to which the sensor is
attached, then enter the desired unit number.

 Velocimeter Diagnostics

 The Diagnostic / Velocimeter / Battery Voltage command accesses the
Velocimeter Read Battery Voltage Dialog Box. The dialog box allows you to
enter a Unit ID and read the current battery voltage levels (A BANK and B
BANK). When a multisensor command is used to read all velocimeter battery
voltages (“@” for Unit ID), a prompt appears asking if the battery voltages should
be logged to a disk file. Selecting “Yes” causes a new file to be created; the
filename is constructed from the current date and time, and has the extension
“.BIR”. When the battery voltages are read, the Serial Number, Unit ID, A and B
BANK voltages, and BANK in use for each unit are written to this file.

 The Diagnostic / Velocimeter / Read AGC Voltage command accesses the
Sensor AGC Voltage Dialog Box. The dialog box allows you to enter a Unit ID
and read the voltage present.

 The Diagnostic / Velocimeter / Read/Swap Serial Number command accesses
the Read Serial Number Dialog Box. The dialog box allows you to enter a Unit
ID and read the corresponding Serial Number. The dialog box also allows you to
Swap a unit’s Serial Number.

 The Diagnostic / Velocimeter / Read/Write Sample Rate command accesses the
Read/Write Sample Rate Dialog Box.  The dialog box allows you to enter a Unit
ID and read the currently selected sample rate.  The dialog box also allows you to
assign a new sample rate.  Sample rate is entered in shot cycle increments (e.g., a
value of 6 means take a new sample every 6th shot cycle).

 The Diagnostic / Velocimeter / Serial Number command accesses the
Velocimeter’s Internal Sensor Serial Number Dialog Box. The dialog box
allows you to enter a Unit ID and read the Serial Number and status information
for the sensor installed in that velocimeter.

 The Diagnostic / Velocimeter / Sleep Mode command accesses the Set Sleep
Mode Dialog Box. The dialog box allows you to enter a Unit ID. Pressing the
“Sleep Mode” button will de-activate the velocimeter and preserve battery power
until the next communication to the unit.

 The Diagnostic / Velocimeter / Read Meas./Reset Sync command accesses the
Read Measured Data/Reset Sync Dialog Box.  The dialog box allows you to enter
a Unit ID and read the currently measured speed-of-sound.  The dialog box also
allows you to activate a Reset Sync Counter by checking the box.  When
activated, the velocimeter will reset its sync counter at the same time as other
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velocimeters in the system (assuming the command is a multisensor command
addressed to all units).  This feature ensures that the velocimeters in the system
are acquiring speed-of-sound measurements simultaneously.

 The Diagnostic / Velocimeter / Firmware Versions command accesses the
Firmware Version Dialog Box.  This dialog box allows you to enter a Unit ID and
read the version number for the firmware installed in the measurement sensor and
in the velocimeter’s control unit.

 The Diagnostic / Velocimeter / Read Unit ID command accesses the Read
Global ID Dialog Box. The dialog box allows you to designate a sensor by
Sensor Type, Serial Number, and location (Platform/Line). When located, the
designated sensor’s Unit ID will be displayed.

 The Diagnostic / Velocimeter / Assign Unit Number command accesses the
Assign Unit Number Dialog Box. The dialog box allows you to assign a Unit ID
to a sensor (either Acoustic, Bird, Compass, Depth, or Velocimeter), and assign
the sensor to a specific location (Platform/Line). The Assign Unit Number
command is normally used for a sensor not defined in the Setup file in use. This
option should only be used for sensors communicating over a dedicated test line
that is defined in the Setup file. Unit ID assignments made with this option do not
update the Setup file. In order to change the Unit ID of a sensor defined in the
Setup file, use the Edit menu in the Setup program. Enter the serial number of the
sensor whose unit number is to be assigned, followed by the platform line to
which the sensor is attached, then enter the desired unit number.

 

 In-Streamer Compass Diagnostics

 The Diagnostic / Compass / Read Unit Number command accesses the Read
Global ID Dialog Box. The dialog box allows you to designate a sensor by
Sensor Type, Serial Number, and location (Platform/Line). When located, the
designated sensor’s Unit ID will be displayed.

 The Diagnostic / Compass / Read/Swap Serial Number command accesses the
Read Serial Number Dialog Box. The dialog box allows you to enter a Unit ID
and read the corresponding Serial Number. The dialog box also allows you to
Swap a unit’s Serial Number. Make sure the Unit ID for this Serial Number is
correct by using Assign Unit Number.

 The Diagnostic / Compass / Review Calibration command accesses the Read
Compass Calibration Dialog Box. The dialog box allows you to enter a Unit ID
and review the A, B, and C calibration coefficients of the bird’s compass.
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 The Diagnostic / Compass / Read Heading command accesses the Read
Heading Dialog Box. The dialog box allows you to enter a Unit ID and read the
heading for that bird.

 The Diagnostic / Compass / Averaging command accesses the Heading Control
Gains Dialog Box. The dialog box allows you to enter a Unit ID and read or
modify the heading sample rate and averaging time constant for that compass.

 The Diagnostic / Compass / Node Voltage command accesses the Read Node
Voltage Dialog Box. The dialog box allows you to enter a Unit ID and read the
node voltage for that compass.

 The Diagnostic / Compass / Read AGC Voltage command accesses the Sensor
AGC Voltage Dialog Box. The dialog box allows you to enter a Unit ID and read
the voltage present.

 The Diagnostic / Compass / High/Low Power command accesses the Set Power
Mode Dialog Box. The dialog box allows you to enter a Unit ID and place the
sensor in low power mode, which permits more in-streamer devices to be served
by the Line Power Unit.

 The Diagnostic / Compass / Assign Unit Number command accesses the Assign
Unit Number Dialog Box. The dialog box allows you to assign a Unit ID to a
sensor (either Acoustic, Bird, Compass, or Depth), and assign the sensor to a
specific location (Platform/Line). The Assign Unit Number command is
normally used for a sensor not defined in the Setup file in use. This option should
only be used for sensors communicating over a dedicated test line that is defined
in the Setup file. Unit ID assignments made with this option do not update the
Setup file. In order to change the Unit ID of a sensor defined in the Setup file, use
the Edit menu in the Setup program. Enter the serial number of the sensor whose
unit number is to be assigned, followed by the platform line to which the sensor is
attached, then enter the desired unit number.

 In-Streamer Depth Sensor Diagnostics

 The Diagnostic / Depth / Read Unit Number command accesses the Read
Global ID Dialog Box. The dialog box allows you to designate a sensor by
Sensor Type, Serial Number, and location (Platform/Line). When located, the
designated sensor’s Unit ID will be displayed.

 The Diagnostic / Depth / Read/Swap Serial Number command accesses the
Read Serial Number Dialog Box. The dialog box allows you to enter a Unit ID
and read the corresponding Serial Number. The dialog box also allows you to
Swap a unit’s Serial Number. Make sure the Unit ID for this Serial Number is
correct by using Assign Unit Number.
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 The Diagnostic / Depth / Read Depth & Temperature command accesses the
Read Depth and Temperature Dialog Box. The dialog box allows you to enter a
Unit ID and read or set the depth, pressure, and temperature calibration
coefficients for that depth sensor.

 The Diagnostic / Depth / Calibration command accesses the Depth Calibration
Dialog Box. The dialog box allows you to enter a Unit ID and read or modify the
depth slope, depth offset, and temperature offset for that depth sensor.

 The Diagnostic / Depth / Averaging command accesses the Depth Control
Gains Dialog Box. The dialog box allows you to enter a Unit ID and read or
modify the sample rate and averaging time constant for that depth sensor.

 The Diagnostic / Depth / Node Voltage command accesses the Read Node
Voltage Dialog Box. The dialog box allows you to enter a Unit ID and read the
node voltage for that depth sensor.

 The Diagnostic / Depth / Read AGC Voltage command accesses the Sensor
AGC Voltage Dialog Box. The dialog box allows you to enter a Unit ID and read
the voltage present.

 The Diagnostic / Depth / High/Low Power command accesses the Set Power
Mode Dialog Box. The dialog box allows you to enter a Unit ID and place the
sensor in low power mode, which permits more in-streamer devices to be served
by the Line Power Unit.

 The Diagnostic / Depth / Assign Unit Number command accesses the Assign
Unit Number Dialog Box. The dialog box allows you to assign a Unit ID to a
sensor (either Acoustic, Bird, Compass, or Depth), and assign the sensor to a
specific location (Platform/Line). The Assign Unit Number command is
normally used for a sensor not defined in the Setup file in use. This option should
only be used for sensors communicating over a dedicated test line that is defined
in the Setup file. Unit ID assignments made with this option do not update the
Setup file. In order to change the Unit ID of a sensor defined in the Setup file, use
the Edit menu in the Setup program. Enter the serial number of the sensor whose
unit number is to be assigned, followed by the platform line to which the sensor is
attached, then enter the desired unit number.
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 The Performance Menu
  The Performance menu options allow

you to obtain information on system
performance and integrity monitoring.

 Acoustic Disk Logging

 The Performance / Acoustic Disk Logging command accesses the Disk Logging
Dialog Box. The dialog box allows you to cause the next N shot points worth of
acoustic data to be logged to a file on the hard disk of the Operator Interface
system, where N is a user-entered value (default=250). Logging terminates
automatically after the specified number of shot points, or you can choose to
terminate logging early. The logged acoustic data can be analyzed by the Analysis
program. The log file name is constructed from the current date and time, and has
the extension “.DEP”.

 The Acoustic Logging Counter (ALog) on the Status Bar counts the number of
shots logged.

 

 The Skipping Nth Shots option is not active here; it is active only in the
Disk Logging: Depth & Fin Dialog Box.

 Birds Disk Logging

 The Performance / Birds Disk Logging command accesses the Disk Logging
Dialog Box. The dialog box allows you to cause the next N shot points worth of
bird depth and wing angle data to be logged to a file on the hard disk of the
Operator Interface system, where N is a user-entered value (default=250). In
addition, you can select the number of shots to be skipped between each log (0-
100), with 0 meaning no shots skipped. Logging terminates automatically after the
specified number of shot points. The depth is logged in units of 0.1 meters and the
wing angle in units of 0.1 degrees. The filename is constructed from the current
date and time, and has the extension “.FIN”. The number of shots logged appears
on the status bar.

 The Bird Logging Counter (BLog) on the Status Bar counts the number of shots
logged, and is used for bird ballast data..

 Sensor Communications Text

 The Performance / Sensor Comm. Text command accesses the Sensors
Communications Charts Dialog Box. The dialog box allows you to select the
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transmission ports that you want information from. Data available in the dialog
box includes the inbound and outbound signal strength and outbound noise level
for all sensors on the selected line. Under Communications, data includes the total
number of polls issued, the number of response time-outs, and the number of
checksum errors. Under Performance, data includes the inbound noise, the
transmit voltage, the transmit current, the dc voltage (if Line Power Unit is
installed), and the dc current (if Line Power Unit is installed). The dialog box
updates automatically at every shot cycle after the initial read.

 Sensor Communications Graphic

 The Performance / Sensor Comm. Graphic command displays a graphical
representation of inbound signal strength and noise data by transmission line. The
display plots inbound received signal strength (in dB volts) as a function of linear
offset (in meters) for the selected transmission line. All sensors that communicate
over the selected line are displayed. The vertical axis represents signal strength,
and the horizontal axis represents offset distance from the towpoint. The
background noise level in dBV is shown as a horizontal line across the graph. The
display updates automatically at every shot cycle after the initial read.

 Normally the received signal strength should decrease linearly with distance down
the line. If any significant sharp drops appear at specific points along the line, this
may a indicate leakage problem or some other condition causing attenuation.
Also, communications may be unreliable with any sensor whose signal strength is
near the background noise level.

Sensor Communication Test
The Performance / Sensor Comm. Test option performs a communications test
on a sensor.  This test allows you to send a number of polls to a selected sensor,
and to display the results in a table of statistics. When this option is selected, the
Sensor Comm. Performance Test Dialog is displayed.  From here you select the
platform line and the device type, and enter the sensor’s unit number (or serial
number) and the number of times to poll the unit.  To poll continuously without
stopping until the window is closed, enter zero for the number of times to poll.
Click “Start” to begin the test.

 Reset Counter Statistics

 The Performance / Reset Counter Statistics command accesses the Reset
Line(s) Counter Statistics Dialog Box. Select the line or lines that you want to
reset, and press the “Reset” button; this causes the Operator Interface processor to
send a command to the DMU to clear all sensor communications counters.
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 Reset Communication Statistics

 The Performance / Reset Comm. Statistics accesses the Reset Line (s)
Communication Statistics Dialog Box. Select the line or lines that you want to
reset, and press the “Reset” button; this causes the Operator Interface processor to
send a command to the DMU to clear and reset the filtered signal strength,
background noise, and line power statistics.

 Reset Range Statistics

 The Performance / Reset Range Statistics accesses a question box asking
whether or not you wish to proceed.  A “Yes” response causes the Operator
Interface processor to send a command to the DMU to reset the range percent
completion values to zero.

 Repeater Diagnostics

Click on Performance/Repeater Diagnostics to access the FSK Repeater
Diagnostics Dialog box. Select the transmission port you wish to view, and press
the “Read” button.  The ID, status, and serial number of each Repeater on that line
will be displayed in the “Repeater(s)” list.

                       
To change a repeater’s status or obtain more detailed information, click on the
desired Repeater ID in the “Repeater(s)” list.  This will enable the following
buttons:
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ENABLE – take the repeater out of Bypass mode and activate the repeat function

BYPASS – place the repeater in Bypass mode, disabling the repeat function

RPTR INFO – display the Repeater Information Dialog, containing repeater
configuration and line signal levels

TEST – display the Repeater Test Dialog for the selected repeater

SENSORS – display the Repeater Sensor Statistics Dialog, with plots of signal
levels measured by the repeater for all sensors on that line.

The Repeater Information Dialog contains repeater configuration settings,
transmission status, voltage level and current signal levels for the last transmitted
sensor message. Following is a short description of the measured values:

Measurement Description

Rx Level Decibels: receive signal strength
Tx Status Voltage: Transmitter health: ˜  1.5
Line Noise Decibels: background noise
Line AGC Voltage: induced receiver noise
DC Input Voltage: module power supply voltage
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The Repeater Test Dialog contains test diagnostics commands. The repeater can
be commanded to output a test pattern for a specific duration. This signal can be
used to measure the output level of the transmitters, which should be a square
wave of 6.8Vpp minimum.  Assuming a line attenuation of 4.26 dB/km, a module
placed 4 km away would show a 0.96Vpp on the shipboard (see equation below).

Also, you can measure the output frequency of the boat and tail transmitters for
both /01 and /03 frequencies. See the following table for frequency specification.

Pattern /01 kHz /03 kHz

Space 25.80 28.98
Boat

Mark 24.54 27.39
Space 27.39 28.98

Tail
Mark 24.54 27.39

The Repeater Sensor Statistics Dialog displays plots of signal levels measured
by the repeater for all sensors on that line. Following is a short description of the
measured values:

Measurement Description

Rx Level receive signal strength in Decibels
Line Noise background noise in Decibels

The Repeater Sensor Statistics Dialog has three tabs:

Boat Side – This window displays a plot of signal levels for each sensor measured
on the repeater’s boat side versus streamer offset.

Tail Side – This window displays a plot of signal levels for each sensor measured
on the repeater’s tail side versus streamer offset.

Sensor Table – This window displays signal and noise levels measured by the
Repeater for all sensors on that line in a tabular format.

 No Database Diagnostic Option

 The ‘No Database’ diagnostic option allows you to perform diagnostics on sensors
that have not been put in the configuration through the Setup program.

 The ‘No Database’ option is entered indirectly, since there is no button or menu
command to invoke the option. When performing diagnostic commands from the

( )
20

D26.4

pp 108.6V
×−

×=



 System 3 (Version 4.0) User’s Manual

  266
 

Diagnostic menu, you may enter a sensor Unit ID that is not in the Setup
configuration. A box will appear asking whether or not you wish to send the
message. If you select ‘Yes,’ a second box appears with a blank Serial number
field. Enter the Serial number of the sensor to perform the selected diagnostic.

 The Sensor Menu
  

 Deploy Acoustic Unit

 The Sensor / Deploy an Acoustic Unit command accesses the Acoustic
Deployment Dialog Box. The dialog box allows you to enter a Unit ID and select
from the following options: Assign Unit Number, Read Serial Number, Read
Battery Voltage, Read AGC, and Download CMX Configuration. Press the
“Execute” button to read the response from the selected options. Press the “Info
Page” button to access the CMX Information Dialog Box.

 Deploy Bird Unit

 The Sensor / Deploy a Bird Unit command accesses the Bird Deployment
Dialog Box. The dialog box allows you to enter a Unit ID and select from the
following options: Assign Unit Number, Read Serial Number, Read Battery
Voltage, Read AGC, Assign Target Depth, Wing Reset, Set Fin +15, Set Fin -15,
and Set Fin 0. Press the “Execute” button to read the responses from the selected
options. Press the “Info Page” button to access the Bird Information Dialog Box.

 Deploy Velocimeter Unit

 The Sensor / Deploy a Velocimeter Unit command accesses the Velocimeter
Deployment Dialog Box. The dialog box allows you to enter a Unit ID and select
from the following options: Assign Unit Number, Read Serial Number, Read
Battery Voltage, Read AGC.

 Enable/Disable Polling

 The Sensor / Enable/Disable Polling command accesses the Enable/Disable
Polling Dialog Box. Enter a Unit ID and select Enable to activate or Disable to
deactivate a sensor for periodic polling by the modem subsystem.
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 CMX Verification Test

 The Sensor / CMX Verification Test command verifies the acoustic ranging
operation of a pair of CMXs by measuring a single range between two CMXs
whose transducers are in close contact. The range value reported between the
CMX pair is an indication of the accuracy of the two CMXs. This is essentially a
zero-range verification test. To pass the test, the reported range time should be 0.0
+/- 0.1 millisecond.

 A special Setup file named ZERO.CFG is used for the verification test. This file
contains only two CMXs, both on transmission port 1 (AA01 and AA02), with a
single range between them.

 The following steps are required to perform this test:

 1. Position two cable-mounted CMXs so that their transducers are barely
in contact. Minimal contact is recommended. Place a suitable impeding
medium (the recommended medium is the bubble pack wrapping used to
ship the battery packs) between the transducers.

 2. The CMXs must communicate over a line connected to modem
transmission port 1. If the default test configuration (ZERO.CFG) is
modified, be sure that the two CMXs are connected to the appropriate
modem port and have different unit numbers.

 3. Enter the Setup program, open the ZERO.CFG Setup file and enter the
serial numbers of the two CMXs being used. Then, transfer this file to the
DMU (File / Transfer to DMU command). After a successful transfer,
exit Setup.

 4. Enter the Operator Interface (OI) program and select DMU / Run
Mode / Exit Run Mode.

 5. Select Sensor / Deploy an Acoustic Unit. Enter the first CMX ID
(AA01) in the Unit ID field, and select ‘Assign Unit Number’ from the list
of Command options. If an error message appears, repeat the operation
until it succeeds. Return to the Unit ID and repeat the same procedure for
the second CMX (AA02).

 6. Select Sensor / CMX Verification. The CMX configurations will be
downloaded to each of the two pods. A message will appear confirming
each download.

 7. Select DMU / Run Mode / Enter Run Mode. This activates data
acquisition and acoustic ranging.

 8. Observe the acoustic signal strengths for path 1 and path 2 for the range
“AA01-AA02”. They should fall within the range of -35 dB to -1 dB. If
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they do not, make small adjustments to the position of the CMX
transducers or the impeding medium to change the contact pressure.

 9. Select the DMU / Path Reflections command to ensure that both
CMXs are communicating properly (CMX Unit IDs are both the correct
pre-selected color).

 10. Observe the range time for range “AA01-AA02” over several shot
intervals. The reported range should be 0.0 +/- 0.1 millisecond.

 11. When the test is complete, return to the Setup program and transfer
the desired Setup file to the DMU (File / Transfer to DMU command).
Then go through normal deployment procedures.

 

 Before returning to normal operation, the runtime configurations must
be downloaded to all CMXs using the Download CMXs Configuration
command.

 CMX Manual Range Test

The Manual Range Test between deployed acoustic units adds a higher level of
deployment and field test diagnostics for acoustic units. This feature allows you to
test the ranging operation of any pair of acoustic units as soon as they are in the
water at an appropriate depth.  The two units do not have to be at their final
deployment location, and they do not need to have a range between them
configured in the Setup file.

Manual Range Setup

The manual range test is designed to be used when the system is not performing
normal range acquisition; for example, during deployment or on line change.
When performing this operation it is very important that only the two units being
tested are functioning in normal acoustic mode. This is achieved by placing all
other units in Background Noise mode, which is in effect a ‘listening only’ mode.
The following steps prepare the system for manual ranging:

1. Select Exit RUN mode from the Operator Interface DMU menu. Wait until
the DMU run mode ‘R’ indication on the Status Bar goes away.

2. Set all Acoustic units to Background Noise mode by selecting the main menu
option Sensor / Check Background Noise, and wait for the response of all
the units. It is essential to have all of the deployed units in Background Noise
mode.

3. Place the DMU back in RUN mode.
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4. Activate the Manual Range Diagnostic window by selecting the CMX
Verification Test from the Sensor main menu option.

 

 When employing the Manual Ranging feature during system
deployment, be sure to deploy any new units in Background Noise mode.
To facilitate this, a new command has been added to the Acoustic
Deployment window.

Manual Range Operation

After successfully setting up the System for manual range operation, select
Sensor / CMX Verification Test from the main menu to display the Manual
Range Diagnostic window.  The following diagnostic window will appear:

                     
While in this diagnostic window you will be able to download a special
configuration that will allow the ranging of any two deployed units*. The steps to
perform the manual range test are as follows:

1. Enter the Unit ID of each of the two units to be tested. These units must be
part of the current configuration.

2. Press the Download button and wait for ‘PASS’ acknowledgements from both
units. If any one unit fails, a FAIL <UnitID> message will be displayed, at

                                                          
* The units to be range tested must be with in 1000 meters of each other.
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which time this step should be repeated.  This step also disables the ‘Unit ID’
boxes; you will be able to change these units only after pressing the Finish
button.

3. After a successful download, the Start button will be enabled; press it when
ready to start the ranging process. At this time, the units will be queried every
shot cycle and their reported range/path values will be displayed. If the units
can not range, stop the test, enter new threshold settings, and return to step 2
to retry.

4. After starting the test, you will be able to halt it by pressing the Stop button.
This will be done once you are satisfied with the range values received, or
when attempting to change the threshold setting or transmit channel in order to
deal with units that might have path obstructions.

5. When ready to perform a manual range test with a different pair of units, press
the Finish button. This action will attempt to set the two selected units back to
Background Noise mode. If successful, you will be able to again enter new
unit IDs and restart the manual ranging process. If unsuccessful, retry by
pressing the Finish button again.

6. At any time you will be able to exit the window by pressing the Close button.
The system will attempt to restore the units back to Background Noise mode,
but it is left to you to ensure their state by carefully following the Start, Stop,
and Finish steps described above.

7. Finally, after closing this window, you will be reminded that the system is in
Background Noise mode. To return the system to normal operation, first re-
download the acoustic configurations by performing a Download CMXs
Conf. command, then place the DMU in RUN mode

 Download CMXs Configuration

 The Sensor / Download CMXs Configuration command loads any required
configuration data to an acoustic sensor. (Currently this consists of acoustic
aperture and threshold settings). Valid runtime acoustic configurations (originally
generated by the Setup program) must be downloaded to all CMXs prior to
initiating operation of the acoustic system to ensure that valid range data is
produced. It is also important to avoid making any individual range
aperture/threshold adjustments unless the affected CMXs contain valid runtime
configuration data.

 Check Background Noise

 The Sensor / Check Background Noise command measures the background
acoustic noise while off-line (not in the Run Mode). A special configuration is
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downloaded to the CMXs, which turns off the transmitters in the CMX units. The
receive apertures are still active and viewing the ambient background noise. The
save acoustic .DEP file option can be used to record the background noise and
then view this information using the Analysis program.

 Before returning to normal operation, the runtime configurations must be
downloaded to all CMXs using Download CMXs Configuration.

 Set Geometry Parameters

 The Sensor / Set Geometry Parameters command accesses the Geometry Test
Settings Dialog Box, which allows you to select an acoustic group and enter the
two reference CMXs (origin and baseline). The origin CMX defines the center of
a local coordinate system for the group, and the baseline CMX determines the
orientation of the local coordinate system.  Following your selection of the two
reference CMXs, select the Sensor / Request a Geometry Test command.

 Request a Geometry Test

 The Sensor / Request a Geometry Test command initiates the geometry
verification process. When the process is started, the CMX Serial numbers are
read and compared with the configured Serial numbers.

 

 At this point, it is assumed that all CMXs are deployed and their
acoustic configurations downloaded, and the reference CMXs (origin
and baseline) are specified.

 For units with mismatches, both the configured Serial number and the true Serial
number (read from the sensor) are displayed next to the Unit ID. Mismatches must
be resolved in order to proceed further (communications failures are ignored).

 If all Serial numbers match, the verification will proceed. During the next phase,
the DMU collects range samples over 10 shot intervals and then computes the
estimated positions of the CMXs. The DMU must be in Run Mode for the
sampling process to proceed. Other operations can be performed at the Operator
Interface while this sampling is in progress. A message appears when the
verification is complete (allow at least 10 shot intervals), indicating that the
results are available for display.

 Any of the following error conditions can prevent the verification process from
determining the CMX locations:

• invalid reference CMXs specified

• insufficient range data for reference CMXs

• insufficient range data for the group
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• no convergence

• RMS exceeds threshold.

 If the ‘invalid reference CMXs specified’ message appears, re-enter two reference
CMXs, ensuring that they are on the same line. If any of the other error messages
appear, verify that all CMX configurations have been downloaded and that the
CMXs are communicating. Then go to the Range display and check the status of
the ranges in that group. If a fault is discovered, restart the verification after it is
corrected.

 

 During the acquisition of the geometry verification data, the lines should
be straight and no turns made.

 Retrieve Geometry Results

 The Sensor / Retrieve Geometry Results command accesses the Select Group
Dialog Box. The dialog box allows you to select the number of the acoustic group
that you want to view in order to obtain the results of the last geometry
verification. A dialog box appears briefly and informs you that the verification
results are being compiled. Following the compilation of the geometry verification
results, they are displayed in a tabbed window. The window is divided into two
groups: Lines and Units and Acoustic Ranges.

 The Lines and Units Geometry Test Results Display allows you to view the
configured lateral offset and the calculated lateral offset for each line and sensor
unit found in the selected group. All offsets are in meters. The calculated offset
for the line is the average of the calculated lateral offsets of all CMXs on that line.
Any calculated lateral offset that differs from the corresponding configured offset
by more than 10 meters is displayed in a pre-selected color. Any unit with
insufficient valid range data to participate in the verification is displayed in
another pre-selected color.

 

 To select the colors used in the displays, use the tabbed System
Preferences Dialog Box, which is accessed by clicking on File /
Preferences. Note that if your monitor is not using True or High Color,
the colors you select may appear differently in the displays.

 The Acoustic Ranges Geometry Test Results Display allows you to view the
configured, calculated and measured range distances (in meters) for each range in
the selected group. The measured range is based on an average of the observed
range values collected over the 10 shot intervals, with all unqualified range
measurements excluded. If an insufficient number of valid measurements were
obtained over this 10-shot sample interval for a range, that range is displayed in a
pre-selected color. Any calculated range that falls outside the center half of its
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configured aperture is displayed in another pre-selected color.
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The DMU Menu
  The DMU menu allows you to modify

certain system configuration parameters
within the DMU Communications
Control processor without interrupting
normal data acquisition.

 Enter Run Mode

 The DMU / Enter Run Mode command activates the operational state of the
DMU. The DMU initiates periodic data acquisition and data distribution by
internal or external trigger.

 Exit Run Mode

 The DMU / Exit Run Mode command deactivates the operational state of the
DMU. When not in Run Mode, the DMU stops all periodic data acquisition and
data distribution, and is available full time for special sensor diagnostics.

 Scan Interval

 The DMU / Change Scan Interval command accesses the Internal Scan
Interval Dialog Box. The dialog box allows you to change the interval at which
the DMU generates internal scan triggers in the absence of external triggers.

 Set Acoustics Mode

 The DMU / Set Acoustics Mode command is a switch that allows you to turn the
acoustics on or off. Turning the acoustics off when they are not in use saves
battery life.

 Path Reflections

 The DMU / Path Reflections command is a switch that allows you to enable or
disable the reflection QC function. When the reflection QC function is enabled,
the DMU will analyze the acoustic data trend and detect when reflections are
present. When reflections are detected, the data quality flag bit will be set in the
message to the host computer signifying bad (reflected) data. This function serves
as an additional layer of acoustic data QC before data is handed to the host
computer. When the function is disabled acoustic data is not checked for the
presence of reflections.



 Section VI   Operator Interface Program

  275
 

 Path Prediction

 The DMU /Path Prediction command is a switch that allows you to enable or
disable the path prediction feature. The acoustic pod will send the predicted value
of the path time if it does not detect a path time. When a path prediction is sent
from a pod, a +6 is placed in the signal strength field to notify the dry end that the
path is a predicted value. If path prediction is off, the DMU will ignore the
prediction from the acoustic pod. If path prediction is enabled, and the range is
configured as a two-way range, the DMU will combine a predicted value with an
actual received path from the other pod in the range pair to form a range. A
predicted value will not be used for a configured one-way range even if path
prediction is enabled since no received path time is available to qualify the
prediction. Refer to the table for a description of the operation of the acoustic path
prediction feature and its effect on the data quality flag (0 / Good Range; 1 / Bad
Range) in the host message and its effect on acoustic secondaries.

 

  ACOUSTIC DATA

 

 DATA QUAL. FLAG

 (0 / GOOD; 1 / BAD)

 PERFORM
SECONDARY?

 

  PATH 1  PATH 2  PRED. ON  PRED. OFF  EST. ON  EST. OFF

 PASSED  DATA  DATA  0  0  N  N

 RANGE  DATA  PREDICTION  0  1  N  Y

 PROC.  PREDICTION  DATA  0  1  N  Y

 CHECKS  PREDICTION  PREDICTION  1  1  Y  Y

 FAILED  DATA  DATA  1  1  Y  Y

 RANGE  DATA  PREDICTION  1  1  Y  Y

 PROC.  PREDICTION  DATA  1  1  Y  Y

 CHECKS  PREDICTION  PREDICTION  1  1  Y  Y

 

 Initialize Diagnostic Link

 The DMU / Initialize Diagnostic Link command checks the communications
link between the DMU and the Operator Interface computer. Up to six Operator
Interfaces can be linked to the DMU at one time. All other computers are
connected as Remote monitors. The Initialize Diagnostic Link command can be
re-attempted at any time.
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 The Window Menu

 Full Scale

 The Window /Full Scale command shows the entire system network in the
Graphic Display.

 This command is accessed in any of three ways:

• Click on the “Display Full Scale” button   .

• Click on Window / Full Scale.

• Click on the right mouse button (but not directly on a sensor) when in the
Graphic Display and select Full Scale from the menu that appears.

 Zoom Area

 The Window / Zoom Area command enlarges a selected area in the Graphic
Display.

 This command is accessed in any of three ways:

• Click on the “Zoom Area” button   .

• Click on Window / Zoom Area.

• Click on the right mouse button (but not directly on a sensor) when in the
Graphic Display and select Zoom Area from the menu that appears.

Open Window

The Window / New Window command creates a new window that views the
same file.

The Window / 1, 2, 3, or 4 (or other number) command brings the screen of an
opened file to the front.

Change Window Position

The Window / Cascade command positions multiple opened windows in an
overlapped arrangement.

The Window / Tile Horizontally command positions multiple opened windows
in a non-overlapped horizontal arrangement.
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The Window / Tile Vertically command positions multiple opened windows in a
non-overlapped vertical arrangement.

Refresh Window

The Window / Redraw command refreshed the window.

The Window / Update All command refreshes all system views.

Arrange Icons

The Window / Arrange Icons command arranges icons of closed or minimized
windows.
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The Help Menu

Help Topics

 The Help / Help Topics command accesses the main Help topics window with
the Contents, Index, and Find tabs. All OI Help topics are available through this
command. From the Contents window, double-click on a book to open it and
display a list of topics, then double-click on the desired topic. From the Index
window, either double-click on the desired topic, or type the first few letters of the
topic in the window under the Index tab to find the topic, then click the Display
button (or press Enter).

About System3 OI

The Help / System 3 OI command accesses the System 3 OI information box,
which displays the copyright notice and version of your System 3 application.

You can also access the System 3 OI information box by clicking on  .
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SYSTEM 3 ANALYSIS PROGRAM
The Analysis allows you to analyze acoustic data that has been acquired.

The Analysis program is optional and can not be executed unless the software has
been installed on the Operator Interface computer.

Analysis Program Prerequisites
To use the Analysis Program, you must first have a .DEP file. All .DEP files are
created in the Operator Interface Program. You can create a .DEP file by
following the steps below:

1. In the Operator Interface Program, click on the Performance / Acoustic
Disk Logging command.

2. The Disk Logging Acoustic Dialog Box will be displayed. Type the
number of shots into the box provided (or leave at the 250-shot default),
and press the OK button.

3. A .DEP file will be created. Save the .DEP file in a folder. The Analysis
files should be installed in the same directory as the System 3 files.

Start Analysis Program
Once you have at least one .DEP file, you can start the Analysis Program by
following the steps below:

1. Open the Analysis Program, and click on File / Open a .DEP.

2. Select a DEP file and press Open.

3. To change the default configuration for range and path data selection for
the graphs, click on Range – Settings.  The Range/Chart Settings Dialog
Box will appear.  The Range/Chart Settings Dialog Box allows you to
setup the Analysis graphic display.

4. Make the desired selections on the Range/Chart Settings Dialog Box.  It
will be useful to leave this dialog box open to conveniently modify the
Application graphic display.

5. Select a range using the range selector, which is a window immediately
below the pulldown menus (File, Range, Summary, and Help) and to the
left of the Toolbar.

6.  When a range is selected, the graphic for that range will be displayed. The
graphic can be modified using the Range/Chart Setting Dialog Box.
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The following paragraphs describe the individual toolbar and menu
commands of the Analysis Program.

ANALYSIS TOOLBAR

Copy as Graphic

The “Copy as Graphic” button   copies the selection to the clipboard as a
bitmap.

Copy as Text

The “Copy as Text” button    copies the selection to the clipboard as text.

Print

The “Print” button    prints the displayed chart (or graph).

Change the Gallery Type

The “Change the Gallery Type” button    changes the type of graph that is
displayed (for example: Linear, Scatter, etc.). Currently only Scatter graphs are
supported.
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3D/2D View

The “3D/2D View” button    is a switch that allows you to display the same
Analysis data in either a 3D or a 2D view.  Note that the 3D view shown below is
shown with the Z-Clustered Series button selected.

Figure 7.1  3D View
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Figure 7.2  2D View
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Rotate the Chart (3D)

The “Rotate the Chart (3D)” button   accesses the 3D View Properties Dialog
Box. This dialog box allows you to view the Analysis graphic data from any
angle. This dialog box is also accessible through the Chart properties button, and
selecting the 3D View tab on the Chart Properties Dialog Box.

Figure 7.3  3D View Properties Dialog Box



System 3 (Version 4.0) User’s Manual

286

Z-Clustered Series (3D)

The “Z-Clustered Series (3D)” button   allows you to switch between two
types of 3D views. In each view, the Z-axis data is depicted (displayed)
differently.  The first example shows the view with the button de-selected; the
second example shows the view with the button selected.

Figure 7.4  Z-Clustered Series De-selected
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Figure 7.5  Z-Clustered Series Selected

Zoom

The “Zoom” button    enlarges a selected area.

Vertical Grid

The “Vertical Grid” button    adds vertical grid lines to the graph.

Horizontal Grid

The “Horizontal Grid” button    adds horizontal grid lines to the graph.
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Titles

The “Titles” button    accesses the Titles Dialog Box.  This dialog box allows
you to change the information titles on the main Applications program graphic.
This dialog box is also accessible through the Chart properties button, and
selecting the Titles tab on the Chart Properties Dialog Box.

Figure 7.6  Titles Dialog Box
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Fonts

The “Fonts” button    accesses the Font Dialog Box.  This dialog box allows
you to set  the type, style, size, and color of the fonts used in the Analysis
program.

Figure 7.7  Font Dialog Box
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Chart Properties

The “Chart Properties” button    accesses the Chart Properties Dialog Box.
The Chart Properties Dialog Boxes allow you to tailor the appearance of each
dialog box and graphic display. This dialog box is tabbed General, Series, Scale,
3D View, and Titles.  An example of each dialog box appears below.

Figure 7.8  General Chart Properties Dialog Box
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Figure 7.9  Series Chart Properties Dialog Box
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Figure 7.10  Scale Chart Properties Dialog Box
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This dialog box allows you to view the Analysis graphic data from any angle.
Select (check) the Full 3D View to make this feature operable.

Figure 7.11  3D View Chart Properties Dialog Box
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This dialog box allows you to change the information titles on the main
Applications program graphic.

Figure 7.12  Titles Chart Properties Dialog Box
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FILE MENU

Open a .DEP
The File / Open a .DEP command opens a .DEP file from the selected folder.

Save as .TXT
The File / Save as .TXT command saves an Analysis Program file (a .DEP) in an
ASCII format. This feature is unavailable at this time.

Exit
The File / Exit command exits the Analysis Program.

RANGE MENU

Range Parsing
The Range / Parsing command accesses the Range Parsing Dialog Box.  This
dialog box allows you to select a subset of the data collected based on shot
sequence and/or completion rate.  You can specify the starting and ending shot
sequence numbers and the maximum completion rate.

Range Settings
The Range / Settings command accesses the Range/Chart Settings Dialog Box.
This dialog box allows you to select the type of information that will be displayed
for a selected range.

The Display options allow you to select which path and range data will be
displayed.

The Show/Include options allow you to select whether signal strength, threshold,
or secondary acoustic data will be displayed.

The Plot Type option allows you to choose between showing the range distance or
the deviation in distance shot-to-shot (the rate of change).
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The ranges can be viewed in Units of either meters or milliseconds.

When Signal Strength is shown, you can simplify the graphic display by choosing
not to show any prediction (see Note below) graphics or to show only completed
shot data.

Signal strength predictions are path-time estimates generated by the
CMX and are represented by a +6 value in the signal strength graphic.
The +6 signal strength prediction value is not a real value.

Range Statistics
The Range / Statistics command accesses the Range Statistics Dialog Box.

On the right side of the dialog box, general acoustic range data is shown.  On the
left side of the dialog box, statistics for a specified range is shown. .  You  select
ranges by using the range selector, which is a window immediately below the
pulldown menus (File, Range, Summary, and Help).

The Range Statistics Dialog Box is tabbed into five windows: Rate, Distance,
∂Distance, Signal, and Unit.

The Range Statistics Rate window shows the statistical percentage rates of shot
completions.

Figure 7.14  Range Statistic Rate Dialog Box
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The Range Statistics Distance window shows the range distances for the selected
range.

Figure 7.15  Range Statistics Distance Dialog Box

The Range Statistics ∂Distance window shows the distance deviation, or rate or
change, shot-to-shot for the selected range.

Figure 7.16  Range Statistics ∂Distance Dialog Box
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The Range Statistics Signal window shows signal strength information in the
selected range.

Figure 7.17  Range Statistics Signal Strength Dialog Box

The Range Statistics Unit window shows unit information for the two CMX units
in the selected range.

Figure 7.18  Range Statistics CMX Unit Dialog Box

Signal strength predictions are path-time estimates generated by the
CMX and are represented by a +6 value in the signal strength graphic.
The +6 signal strength prediction value is not a real value.
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Print All Ranges
The Range / Print / All command prints both a copy of the displayed graphic and
a copy of the Analysis Range Statistics for the specified range.

Print Range Plot (Chart)
The Range / Print / Chart command prints a copy of the displayed graphic.

Print Range Statistics
The Range / Print / Statistics command prints a copy of the Analysis Range
Statistics for the specified range.



System 3 (Version 4.0) User’s Manual

300

SUMMARY MENU

Ranges Summary
The Summary / Ranges command accesses the Ranges Analysis Summary
Information Box.

This information box summarizes range distance and completion information for
all ranges in the system.

Figure 7.19  Ranges Analysis Summary Information Box
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Units Summary
The Summary / CMX Units command accesses the Unit Analysis Summary
Information Box.

This information box summarizes the number of ranges, communications success
rate, and the transmit and receive percentages for all CMX units in the system.

Figure 7.20  Unit Analysis Summary Information Box
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Signals Summary
The Summary / Path S.S. command accesses the Signal Strength Analysis
Summary Information Box.

This information box summarizes Path 1 and Path 2 signal strength information
for all ranges in the system.

Figure 7.21  Signal Strength Analysis Summary Information Box

HELP MENU

Analysis Help Topics
The Analysis Help Topics command accesses the Help file.

About Analysis
The About Analysis command displays the Analysis software version and
copyright information.


